CS+ V8.10.00
Integrated Development Environment

User’s Manual: Analysis Tool

Target Device
RL78 Family
RX Family
RH850 Family

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corp. without notice. Please review the latest information published by Renesas Electronics Corp. through various means, including the Renesas Electronics Corp. website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depend on the product’s quality grade, as indicated below.

   - “Standard”:
     - Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliance; machine tools; personal electronic equipment; industrial robots; etc.
   - “High Quality”:
     - Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implants; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DISCLAIMS ANY AND ALL LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes” for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

© 2023 Renesas Electronics Corporation. All rights reserved.
How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and systems for RH850 family, RX family, RL78 family, and provides an outline of its features. CS+ is an integrated development environment (IDE) for RH850 family, RX family, RL78 family. Integrating the necessary tools for the development phase of software (e.g., design, implementation, and debugging) into a single platform. By providing an integrated environment, it is possible to perform all development using just this product, without the need to use many different tools separately.

Readers
This manual is intended for users who wish to understand the functions of the CS+ and design software and hardware application systems.

Purpose
This manual is intended to give users an understanding of the functions of the CS+ to use for reference in developing the hardware or software of systems using these devices.

Organization
This manual can be broadly divided into the following units.

1. GENERAL
2. FUNCTIONS
3. CAUTIONS
A. WINDOW REFERENCE

How to Read This Manual
It is assumed that the readers of this manual have general knowledge of electricity, logic circuits, and microcontrollers.

Conventions
Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)
Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention
Remarks: Supplementary information
Numeric representation: Decimal ... XXXX
Hexadecimal ... 0xXXXX
# TABLE OF CONTENTS

1. **GENERAL** ................................................. 6  
   1.1 Summary ................................................. 6  
      1.1.1 What is analyzed .................................. 6  
      1.1.2 Types of analysis information .................. 7  
   1.2 Features ............................................... 10  

2. **FUNCTIONS** ............................................ 14  
   2.1 Overview ............................................... 14  
   2.2 Display Function Information ....................... 18  
   2.3 Display Variable Information ....................... 19  
   2.4 Display Calling Relationships between Functions (Call Graph) ....................................... 20  
   2.5 Display Class/Function/Variable Information ....... 24  
   2.6 Customize Display Method ............................. 26  
      2.6.1 Set the columns to display .................... 26  
      2.6.2 Change the order of the columns to display .. 27  
      2.6.3 Lock the specific column to display ........ 28  
      2.6.4 Sort the analysis information ............... 29  
      2.6.5 Filter the analysis information .............. 29  
   2.7 Jump to Defined Location ............................. 32  
   2.8 Jump to Declared Location ............................ 34  
   2.9 Set Break Events ...................................... 35  
      2.9.1 Set a breakpoint to a function ............... 35  
      2.9.2 Set a break event to a variable ............. 35  
   2.10 Register Watch-Expressions ........................... 37  
   2.11 Display List of Referencing Location ............. 38  
   2.12 Import or Export Information ........................ 39  
   2.13 Display Analysis Information in Chart ........... 43  
      2.13.1 Graph transitions in values .................. 43  
      2.13.2 Chart the function execution time ratios .... 55  
   2.14 Save Analysis Information ........................... 57  

3. **CAUTIONS** .............................................. 59  
   3.1 Changing Active Project ............................... 59  
   3.2 Coverage Results ....................................... 59  
   3.3 Real-time Sampling Analysis ........................... 59  
   3.4 Trace Data Analysis .................................... 60  
   3.5 When the Panel Is Opened during Execution of Program ............................................. 60  
   3.6 When CC-RX (C++ Source Files) Is Used ............ 61
1. GENERAL

This chapter describes an overview of the analysis tool (Program Analyzer).

**Cautions 1.** "E2" in this manual is the abbreviated name of "E2 emulator". "E2 Lite" is the abbreviated name of "E2 emulator Lite".

**Cautions 2.** When the IE850A emulator is used, please read references to "E2 [RH850]" in this manual as also meaning "IE850A [RH850]".

1.1 Summary

The analysis tool is a component provided by CS+. It supports the analysis of the behavior of programs developed for RH850 family, RX family, RL78 family.

1.1.1 What is analyzed

The analysis tool only analyzes C/C++ source files (including header files) in a project being set to the active project in the Project Tree panel. Consequently, assembler source files are not analyzed. Note, however, that symbols defined in assembler source files that are referenced from C/C++ source files are analyzed.

**Cautions 1.** C++ source files are only supported by CC-RX.

**Cautions 2.** If the target project to be analyzed satisfies the conditions shown below, the analysis tool cannot be used.
- A debug-dedicated project
- A boot loader for multi-core project [RH850]
- A project in which a non-supported build tool is registered
- A project in which no build tool is registered

**Remark** It is possible to forcibly display the function/variable information for C/C++ source files and header files in a project other than the active project by importing information files (function list file (*.mtfl)/variable list file (*.mtvl)) (see "2.12 Import or Export Information File" for details).

Among the above files that can be analyzed, only desired files can be selected as the files to be analyzed or files not to be analyzed to improve the efficiency of analysis. The function information and variable information in the files not to be analyzed is not displayed in the panels (except for the Analysis Chart panel) provided by the analysis tool.

Only the function information and variable information in the files to be analyzed is displayed in the panels (except for the Analysis Chart panel) provided by the analysis tool.

Use any of the following methods to specify files to be analyzed and files not to be analyzed (use a convenient method for the analysis purpose).

1) When the files not to be analyzed are specified (default)

- In the same category above, click the [...] button that appears at right edge in the column when [Files not to analyze] property is selected.
- On the Select Files not To Analyze dialog box opened, select the files not to be analyzed.

2) When the files to be analyzed are specified

- In the same category above, click the [...] button that appears at right edge in the column when [Files to analyze] property is selected.
- On the Select Files To Analyze dialog box opened, select the files to be analyzed.
1.1.2 Types of analysis information

The analysis tool acquires, analyzes, and displays the following two types of information.

(1) Static analysis information
This is the function information-variable information that can be displayed when a build has completed without any compiler or assembler errors. This is the result of analyzing the load module and cross reference information generated by the build tool.

For this reason, in order to acquire static analysis information, you should configure your build tool to generate cross reference information when performing the build. The analysis tool does, however, provide the following property that forces the build tool to generate cross reference information:


By setting this property to [Yes], it is possible to generate cross reference information regardless of the build tool's configuration. Note that if this property is set to [No] (default), the current setting in the build tool will take precedence.

(2) Dynamic analysis information
This is the function information or variable information provided as a result of analyzing trace data, real-time RAM monitoring, or coverage data acquired by the debug tool.

For this reason, you should enable Trace function, RRM function/RAM monitor (pseudo RRM) function, or Coverage function [IECUBE][E20][RX][Simulator] to acquire dynamic analysis information. The analysis tool does, however, provides the following property that automatically enables all of the above functions of the debug tool:


By setting this property to [Yes], it is possible to use the above debug tool's functions regardless of the debug tool's configuration. Note that if this property is set to [No] (default), the current setting in the debug tool will take precedence.

Cautions 1.
You must connect to the debug tool after the completion of the setting above. It is necessary to re-connect to the debug tool if you change this setting during debugging.

Cautions 2.
Functions that the debug tool does not support cannot be enabled. For some debug tools, the following functions are mutually exclusive. In that case, the priority is as follows:

Trace function > RRM function/RAM monitor (pseudo RRM) function > Coverage function

Cautions 3.
The dynamic analysis information cannot be acquired when the program analyzer tool or task analyzer tool provided by "RI series" is used.

The dynamic analysis information that each debug tool's function provides to the analysis tool is as follows:

(a) Trace function
This function is used to collect an execution history of the program as a trace data. The trace function provides the following Dynamic analysis information:

- Execution time (including a proportion of total execution time and average execution time)
- Execution count (including access type (read count, write count, and so on))
- Variable values (including maximum values and minimum values)
- Graph data (when the method for acquiring the graph data is Trace data analysis)

Cautions 1.

- [Full-spec emulator][E1/E2/E20]
  The contents of the dynamic analysis information differ depending on the [Trace target setting] property in the [Trace] category on the [Debug Tool Settings] tab of the debug tool's Property panel.

  - When [Debug core only] is selected
    The debug tool collects trace data regarding PE\textsubscript{n} currently selected in the Debug Manager panel. Therefore, the analysis tool also displays the dynamic analysis information regarding PE\textsubscript{n}.

  - When [All core] is selected
    The debug tool collects trace data in all PEs. Therefore, after collecting trace data, the anal-
ysis tool displays the corresponding dynamic analysis information by switching to another PE\textsubscript{n} in the Debug Manager panel.

- **[Simulator]**
  The debug tool collects trace data regarding PE\textsubscript{n} currently selected in the Debug Manager panel. Therefore, the analysis tool also displays the dynamic analysis information regarding PE\textsubscript{n}.

**Cautions 2.** **[Full-spec emulator][IECUBE][E1/E20/E2[RH850]][Simulator]**
Perform the following setting on the debug tool's Property panel to acquire the execution time correctly:

- [Debug Tool Settings] tab >> [Trace] category >> [Clear trace memory before running] property >> [Yes] (default)

**Cautions 3.** **[E20[RX]]**
If [Start Trace]/[Stop Trace] from the context menu on the Trace panel is selected during execution of a program, then an invalid value will be displayed as the execution time.

**Cautions 4.** **[E1/E2/E2 Lite/E20[RX]][EZ Emulator[RX]]**
The execution time of functions is not displayed when the device does not support the trace time tag feature. The time information displayed in graphs through Trace data analysis will not be correct.

**Cautions 5.** **[E20[RX]]**
In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of the dynamic analysis information by trace data will increase because complement of instructions between branch instructions is performed. If you focus only on variables, we recommend selecting [Data access] in this property.

**Cautions 6.** **[E1/E2/E2 Lite/E20/COM Port[RL78]][EZ Emulator[RL78]]**
Since branch origin addresses can only be acquired from the trace data, only the [Execution Count] item in the Function List panel/Call Graph panel is supported.

(b) **RRM function/RAM monitor (pseudo RRM) function**
This function permits you to read the contents of memory (variables/registers/addresses) in real-time while executing the program.

The RRM function/RAM monitor (pseudo RRM) function provides the following Dynamic analysis information:

- **Graph data** (when the method for acquiring the graph data is Real-time sampling analysis\textsuperscript{Note})

**Note** **[E1/E2/E2 Lite/E20/COM Port[RL78]]**
If the selected microcontroller incorporates a Smart Analog IC and the debug tool is in the Data collection mode, graph data is not acquired through real-time sampling analysis. Instead a sampling method specific to Smart Analog is used to acquire data and display graphs.

**Caution** **[RH850]**

- **Variable values and addresses**
  The address and value are determined based on the PC value in PE\textsubscript{n} currently selected in the Debug Manager panel.

- **Register values**
  The value in PE\textsubscript{n} currently selected in the Debug Manager panel is acquired.

- **The area that can be read by this function**
  The contents of memory can be read for access in all PEs. In the Local RAM self area, note that they can be read only for the access in PE\textsubscript{n} currently selected in the Debug Manager panel.

**Remark**
The target area from which you can read using the RRM function/RAM monitor (pseudo RRM) function varies depending on the microcontroller being selected in the project and the debug tool used.

For details on the relationship between the RRM function/RAM monitor (pseudo RRM) function and their target area, see "CS+ Integrated Development Environment User's Manual: Debug Tool".
(c) Coverage function \([\text{IECUBE}][\text{E20}[RX]][\text{Simulator}]\)

This function is used to perform coverage measurements.

The coverage function provides the following Dynamic analysis information:

- Code coverage rates
- Data coverage rates

**Cautions 1. [E20[RX]]**
The code coverage rates are measured only when the selected microcontroller supports the coverage function (a measurement of the data coverage is not supported).

**Cautions 2. [Simulator[RH850]]**
The coverage is measured for access in all PEs. In the Local RAM self area, note that the measurement results will be displayed only for the access in PEn currently selected in the Debug Manager panel.
1.2 Features

The features of the analysis tool are shown below.

- Displaying function information
  The following information about functions is displayed:
  Static analysis information (e.g. function name, file name, attribute, return type, reference count, etc.) and Dynamic
  analysis information (e.g. execution count, execution time, code coverage, etc.).

- Displaying variable information
  The following information about variables is displayed:
  Static analysis information (e.g. variable name, file name, attribute, type, reference count, etc.) and Dynamic analysis
  information (e.g. read count, write count, data coverage, etc.).
- Displaying the call graph
A tree-structured chart (call graph) indicating calling relationships between functions in the program is displayed.

- Displaying class information/function information/variable information
The class information [CC-RX], function information and variable information in the program are displayed in a tree structure.
- Linked operation with debug tool
  The following operations can be performed on the debug tool from the various panels of the analysis tool.
  - Jump to the location where the specified function or variable is defined:
    Function List panel/Variable List panel/Call Graph panel/Class/Member panel
  - Set a break event at the specified function or variable:
    Function List panel/Variable List panel
  - Register a watch expression for the specified variable:
    Variable List panel

- View list of locations referencing function/variable
  You can find and display a list of locations referencing a function/variable.

- Graph analysis information
  - A line chart indicating changes in values of variables or of data collected for Smart Analog [E1/E2/E2 Lite/E20/COM Port[RL78]] is displayed.
- A pie chart indicating function execution time ratios is displayed.
2. FUNCTIONS

This chapter describes the main features and operating procedures of the analysis tool.

2.1 Overview

The analysis information acquired by the analysis tool is displayed on the following panels.

Table 2.1 Panels Displaying Analysis Information

<table>
<thead>
<tr>
<th>Panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function List panel</td>
<td>Displays the function information.</td>
</tr>
<tr>
<td>Variable List panel</td>
<td>Displays the variable information.</td>
</tr>
<tr>
<td>Analysis Chart panel</td>
<td>Displays charts of the function information and the variable information.</td>
</tr>
<tr>
<td>[Variable Value Changing Chart] tab</td>
<td>Displays changes in values of variables or data collected for Smart Analog [E1/E2/E2 Lite/E20/COM Port[RL78]] Note 1 (line chart).</td>
</tr>
<tr>
<td>[Execution Time(Percentage) Chart] tab</td>
<td>Displays function execution time ratios (pie chart).</td>
</tr>
<tr>
<td>Call Graph panel</td>
<td>Displays calling relationships between functions (call graph).</td>
</tr>
<tr>
<td>Class/Member panel</td>
<td>Displays the class information [CC-RX] Note 2, function information and variable information in a tree structure.</td>
</tr>
<tr>
<td>Variable Value Changing Chart (zoomed in) panel</td>
<td>Zooms in on the chart displayed in the [Variable Value Changing Chart] tab.</td>
</tr>
</tbody>
</table>

Notes 1. [E1/E2/E2 Lite/E20/COM Port[RL78]]
Data collection for Smart Analog is supported only when the selected microcontroller incorporates a Smart Analog IC.

Notes 2. [CC-RX]
The class information is provided only when C++ source files are subject to analysis.

In the each panel, the following types of function/variable are subject to analysis.

Table 2.2 Types of Functions/Variables That Are Subject to Analysis

<table>
<thead>
<tr>
<th>Types</th>
<th>Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function List</td>
</tr>
<tr>
<td>Global function</td>
<td>✓</td>
</tr>
<tr>
<td>Static function</td>
<td>✓</td>
</tr>
<tr>
<td>Member function [CC-RX]</td>
<td>✓</td>
</tr>
<tr>
<td>Global variable</td>
<td>-</td>
</tr>
<tr>
<td>Static variable inside a file</td>
<td>-</td>
</tr>
<tr>
<td>Static variable inside a function</td>
<td>-</td>
</tr>
<tr>
<td>Local variable</td>
<td>-</td>
</tr>
</tbody>
</table>
By validating this analysis information, it is possible to search for unused functions and variables, and processing that is creating bottlenecks, allocate memory effectively to reduce code size, and the like.

The basic operation sequence of the analysis tool is as follows:

1. **Start CS+**
   
   Launch CS+ from the [Start] menu of Windows.

   **Remark**
   
   For details on how to start CS+, see "CS+ Integrated Development Environment User's Manual: Project Operation".

2. **Set a project**
   
   Create a new project, or load an existing one.

   **Remark**
   
   For details on how to set a project, see "CS+ Integrated Development Environment User's Manual: Project Operation".

3. **Create a load module**
   
   Create a load module by running a build after setting of the active project and the build tool to be used.

   **Caution**
   
   Run a build after setting the [Enable static analysis information] property in the [General] category on the [Settings] tab of the Property panel to [Yes], in order to generate the cross reference information required for the analysis tool without depending on the configuration of the build-tool being used (see "(1) Static analysis information").

   **Remarks 1.**
   
   For details on how to create a load module, see "CS+ Integrated Development Environment User's Manual: Project Operation" of the compiler to use.

   **Remarks 2.**
   
   If the build completes without compiler or assembler errors, then at this point the Static analysis information can be displayed in the Function List panel/Variable List panel/Call Graph panel/Class/Member panel.

4. **Execute downloading**
   
   Connect CS+ to the debug tool after configuring the operational environment of the debug tool, and then download the load module created in steps (3) to the debug tool.

   **Caution**
   
   Connect to the debug tool after setting the [Enable dynamic analysis information] property in the [General] category on the [Settings] tab of the Property panel to [Yes], in order to acquire the dynamic information necessary for the analysis tool without depending on the configuration of the debug tool being used (see "(2) Dynamic analysis information").

   **Remark**
   
   For details on how to execute download, see "CS+ Integrated Development Environment User's Manual: Debug Tool" of the microcontroller used.

5. **Execute programs**
   
   Execute the program on the debug tool.

   **Remark**
   
   For details on how to execute programs, see "CS+ Integrated Development Environment User's Manual: Debug Tool" of the microcontroller used.

6. **Specify the files to be analyzed**
   
   If necessary, specify the files to be analyzed by the analysis tool (see "1.1.1 What is analyzed").
(7) **Display Function Information**

Display the Function List panel in order to validate the acquired function information.
The Function List panel can be operated as follows, in accordance with the purpose.
Note that if the program is modified during debugging, the operation is repeated via (3), above.

(a) **Customize Display Method**

Change the display method (e.g. set which columns to display and the sorting order) on the panels.

(b) **Jump to Defined Location**

Jump to the location where the function on the panel has been defined.

(c) **Set a breakpoint to a function**

Set a breakpoint to the function on the panel.

(d) **Display List of Referencing Location**

Find and display a list of locations referencing the function on the panel.

Remark It is also possible to display the function information defined in other than the active project.
For detailed instructions on displaying function information, see "2.12 Import or Export Information File".

(8) **Display Variable Information**

Display the Variable List panel in order to validate the acquired variable information.
The Variable List panel can be operated as follows, in accordance with the purpose.
Note that if the program is modified during debugging, the operation is repeated via (3), above.

(a) **Customize Display Method**

Change the display method (e.g. set which columns to display and the sorting order) on the panels.

(b) **Jump to Defined Location**

Jump to the location where the function on the panel has been defined.

(c) **Set a break event to a variable**

Set a break event with access condition to the variable on the panel.

(d) **Register Watch-Expressions**

Register variables to the Watch panel (Watch1) as watch-expressions.

(e) **Display List of Referencing Location**

Find and display a list of locations referencing the variable on the panel.

Remark It is also possible to display the function information defined in other than the active project.
For detailed instructions on displaying function information, see "2.12 Import or Export Information File".

(9) **Display Calling Relationships between Functions (Call Graph)**

Display the Call Graph panel in order to validate the relationship between functions.
The Call Graph panel can be operated as follows, in accordance with the purpose.

(a) **Jump to Defined Location**

Jump to the location where the function/variable on the call graph has been defined.

(b) **Search for a function/variable**

Search for an arbitrary function/variable existing in the call graph.

(10) **Display Class/Function/Variable Information**

Display the Class/Member panel in order to validate the class information [CC-RX], function information and variable information.
The Class/Member panel can be operated as follows, in accordance with the purpose.

(a) **Jump to Defined Location**

Jump to the location where the class/function/variable on the tree has been defined.

(b) **Jump to Declared Location**

Jump to the location where the class/function/variable on the tree has been declared.

Remark [CC-RX] The class information is provided only when C++ source files are subject to analysis.

(11) **Display Analysis Information in Chart**

Display acquired function information/variable information in a chart.
Note that if the program is modified during debugging, the operation is repeated via (3), above.
(a) **Graph transitions in values**
Display the relationship between values of variable/register/address or of data collected for Smart Analog Note and time in a line chart.

Note: [E1/E2/E2 Lite/E20/COM Port[RL78]]
This feature is supported only when the selected microcontroller incorporates a Smart Analog IC.

(b) **Chart the function execution time ratios**
Display a pie chart of the function execution time ratios.

(12) **Save Analysis Information**
Save the acquired analysis information to a file.

(13) **Save the project file**
Save the setting information of the project to the project file.

Remark: For details on how to save the project file, see "CS+ Integrated Development Environment User's Manual: Project Operation".
2.2 Display Function Information

Display the function information (function name, file name, attribute, reference count, execution count, code coverage, etc.) in the program.

The latest function information that can currently be displayed (see "1.1.2 Types of analysis information") is displayed on the following Function List panel, which is opened by clicking the button on the Main window's toolbar.

Note, however, that the function information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed").

See the Function List panel for details on each of the function information items displayed.

Figure 2.1 Display Function Information (Function List Panel)

Cautions 1. [E20[RX]]

In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of the Dynamic analysis information by trace data will increase because complement of instructions between branch instructions is performed (the processing time is proportional to the set value of the [Trace memory size][MByte] property in the same category above).

Cautions 2. [CC-RX]

When C++ source files are subject to analysis, see "3.6 When CC-RX (C++ Source Files) Is Used".

Cautions 3. [CC-RX]

Unused static functions deleted via compiler optimization cannot be displayed in the panel.

Remarks 1. The display contents are updated each time program execution is stopped.

Note, however, that if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Yes] (default), the information will be updated in accordance with the setting on the Property panel.

Remarks 2. The value of the information that has been changed because of the execution of a program is shown highlighted (the color depends on the configuration in the [General - Font and Color] category of the Option dialog box). To reset the highlighting, click the button on the toolbar.

Remarks 3. The current row mark ( ) indicates the current row.

The following operations can be performed on the function with the current row mark.

- Jump to Defined Location
- Set Break Events
- Display List of Referencing Location

Remarks 4. Information for functions defined outside the active project, and which are never referenced from the active project, is ordinary not displayed in the Function List panel.

For detailed instructions on displaying function information in this case, see "2.12 Import or Export Information File".
2.3 Display Variable Information

Display the variable information (variable name, file name, attribute, read count, write count, data coverage, etc.) in the program.

The latest variable information that can currently be displayed (see "1.1.2 Types of analysis information") is displayed on the following Variable List panel, which is opened by clicking the button on the Main window's toolbar.

Note, however, that the variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed").

See the Variable List panel for details on each of the variable information items displayed.

Figure 2.2 Display Variable Information (Variable List Panel)

Cautions 1. [E20[RX]]
In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of the Dynamic analysis information by trace data will increase because complement of instructions between branch instructions is performed. If you focus only on variables, we recommend selecting [Data access] in this property.

Cautions 2. [CC-RX]
When C++ source files are subject to analysis, see "3.6 When CC-RX (C++ Source Files) Is Used".

Cautions 3. [CC-RX]
Unused variables deleted via compiler optimization are not displayed.

Remarks 1. The display contents are updated each time program execution is stopped.
Note, however, that if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Yes] (default), the information will be updated in accordance with the setting on the Property panel.

Remarks 2. The value of the information that has been changed because of the execution of a program is shown highlighted (the color depends on the configuration in the [General - Font and Color] category of the Option dialog box). To reset the highlighting, click the button on the toolbar.

Remarks 3. The current row mark ( ) indicates the current row.
The following operations can be performed on the function with the current row mark.
- Jump to Defined Location
- Set Break Events
- Display List of Referencing Location
- Graph transitions in values

Remarks 4. Information for functions defined outside the active project, and which are never referenced from the active project, is ordinary not displayed in the Variable List panel.
For detailed instructions on displaying function information in this case, see "2.12 Import or Export Information File".
2.4 Display Calling Relationships between Functions (Call Graph)

You can display a tree-structured chart (call graph) that represents calling relationships between functions in the program based on the acquired function information.

The latest call graph that can currently be displayed (see "1.1.2 Types of analysis information") is displayed on the following Call Graph panel, which is opened by clicking the button on the Main window's toolbar.

Note, however, that the function information and variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed").

See the Call Graph panel for details on the call graph displayed.

Figure 2.3 Display Calling Relationships between Functions (Call Graph Panel: Whole View)

Cautions 1. If the debug tool to use does not support the trace function, or if the debug tool's trace function is not enabled, then the Dynamic analysis information (e.g. the execution count/read count/write count) in the call graph cannot be displayed.

For the dynamic analysis information, see the caution of "(a) Trace function".

Cautions 2. [CC-RX]
When C++ source files are subject to analysis, see "3.6 When CC-RX (C++ Source Files) is Used".

The following operations can be performed on the call graph displayed.

1. Change a parent function

   By default, the first function to appear named "main" or containing such word is considered to be the parent function, and that function is placed on the left edge of the call graph in a box format (function box).

   Select a function from the drop-down list of the [Parent Function Name] combo box to change the parent function to be displayed in call graph.

   Remark [RH850]
   If the selected microcontroller version supports multi-core, you can select "PMn" in the [Parent Function Name] combo box. In this case, the call graph will only be displayed for the functions executed in the selected PMn/PEn.

2. Display the parent and child functions of the specified function

   By clicking the button on the panel control area, the call graph is switched to Details view that displays the parent functions and child functions of the function currently being specified with the [Target Function Name] combo box.
In the details view, when global variables, static variables inside a file or static variables inside a function accessed from the target function exist, these variables are also displayed as variable boxes.

To switch to Whole view (default), click the button again.

Figure 2.4 Display Parent and Child Functions (Call Graph Panel: Details View)

(3) Jump to defined location
By double-clicking on a function box/variable box in the call graph, you can jump to the location of the source text where that function/variable is defined (see "2.7 Jump to Defined Location").

(4) Pop-up display of the function/variable information
When the mouse cursor is hovered over a function box/variable box in the call graph, information about that function/variable appears in a pop-up.

Caution: This function cannot be used while scrolling via the mouse dragging is being enabled by the button on the panel control area.

Figure 2.5 Pop-up Display of Function/Variable Information

(5) Search for a function/variable
You can search for an arbitrary function/variable existing in the call graph.
To do this, click the button on the Call Graph panel's toolbar to open the Call Graph Search dialog box. In this dialog box, follow the steps below.
Figure 2.6  Search for Functions (Call Graph Dialog Box)

(a) Specify [Function/Variable Name]
Specify a function name/variable name to search.
You can either type character strings directly into the text box (up to 2046 characters), or select one from the input history via the drop-down list (up to 10 items).
Next, to specify conditions for the specified character strings, select the desired conditions in the [Condition] combo box ([contains] is selected by default).
Searches are case-insensitive if the [Case-sensitive] check box is selected.
Remark You can also specify the function name/variable name with any one of the following methods.
- Drag and drop an arbitrary row of the Function List panel/Variable List panel to this area.
- Drag and drop an arbitrary character strings to this area.

(b) Specify [Class Name] [CC-RX]
If required as a search parameter for a function/variable, you can specify the class name to which a member function/member variable to search belongs.
You can either type character strings directly into the text box (up to 2046 characters), or select one from the input history via the drop-down list (up to 10 items).
Next, to specify conditions for the specified character strings, select the desired conditions in the [Condition] combo box ([contains] is selected by default).
Searches are case-insensitive if the [Case-sensitive] check box is selected.
Remark You can also specify the class name with any one of the following methods.
- Drag and drop an arbitrary character strings to this area.

(c) Specify [Parent Count]
If required as a search parameter for a function, you can specify the number of parent functions to search.
You can either type a value directly into the text box (settable range: 0 to 65535), or select one from the input history via the drop-down list (up to 10 items).
Next, to specify conditions for the specified value, select the desired conditions in the [Condition] combo box ([equals] is selected by default).

(d) Specify [Child Count]
If required as a search parameter for a function, you can specify the number of child functions to search.
You can either type a value directly into the text box (settable range: 0 to 65535), or select one from the input history via the drop-down list (up to 10 items).
Next, to specify conditions for the specified value, select the desired conditions in the [Condition] combo box ([equals] is selected by default).

(e) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, the search uses the specified conditions, starting from the function name/variable name at the bottom of the call graph, and proceeding upward. The corresponding function box/variable box is highlighted.
When the [Search Forward] button is clicked, the search uses the specified conditions, starting from the function name/variable name at the top of the call graph, and proceeding downward. The corresponding function box/variable box is highlighted.

If a function box/variable box has been selected on the Call Graph panel, then the search starts from the corresponding function, moving upward/downward.

Remarks 1. The display contents are updated each time program execution is stopped. Note, however, that if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Yes] (default), the information will be updated in accordance with the setting on the Property panel.

Remarks 2. A function/variable whose source file does not exist in the project can be displayed in the call graph if the [Display the function/variable without definition at Call Graph panel] property in the [General] category on the [Settings] tab of the Property panel is set to [Yes].
2.5 Display Class/Function/Variable Information

You can display the class information [CC-RX], function information and variable information in the program by using a tree structure. These information is displayed on the following Class/Member panel, which is opened by clicking the button on the Main window’s toolbar.

Note, however, that the class information [CC-RX], function information and variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed"). See the Class/Member panel for details on the tree displayed.

Figure 2.8 Display Class Information (Class/Member Panel)

Caution [CC-RX]
The class information is provided only when C++ source files are subject to analysis. When C++ source files are subject to analysis, see "3.6 When CC-RX (C++ Source Files) Is Used".

The acquired information is displayed in the classes/categories tree area (top) and the functions/variables list area (bottom). When a node on the tree displayed in the classes/categories tree area is selected, the information of the node (e.g. function names/variable names defined in the selected node) will be displayed in the functions/variables list area. You can use the [View Setting] combo box in the panel control area to classify the items in the classes/categories tree into the following five groups.

<table>
<thead>
<tr>
<th>Items of List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category group (default)</td>
<td>Classifies and displays classes, interfaces, and other types.</td>
</tr>
<tr>
<td>Access group</td>
<td>Classifies and displays nodes by their access specifiers specified in their classes, etc.</td>
</tr>
<tr>
<td>Namespace group</td>
<td>Classifies and displays nodes by namespaces in which the class and other elements are defined.</td>
</tr>
<tr>
<td>File group</td>
<td>Classifies and displays nodes by the files in which the class and other elements are defined.</td>
</tr>
<tr>
<td>Alphabet group</td>
<td>Displays nodes in alphabetical order.</td>
</tr>
</tbody>
</table>
Remarks 1. The following operations can be performed on the node currently being selected.
- Jump to Defined Location
- Jump to Declared Location

Remarks 2. [CC-RX]
When the mouse cursor is hovered over a node (except for a category node), "Namespace name" to which the node belongs appears in a pop-up.
2.6 Customize Display Method

The following operations will enable you to customize the displaying of items (columns) and the analysis information on the Function List panel/Variable List panel.
All operations refer to the header area of each panel (the area where the column labels are displayed).
- Set the columns to display
- Change the order of the columns to display
- Lock the specific column to display
- Sort the analysis information
- Filter the analysis information

Remark: In the Column Chooser dialog box, click the [Default] button to return all the customizations you have performed via the operations above to the default values.

2.6.1 Set the columns to display

You can show or hide any of the items (columns) displayed on the Function List panel/Variable List panel.

(1) Restricting the columns displayed
(2) Adding columns to display

(1) Restricting the columns displayed
There are two ways to perform this operation, as shown below.
(a) Performing the operation from the panel
Use the mouse to drag and drop the items to hide off of the panel.

Figure 2.9 Restricting Columns Displayed (Operation from Panel)

(b) Performing the operation from the Column Chooser dialog box
On the left edge of the panel’s header area, click the button to open the Column Chooser dialog box, and then clear the check boxes of the names of the items to hide.

Figure 2.10 Restricting Columns Displayed (Operation from Column Chooser Dialog Box)
(2) Adding columns to display

On the left edge of the panel’s header area, click the button to open the Column Chooser dialog box, and then select the check boxes of the names of the columns to display, or drag and drop them directly from the dialog box to the information display area on the panel using the mouse.

Figure 2.11 Adding Columns to Display (Clearing Check Boxes in Column Chooser Dialog Box)

2.6.2 Change the order of the columns to display

You can change the display order of the items (columns) displayed on the Function List panel/Variable List panel. There are two ways to perform this operation, as shown below.

There are two ways to perform this operation, as shown below.

(1) Performing the operation from the panel
(2) Performing the operation from the Column Chooser dialog box

(1) Performing the operation from the panel

Use the mouse to drag and drop the column name to move directly to an arbitrary column (header area).
2.6.3 Lock the specific column to display

You can set specified items (columns) to always be displayed on the Function List panel/Variable List panel, even if the screen display is scrolled.

To do this, use the mouse to click the lock display icons ( ‹ ‡ / ‡ ‹ ) of the desired column name (clicking repeatedly toggles the item display between locked and unlocked).

Columns configured for locked display are locked at the leftmost column, so they will not be scrolled even if the user scrolls horizontally.

The meanings of the lock display icons are as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‹</td>
<td>Indicates that the display is not locked (default).</td>
</tr>
<tr>
<td>‡</td>
<td>Indicates that the display is locked.</td>
</tr>
</tbody>
</table>
Remarks 1. You can also lock the display of a column by dragging and dropping it between two items with locked displays, or to the rightmost column.

Remarks 2. You can also unlock the display of a locked item by dragging and dropping it between two items with unlocked displays.

2.6.4 Sort the analysis information

You can sort the information values on the Function List panel/Variable List panel by column, and in ascending or descending order.

To do this, use the mouse to click the desired column name (clicking repeatedly toggles the sort order between ascending and descending).

If the items to sort are numbers (decimal or hexadecimal), then the information is sorted by numerical value. For other types of data (e.g. strings), the information is sorted by character code.

The following mark appears by the column name of the column that the information is sorted on:

Table 2.5 Marks that Indicate Sorted Display

<table>
<thead>
<tr>
<th>Mark</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲</td>
<td>Indicates that the information is being sorted in ascending order. Click again with the mouse to sort in descending order.</td>
</tr>
<tr>
<td>▼</td>
<td>Indicates that the information is being sorted in descending order. Click again with the mouse to sort in ascending order.</td>
</tr>
</tbody>
</table>

Remark Click while holding down the [Shift] key to sort on multiple columns.

2.6.5 Filter the analysis information

You can set filters for displaying information on the Function List panel/Variable List panel.

The following types of filters are available.

(1) Filtering via custom settings for each column
(2) Filtering results linked to panel

Caution The Filtering via custom settings for each column and the Filtering results linked to panel are mutually exclusive functions. For this reason, the two filtering functions described here cannot be enabled simultaneously (when one of the filters is active, setting the other filter will disable the first one).

(1) Filtering via custom settings for each column
Configure a custom filter for each column, and display the acquired information.
To do this, click on the filter icon ( / ) of the target column name, then select the following menu item.

Table 2.6 Filter Display Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(All)</td>
<td>Does not set filter (resets filter display). Displays all information.</td>
</tr>
<tr>
<td>(Custom)</td>
<td>Opens the Filter Settings dialog box to set detailed filtering conditions. Only information matching the conditions specified in this dialog will be displayed.</td>
</tr>
<tr>
<td>(Blanks)</td>
<td>Displays empty (&quot;-&quot; ) fields.</td>
</tr>
<tr>
<td>(NonBlanks)</td>
<td>Does not display empty (&quot;-&quot; ) fields.</td>
</tr>
<tr>
<td>Information list</td>
<td>All acquired information is displayed in a list as strings. Only values matching the string selected from the list are displayed.</td>
</tr>
</tbody>
</table>

Select [(Custom)] to open the Filter Settings dialog box. Use this dialog box to set up to two condition groups. Both conditions can be linked into a single filtering condition via the logical operator buttons ([AND] / [OR]). Use the top condition-specification area if you only wish to specify one filtering condition.
Figure 2.15 Filtering via Custom Settings for Each Column (Filter Settings Dialog Box)

The meanings of the filter icons are as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Indicates that no filtering is taking place (default).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates that the information is being filtered.</td>
</tr>
</tbody>
</table>

(2) Filtering results linked to panel

(a) Linking with the Project Tree panel
(b) Linking with the Editor panel
(c) Linking with the Debug Manager panel [RH850]

Caution If "(1) Filtering via custom settings for each column" is configured while the information is being filtered via the method described below, linking displays that have been taking place will be reset.

Remark The three filtering functions described below can be used simultaneously.

(a) Linking with the Project Tree panel
Only display values for functions/variables in a file/category selected in the Project Tree panel.
To do this, click the button on the Function List panel/Variable List panel toolbar to enable this filtering function, then from the Project Tree panel, select the desired file(s)/category(s). Click this button again to disable this function. The relationship between the selections in the Project Tree panel and the filtered functions/variables is as follows:

Table 2.8 Filtering Linked to Project Tree Panel

<table>
<thead>
<tr>
<th>Selection</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single file in active project</td>
<td>Functions/variables defined in single file</td>
</tr>
<tr>
<td>Multiple files in active project</td>
<td>Functions/variables defined in multiple files</td>
</tr>
<tr>
<td>Single category in active project</td>
<td>Functions/variables defined in single category</td>
</tr>
<tr>
<td>Multiple categories in active project</td>
<td>Functions/variables defined in multiple categories</td>
</tr>
<tr>
<td>Combination of files and categories in active project</td>
<td>Functions/variables defined in the selected files and categories</td>
</tr>
<tr>
<td>Other than the above</td>
<td>All functions/variables defined in files included in the active project</td>
</tr>
</tbody>
</table>

Caution Assembler source files cannot be analyzed.

Remark If a header file is selected, then functions/variables defined in that header file are displayed.
(b) Linking with the Editor panel
Only display information for functions/variables starting with the word at the caret position in the Editor panel. To do this, click the button on the Function List panel/Variable List panel toolbar to enable this filtering function, then move the caret to the desired function/variable name in the Editor panel. Click this button again to disable this function. Note, however, that if there is no word at the caret position (e.g. if it is at a space or tab character), then the display will not be filtered linked to the Editor panel.

(c) Linking with the Debug Manager panel [RH850]
Only display information for functions/variables in the common region (Common) and PEn currently being selected in the Debug Manager panel. To do this, click the button on the Function List panel/Variable List panel toolbar to enable this filtering function. Click this button again to disable this function. Note, however, that if the selected microcontroller version does not support multi-core, then this function will be invalid.
2.7 Jump to Defined Location

You can jump to the location where the function, variable, or class [CC-RX], etc. on the Function List panel/Variable List panel/Call Graph panel/Class/Member panel is defined.

Cautions 1. If the target of the following operation is a member of an enumeration type, then a jump will be made to the defined location of the enumeration type. Note, however, that it is not possible to jump to the defined location of a member of an anonymous enumeration type via the member node.

Cautions 2. [CC-RX]
When C++ source files are subject to analysis, the defined location information on member functions defined in a template function or a template class cannot be obtained. Therefore, the following operation is invalid for them; except however, when the template function is defined with a static declaration, and defined outside a class.

(1) Jump to the Editor panel
When the jump is executed, the source file in which the target is defined opens in the Editor panel, and the caret moves to the line where it is defined.
To do this, perform the following operation.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Target</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function List panel</td>
<td>A line of function</td>
<td>Double-click</td>
</tr>
<tr>
<td>Variable List panel</td>
<td>A line of variable</td>
<td></td>
</tr>
<tr>
<td>Call Graph panel</td>
<td>- A function box</td>
<td>Double-click</td>
</tr>
<tr>
<td></td>
<td>- A variable box</td>
<td>Note</td>
</tr>
<tr>
<td>Class/Member panel</td>
<td>On the classes/categories tree area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A namespace node [CC-RX]</td>
<td>Select [Jump to Source] from the context menu.</td>
</tr>
<tr>
<td></td>
<td>- A class name node [CC-RX]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An interface name node [CC-RX]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A struct type name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An union type name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An enum type name node</td>
<td></td>
</tr>
<tr>
<td>Class/Member panel</td>
<td>On the functions/variables list area</td>
<td>Double-click</td>
</tr>
<tr>
<td></td>
<td>- A function name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A variable name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A macro name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An alternative name node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An enum member name node</td>
<td></td>
</tr>
</tbody>
</table>

Note If scrolling via the mouse dragging is being enabled by the button on the panel control area, this operation cannot be used. In this case, select [Jump to Source] from the context menu after selecting the target, or disable the scroll function temporarily, then perform the operation above.

(2) Jump to the Disassemble panel/Memory panel
When the jump is executed, the disassembly data/memory list corresponding to the starting address of the target opens in the Disassemble panel (Disassemble1)/Memory panel (Memory1), and the caret moves to the corresponding location (note, however, that this is only possible while connecting to the debug tool).
To do this, perform the following operation.
### Panel Target Operation

<table>
<thead>
<tr>
<th>Panel</th>
<th>Target</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function List panel</td>
<td>A line of function</td>
<td>One of the following:&lt;br&gt;- Jump to the Disassemble panel: Select [Jump to Disassemble] from the context menu. &lt;br&gt;- Jump to the Memory panel: Select [Jump to Memory] from the context menu.</td>
</tr>
<tr>
<td>Variable List panel</td>
<td>A line of variable&lt;sup&gt;Note 1&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td>Call Graph panel</td>
<td>- A function box&lt;br&gt;- A variable box</td>
<td></td>
</tr>
<tr>
<td>Class/Member panel</td>
<td>On the functions/variables list area&lt;sup&gt;Note 2&lt;/sup&gt;</td>
<td>- A function name node&lt;br&gt;- A variable name node&lt;br&gt;- A macro name node&lt;br&gt;- An alternative name node&lt;br&gt;- An enum member name node</td>
</tr>
</tbody>
</table>

**Notes**

1. You can jump to only the Memory panel.
2. Neither a node on the classes/categories tree area nor a node of an instance variable can be target for this function.
2.8 Jump to Declared Location

You can jump to the location of the source text where the function, variable, or class [CC-RX], etc. on the Class/Member panel is declared.

**Caution** [CC-RX]

When C++ source files are subject to analysis, the reference information for functions/variables that are referenced in a member function defined in a template function or a template class cannot be obtained. Therefore, the following operation is invalid for them; except however, when the template function is defined with a static declaration, and defined outside a class.

When the jump is executed, the source file in which the target is declared opens in the Editor panel, and the caret moves to the line of the function prototype declaration (for C source files) or the line of the function prototype declaration inside class declaration (for C++ source files).

To do this, perform the following operation.

<table>
<thead>
<tr>
<th>Target</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the classes/categories tree area</td>
<td>Select [Jump to Declaration of Source] from the context menu.</td>
</tr>
<tr>
<td>- A namespace node [CC-RX]</td>
<td></td>
</tr>
<tr>
<td>- A class name node [CC-RX]</td>
<td></td>
</tr>
<tr>
<td>- An interface name node [CC-RX]</td>
<td></td>
</tr>
<tr>
<td>- A struct type name node</td>
<td></td>
</tr>
<tr>
<td>- An union type name node</td>
<td></td>
</tr>
<tr>
<td>- An enum type name node</td>
<td></td>
</tr>
</tbody>
</table>

On the functions/variables list area

- A function name node
- A variable name node
- A macro name node
- An alternative name node
- An enum member name node

**Remark**

The line to which the caret moves may be the same as the line of the result of selecting [Jump to Source] (see "2.7 Jump to Defined Location").
2.9 Set Break Events

You can set a break event in the debug tool at a function-variable on the Function List panel/Variable List panel.

- Set a breakpoint to a function
- Set a break event to a variable

2.9.1 Set a breakpoint to a function

Set a breakpoint at the start of the function on the Function List panel (the first executable line in the function).

To do this, select the row in which the target function is displayed (make sure that the current row mark ( ) appears to the left of the selected row), then from the context menu, select [Set Break to Function].

Caution
This operation is disabled while disconnecting from the debug tool.

A breakpoint set via this operation is managed in the Events panel as an event whose name is "Break at start of function".

Figure 2.16 Example of Setting Breakpoint in Events Panel

Remarks 1. If there is already a breakpoint set at the corresponding location, the behavior is as follows:

- If a breakpoint in a valid state is set: No effect
- If a breakpoint in an invalid state is set: Sets the breakpoint to a valid state

Remarks 2. [CC-RX]
If the target function is a template function and multiple addresses corresponding to its template function exist, then the breakpoints will be set to all the addresses.

2.9.2 Set a break event to a variable

Set a break event with access condition to a variable on the Variable List panel.

To do this, select the row in which the target variable is displayed (make sure that the current row mark ( ) appears to the left of the selected row), then from the context menu, select one of the following and then press the [Enter] key.

- [Access Break] >> [Set Variable Read Break to]: Sets a break event with read access condition.
- [Access Break] >> [Set Variable Write Break to]: Sets a break event with write access condition.
- [Access Break] >> [Set Variable R/W Break to]: Sets a break event with read/write access condition.

Note that at this time, you can specify the value in the text box in the context menu.

In this case, execution will only break if it is accessed with the specified value. If you press [Enter] key without entering a value in the text box, then execution will break when the target variable is accessed, regardless of the value.
Cautions 1. This operation is disabled while disconnecting from the debug tool.

Cautions 2. For combination break events, this function is available only when the combination condition is "OR".

A break event set via this operation is managed in the Events panel as an event whose name is "Access break to variable".

Remark
If there is already a breakpoint set at the corresponding location, the behavior is as follows:
- If a break event in a valid state is set: No effect
- If a break event in an invalid state is set: Sets the break event to a valid state
2.10 Register Watch-Expressions

You can register variables on the Variable List panel as watch-expressions in the Watch panel (Watch1). To do this, drag and drop the row of the target variable (multiple selections possible) directly onto the Watch panel (Watch1).

**Cautions 1.** This operation is disabled while disconnecting from the debug tool.

**Cautions 2.** This operation is disabled for the ["Total"] row.

**Remark** The name of the watch-expression registered in the Watch panel differs depending on the type of the target variable, as follows:

- Global variable: "variable name"
- Static variable inside a file: "file name#variable name"
- Static variable inside a function: "file name#function name#variable name"
- Class variable: "class name::variable name"
2.11 Display List of Referencing Location

You can find and display a list of locations referencing a function/variable on the Function List panel/Variable List panel. To do this, select the row in which the target function/variable is displayed (multiple selections possible), then from the context menu, select [Find All References]. The results of the search are output to the next Output panel's [Find References] tab.

Figure 2.19 Sample List of Locations Referencing Function (Output Panel)

The following information about the referencing locations is output to the list as the search results. For details on the output format, see the section of the Output panel's [Find References] tab.

- Performing the operation from the Function List panel
  - Location where target function is defined
  - List of locations referencing the target function
  - List of functions called within the target function
  - List of variables referenced (read/write) inside the target function
- Performing the operation from the Variable List panel
  - Location where target variable is defined
  - List of locations referencing the target variable

**Caution** Code in C/C++ source files that is referenced but is eliminated by the preprocessor during compilation (e.g. via "#if" or "#ifdef" statements) is not output as referenced locations.

**Remarks 1.** When the function name/variable name on this panel is double-clicked, the Editor panel appears and the caret moves to the line where the function/variable is defined.

**Remarks 2.** You can save the contents displayed on this Output panel's [Find References] tab to a text file (*.txt) by selecting [Save Output-Find References As...] from the [File] menu.
2.12 Import or Export Information File

Information for functions or variables defined outside the active project, and which are never referenced from the active project, is ordinarily not displayed in the Function List panel/Variable List panel.

In this case, it is possible to force this information to be displayed by importing an information file that saves the information about a function/variable you need.

The following types of information files are available.

Table 2.9 Types of Information Files

<table>
<thead>
<tr>
<th>Information File Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function list file(*.mtfl)</td>
<td>Stores the information about the following items on the Function List panel.</td>
</tr>
<tr>
<td>Variable list file(*.mtvl)</td>
<td>Stores the information about the following items on the Variable List panel.</td>
</tr>
</tbody>
</table>

Note: This item appears only when the selected microcontroller version supports multi-core.

The procedure for doing this is as follows:

(1) Generate (Export) information file

(a) Export an information file manually

This operation will generate an information file with only the functions/variables needed to be imported.

To do this, first make the project in which the target functions/variables are defined the active project, then display the necessary information of the target functions/variables in the Function List panel/Variable List panel.

Next, select all the rows displaying the target functions/variables in this panel (multiple rows can be selected by holding down the [Shift]/[Ctrl] key while selecting), then from the [File] menu, select [Save Function List Data As...]/[Save Variable List Data As...]. The following Save As dialog box opens.

Figure 2.20 Export Information File Manually (Example of Function List File)

In the [Save in] area of the above dialog box, select a folder of your choice in which to save the generated information file, then select "Function List File (*.mtfl)" or "Variable List File (*.mtvl)" from the drop-down list in the [Files of type] area.
Next, enter a file name of your choice for the information file in the [File name] area. Note, however, that the file extension must be "mtfl" for a function list file, and "mtvl" for a variable list file.

Click the [Save] button to generate the information file in the specified folder, with the specified file name.

Remark If you also need information about functions/variables defined outside the active project specified here, then generate a separate information file using the same procedure.

(b) Export information files automatically
This operation will automatically generate information files with all the functions/variables displayed in the Function List panel/Variable List panel each time a build/rebuild is executed.
To do this, specify [Yes] with the [Export the functions and variables] property in the [Import / Export] category on the [Settings] tab of the Property panel, and then specify a file name of your choice for the information files in the [Export file name for functions]/[Export file name for variables] property. Note, however, that the file extension must be "mtfl" for a function list file, and "mtvl" for a variable list file. If you specify a relative path, specify the project folder as the base.

Figure 2.21 [Import / Export] Category

The above setting completes the automatic export of the information file.
Execute a build/rebuild to generate the information file automatically in the specified folder, with the specified file name.

Caution Only the current active project is subject to this export.

Remark The following placeholders are supported in the [Export file name for functions]/[Export file name for variables] property.
- %ProjectName%: Replaces itself with the project name.
- %ActiveProjectName%: Replaces itself with the active project name.

(2) Import the information file
Import the information file you generated (exported).
To do this, set the [Import files] property in the [Import / Export] category on the [Settings] tab of the Property panel. When the [Import files] property is selected, a [...] button appears. When this button is clicked the following Path Edit dialog box opens.

Figure 2.22 [Import files] Property in [Import / Export] Category
In the Path Edit dialog box, in the [Path(One path per one line)] area, specify the names of the information files generated in (1) (including the path), one path per line (up to 259 characters per line/up to 64 lines). If you specify a relative path, specify the project folder as the base.

You can also use the [Browse...] button to specify information files. After you have entered the names of all the files to import, click the [OK] button. The specified paths appear as sub-properties of the [Import files] property.

The above setting completes the import of the information file.

Remarks 1. The following placeholders are supported in the Path Edit dialog box.
- %ProjectName%: Replaces itself with the project name.
- %MicomToolPath%: Replaces itself with the absolute path of the CS+ install folder.

Remarks 2. The information files that have been exported by CubeSuite (CubeSuite function list file (*.csfl)/CubeSuite variable list file (*.csvl)) can also be imported.

Remarks 3. If a function/variable with the same name exists in a import file and an active project, the determination is made according to the following rules.
- When C source files are used
  - If the file names are different, and "static" (only lower case) is included in the attribute in the import file, then it is interpreted as a static function/static variable, and loaded as different function information/variable information.
- If the file names are the same and the function names are different, and "static" (only lower case) is included in the attribute in the import file, then it is interpreted as a static variable in a function, and loaded as different variable information.

- Functions/variables other than the above are interpreted as a global function/global variable or a static function/static variable with the same name in a file, and merged as identical function information/variable information.

- When C++ source files [CC-RX]

- [Class Name], [Namespace], [File Name], and [Arguments] are compared. If any one of these does not match, then it is loaded as different function information.

- [Class Name], [Namespace], [Function Name], [File Name], and [Arguments] are compared. If any one of these does not match, then it is loaded as different variable information.

- Functions/variables other than the above are merged as identical function information/variable information.

The rules for determining merging as identical function information/variable information are as follows:

<table>
<thead>
<tr>
<th>Items</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Variable</td>
</tr>
<tr>
<td>[Class Name][CC-RX] [Namespace][CC-RX] [Function Name] [File Pass] [PM Information][RH850][Note] [Arguments Count] [Arguments] [Return Type] [Access Specifier][CC-RX] [Attribute]</td>
<td></td>
</tr>
<tr>
<td>[Code Size[Bytes]]</td>
<td>[Size[Bytes]]</td>
</tr>
</tbody>
</table>

Note This item appears only when the selected microcontroller version supports multi-core.

(3) Cancel the file import
To cancel the file import, delete the import files on the Path Edit dialog box.
2.13 Display Analysis Information in Chart

You can display the acquired function information and variable information (including the data information for Smart Analog ICs) in a chart.

To display a chart, click the button on the Main window’s toolbar to open the Analysis Chart panel.

The following content is graphed in the Analysis Chart panel.

- Graph transitions in values
- Chart the function execution time ratios

Note [E1/E2/E2 Lite/E20/COM Port[RL78]]
This feature is supported only when the selected microcontroller incorporates a Smart Analog IC.

Figure 2.25 Example of Graphs for Analysis Information (Analysis Chart Panel)

2.13.1 Graph transitions in values

Display the relationship between registered variable/register/address/other values and time by a graph (line chart).

Furthermore, when the selected microcontroller incorporates a Smart Analog IC [E1/E2/E2 Lite/E20/COM Port[RL78]], by enabling the Data collection mode on the debug tool, it is possible to display the collected data for Smart Analog by a graph.

Graphs are displayed in the Analysis Chart panel’s [Variable Value Changing Chart] tab.
See the [Variable Value Changing Chart] tab for details on each of the area displayed.

Note
Data collection mode
This mode is the debug tool's feature that is supported only when the selected microcontroller incorporates a Smart Analog IC [E1/E2/E2 Lite/E20/COM Port[RL78]].
When the debug tool is in this mode, the data for Smart Analog can be collected while a program is executed. This mode becomes valid by performing the following setting on the debug tool's Property panel:
[Debug Tool Settings] tab >> [Smart Analog] category >> [Collect data during the execution] property >> [Yes]
Cautions 1.  A graph is displayed based on trace data or real-time RAM monitoring results acquired by the debug tool. To display a graph, see cautions of "(a)Trace function" or "(b)RRM function/RRM monitor (pseudo RRM) function".

Cautions 2.  When Real-time sampling analysis is specified as the method for acquiring the graph data, see "3.3 Real-time Sampling Analysis".

Cautions 3.  When Trace data analysis is specified as the method for acquiring the graph data, see "3.4 Trace Data Analysis".

Cautions 4.  [E1/E2/E2 Lite/E20/COM Port[RL78]]
To graph the collected data for Smart Analog, a monitor program for collecting data must be linked to the execution program.

Remark  You can change the display range of the cursor information area and channel information area by moving the splitter with the mouse. In addition, these areas can be shown/hidden by clicking the mark on the center of their splitters.

The procedure for displaying the chart is as follows:

(1)  Register graphing targets
Register the item to graph.

   (a) When graphing variable/register/address/other values
   (b) When graphing the data collected for Smart Analog [E1/E2/E2 Lite/E20/COM Port[RL78]]

Caution  Graphing targets cannot be registered in the condition below:
   - During execution of a program
   - When the [Analysis method] property in the [General] category on the [Variable Value Changing] tab of the Property panel is set to [Load from file] (i.e. when graphs are restored from the analysis chart data file (*.mtac))

(a)  When graphing variable/register/address/other values
The following types of items can be registered.
   - Global variable
   - Static variable inside a file
   - Static variable inside a function
   - Class variable (only when C++ source files are subject to analysis)
   - CPU register
There are three ways to register graphing targets, shown below.

When the registration is completed, the name of the registered graphing target will be displayed at the Variable name check box corresponding to the channel number in the channel information area.

<1> Registering targets separately (on the Property panel)
<2> Registering targets separately (from the other panel)
<3> Reflecting the Watch panel (auto registration)

**Caution**
You can register graphing targets for up to 32 channels, one target per channel. Note, however, that there may be restrictions on the number and size of targets that can be graphed, depending on the debug tool used and the method by which the graph data was acquired (see "(2) Specify the method for acquiring the graph data").

<1> Registering targets separately (on the Property panel)
Enter the name of the target directly from the keyboard into the [Variable/Address 1 - 32] property in the [Channel 1 - 32] category on the [Variable Value Changing] tab of the Property panel.

![Channel 1 - 32] Category

In addition, the following detailed conditions can be specified with the [Channel 1 - 32] category for each target (see "(4) Display graphs").

- [Type/Size 1 - 32]: Type and size
- [Value per grid [Val/Div] 1 - 32]: Value per grid unit in graph
- [Offset 1 - 32]: Offset value of graph
- [Color 1 - 32] property: Rendering color of graph

**Remarks 1.** To delete the registered graphing target, delete the value of the above [Variable/Address 1 - 32] property.

**Remarks 2.** The registered graphing target name is displayed at the Variable name check box on the [Variable Value Changing Chart] tab.

<2> Registering targets separately (from the other panel)
From the following panel, drag and drop the target directly onto the Channel number or Variable name check box in this tab.

- Variable List panel
- Editor panel
- CPU register panel
- IOR panel [RH850][RX]
- SFR panel [RL78]
- Watch panel

**Note**
The name of the graphing target displayed differs depending on the type of the variable, as follows:

- Global variable: "variable name"
- Static variable inside a file: "file name#variable name"
- Static variable inside a function: "file name#function name#variable name"
- Class variable: 
  "class name::variable name"

Remarks 1. Other than the above, on the Variable List panel or the Editor panel, you can also register the
selected variable as a graphing target, by selecting [Register to Analysis Chart] from the con-
text menu.

Remarks 2. To delete the registered graphing target, delete the value of the [Variable/Address 1 - 32] pro-
PERTY in the [Channel 1 - 32] category on the [Variable Value Changing] tab of the Property
panel.

<3> Reflecting the Watch panel (auto registration)
By clicking the [Reflect] button on the graph control area, you can automatically register watch-expressions
currently being registered in the Watch panel (Watch1) as graphing targets.
Up to 32 watch-expressions in the Watch panel (Watch1), from top to bottom can be registered. If fewer than
32 watch-expressions have been registered, only the registered number are registered.

Caution  
Clicking the [Reflect] button will cause the information of graphing targets being registered to be deleted (the graph being displayed will be erased).

Remarks 1. Categories themselves are not registered, but variables and other elements within categories are.

Remarks 2. If a variable has child nodes (e.g. arrays and structures), expanded variables and the like, such
as structure members and array indices, are not registered.

Remarks 3. If a name matches a graphing target that has already registered, then it will be registered twice.

(b) When graphing the data collected for Smart Analog [E1/E2/E2 Lite/E20/COM Port[RL78]]
This feature is enabled only when the selected microcontroller incorporates a Smart Analog IC.
First, set the debug tool used to the Data collection mode.
Next, specify the channel numbers in which the data is received from a device with the [Data collection channel]
property in the [Smart Analog] category on the [Variable Value Changing] tab of the Property panel. In the drop-
down list, select the check box of the channel number to be used (up to 8 channels can be selected).

Caution  
The [Smart Analog] category appears only when the debug tool is set in the Data collection
mode.

Figure 2.28  [Smart Analog] Category

In addition, the following detailed conditions can be specified with the [Channel 1 - 32] category on the [Variable
Value Changing] tab of the Property panel for each channel (see "(4)Display graphs").

- [Variable/Address 1 - 32]: Character strings that are displayed at the Variable name check box
- [Value per grid[Val/Div] 1 - 32]: Value per grid unit in graph
- [Offset 1 - 32]: Offset value of graph
- [Color 1 - 32] property: Rendering color of graph
(2) Specify the method for acquiring the graph data

There are three ways to acquire the data for graphing, as shown below.
Select the method in the [Analysis method] property in the [General] category on the [Variable Value Changing] tab of the Property panel, in accordance with the purpose.

**Cautions 1.** The method for acquiring the graph data cannot be changed during execution of a program.

**Cautions 2.** If graph data has already been acquired, then changing this setting will cause the stored graph data to be deleted (the graph being displayed will be erased).

---

**Figure 2.30 **[Analysis method] Property

---

<table>
<thead>
<tr>
<th>Method for Acquiring Graph Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time sampling analysis</td>
<td>Select [Real-time sampling] in this property. This method displays graphs based on the data acquired via the RRM function/ RAM monitor (pseudo RRM) function of the debug tool (default). <strong>[E1/E2 Lite/E20/COM Port[RL78]]</strong> If the debug tool is set in the Data collection mode, then the data will be collected using a sampling method. Note for Smart Analog. Therefore, select this item When graphing the data collected for Smart Analog <strong>[E1/E2 Lite/E20/COM Port[RL78]]</strong>. <strong>[Simulator]</strong> Changes in IOR/SFR cannot be displayed.</td>
</tr>
<tr>
<td>Trace data analysis</td>
<td>Select [Analysis of trace data] in this property. This method displays graphs based on the trace data acquired via the Trace function of the debug tool. This item does not appear when any one of the following: - The debug tool does not support the trace function. - The debug tool does not support the trace time tag feature. - The debug tool is set in the Data collection mode. <strong>[E1/E2 Lite/E20/COM Port[RL78]]</strong></td>
</tr>
<tr>
<td>Load from file</td>
<td>Select [Load from file] in this property. This method restores graphs by loading the analysis chart data file (*.mtac) that have been saved (see *(6)Save the graph data to restore the graph).</td>
</tr>
</tbody>
</table>

Note

The following property setting on the Property panel is required.

- [Variable Value Changing] tab >> [Smart Analog] category >> [Sampling interval[ms]] property

The differences depending on the method for acquiring graph data are as follows:
### Table 2.11 Differences Depending on Method for Acquiring Graph Data

<table>
<thead>
<tr>
<th>Differences</th>
<th>Real-time Sampling Analysis</th>
<th>Trace Data Analysis</th>
</tr>
</thead>
</table>
| **Graph display** | Possible when the debug tool is in any of the following states:  
- RRM function/RAM monitor (pseudo RRM) function is enabled  
- Data collection mode [E1/E2/E2 Lite/E20/COM Port[RL78]] | Possible when Trace function of the debug tool is enabled |
| **Chart type** | One of the following<sup>Note 1</sup>  
- Step-plot line chart  
- Normal line chart | Step-plot line chart (fixed) |
| **Registration of graphing targets** | Before execution of a program | Not dependent on the execution timing because analysis is based on trace data |
| **Number of targets that can be graphed** | Dependent on the size of the target area of RRM function<sup>Note 2</sup>. | If Point Trace events are used:  
Dependent on the maximum number of enabled events<sup>Note 3</sup> in the debug tool |
| **Size of targets that can be graphed** | - Less than or equal to 4 bytes | - Less than or equal to 4 bytes [CC-RH][RX]  
- Less than or equal to 2 bytes [RL78] |
| **Time display range** | The execution time, from the start to the end of program execution (Run-Break time) | Time registered as trace data |
| **Time display format** | XXXsXXXms | XXXsXXXmsXXXμsXXXns |
| **Trigger function** | Available (see "(3)Use the trigger function") | None |
| **Real-time update** | Possible | Impossible |
| **Transition points of value** | Not possible to identify accurate time/change points, because they depend on the specified sampling interval<sup>Note 4</sup>. | Matches actual timing (can be checked from Pop-up display) |
| **Target core [RH850]** | See "(b)RRM function/RAM monitor (pseudo RRM) function". | See "(a)Trace function". |
| **Note** | See "3.3 Real-time Sampling Analysis". | See "3.4 Trace Data Analysis". |

**Notes**

1. This depends on the following setting on the Property panel:

2. **[E20(JTAG)][RX600 Series]**
   - Some restrictions apply to the size and the number of the target area for the RRM function. Therefore, CS+ automatically determines the target area within the restrictions.
   - For details on "the target area for the RRM function", see "CS+ Integrated Development Environment User's Manual: Debug Tool" of the microcontroller used.

3. The number of events that can be set to "valid state" simultaneously differs depending on the microcontroller and the debug tool. For details on "Maximum number of enabled events", see "CS+ Integrated Development Environment User's Manual: Debug Tool" of the microcontroller used.

4. When RRM function/RAM monitor (pseudo RRM) function is used:
   - Debug tool's Property panel >> [Debug Tool Settings] tab >> [Access Memory While Running] category >> [Display update interval[ms]] property
   - When the debug tool is in the Data collection mode [E1/E2/E2 Lite/E20/COM Port[RL78]]:
     - Property panel >> [Variable Value Changing] tab >> [Smart Analog] category >> [Sampling interval[ms]] property
(3) Use the trigger function
If you specify Real-time sampling analysis, you can control the timing with which the graph is displayed in response to the specified trigger. You can use this trigger function to display the graph with the appearance of an oscilloscope.
The trigger function can be configured in the [Trigger] category on the [Variable Value Changing] tab of the Property panel.
Your configuration contents will be listed on this tab as the trigger information.
Caution The properties in the [Trigger] category cannot be changed during execution of a program.

Figure 2.31 Setting of Trigger Function ([Trigger] Category)

(a) [Use trigger function]
Select whether to use the trigger function.
Select [Yes] to use the trigger function (default: [No]).

(b) [Trigger mode]
Select the trigger mode (the timing at which graphs are updated).

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Updates the graph display cyclically in real time (default). When a trigger signal is received, the data immediately prior to the trigger signal is graphed to the left of the trigger position, and the data immediately after the trigger signal is graphed to the right of the trigger position. When the graph reaches the right edge of the graph area, the graph resumes scrolling to the left, and the graph display is updated.</td>
</tr>
<tr>
<td>Single</td>
<td>Only updates the graph display upon the first trigger signal from the start of sampling. When a trigger signal is received, the data immediately prior to the trigger signal is graphed to the left of the trigger position, and the data immediately after the trigger signal is graphed to the right of the trigger position. When the graph reaches the right edge of the graph area, the graph display stops updating and sampling.</td>
</tr>
<tr>
<td>Normal</td>
<td>Only updates the graph display upon trigger signals. When a trigger signal is received, the data immediately prior to the trigger signal is graphed to the left of the trigger position, and the data immediately after the trigger signal is graphed to the right of the trigger position. When the graph reaches the right edge of the graph area, the graph display stops updating. Because sampling does not stop, the graph display is updated upon the next trigger signal.</td>
</tr>
</tbody>
</table>


Remark Triggers are suspended while the graph is being updated in response to a trigger signal. A trigger signal received during this time will not cause the graph display to be updated. In [Auto] and [Single] modes, trigger signals are ignored while triggers are suspended. In [Normal] mode, the graph is updated in response to the latest trigger signal when trigger suspension is lifted.

(c) [Trigger source]
Select the variable (channel) that is the source of trigger signal.
Select a channel between ch1 and ch32 (default: [ch1]).

(d) [Trigger level]
Specify the threshold value for determining as a trigger signal.
The variable (channel) specified for [Trigger source] determines whether a trigger signal is recognized, according to whether the value exceeds the threshold set here.
Directly enter a value with a decimal or hexadecimal number in the range "minimum trigger source" to "maximum trigger source" (floating-point decimals allowed) (default: [0]).

Remark: The trigger level is displayed on the right part of graphs as the trigger mark ( ). The trigger level can be changed by dragging on this trigger mark (note, this operation is disabled during execution of a program).

(e) [Direction of trigger edge]
Select the direction of the threshold value specified with [Trigger level]. The variable (channel) specified for [Trigger source] determines whether a trigger signal is recognized, according to whether the value exceeds the threshold in the direction set here.

<table>
<thead>
<tr>
<th>Rising</th>
<th>Generates a trigger signal when the value of [Trigger source] changes from less than [Trigger level] to greater than or equal to [Trigger level] (default).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Falling</td>
<td>Generates a trigger signal when the value of [Trigger source] changes from greater than [Trigger level] to less than or equal to [Trigger level].</td>
</tr>
<tr>
<td>Both</td>
<td>Generates a trigger signal when both &quot;Rising&quot; and &quot;Falling&quot;.</td>
</tr>
</tbody>
</table>

(f) [Trigger position]
Specify the position on the X axis for rendering the location at which the trigger signal occurred (i.e. position where the data is graphed after a trigger signal occurs). Directly enter a value with a decimal number in the following range (default: [0s]).

Note that if the unit (s, ms, us, ns: case insensitive) is omitted, it will be handled as "ms".

- 0 to "(the value of the [Time per grid(Time/Div)] property) x 10"

Remark: The trigger position is displayed on the upper part of graphs as the trigger mark ( ). The trigger position can be changed by dragging on this trigger mark (note, this operation is disabled during execution of a program).

(g) [Trigger mark color]
Specify the color of the trigger marks ( / ) that indicate the trigger level and the trigger position. Specify with the color selection combo box or directly enter the value in decimal number/hexadecimal number (prefix "0x" is needed) or the color name (see "About the specification of the color") (default: [Color Orange]).

(4) Display graphs
After you have executed Note and stopped the program, the latest graph for the registered graphing target is displayed (default). Note, however, that no graphs will be displayed if the corresponding data could not be acquired. Graphs are updated when:

- **Real-time sampling analysis**
  Each time of the specified sampling interval, even if a program is running. You can control (toggle) the start/stop of a real-time sampling manually via the [Sampling] button on this tab, by performing the following setting on the Property panel.

- **Trace data analysis**
  Each time program execution is stopped. Note, however, that if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Yes] (default), the information will be updated in accordance with the setting on the Property panel.

Note: [E1/E2/E2 Lite/E20/COM Port[RL78]]
Click the [ ] button on the debug toolbar to operate the debug tool in the Data collection mode (all execution-related buttons other than the [ ] button are disabled). For details on Smart Analog function, see "CS+ Integrated Development Environment User's Manual: Debug Tool".

Cautions 1. If the acquired graph data exceeds the buffer capacity (10000 plots), then the oldest graph data is overwritten by the new graph data (ring buffer system). In this case, part of the graph rendering will be blank.

Cautions 2. When Real-time sampling analysis is selected, if acquiring graph data has failed, lines between transition points are not displayed but only the time information is displayed (see "(a)Graph").

Cautions 3. [E1/E2/E2 Lite/E20/COM Port[RL78]]
If you run the program by the debug tool in the Data collection mode, change the [Data collection
channel] property in the [Smart Analog] category on the [Variable Value Changing] tab of the Property panel, and run the program again in the data collection mode, the first transition point in the graph may be incorrect.

Remark There are limitations to the trace memory area of the debug tool. Consequently, if the graph is displayed via Trace data analysis, then we recommend setting a Point Trace event for the graphing target in the Watch panel, in order to display transitions of values over a wider range.

The display of this graph can be configured as follows:

(a) Limitation of graphs displayed
You can select the graph to be displayed. In the default condition, all graphs of channels where the graphing target is being registered are displayed. To hide a graph, clear the Variable name check box corresponding to its channel number.

(b) Selection of the chart type
When Real-time sampling analysis is selected, you can select the chart type to be displayed. To change the chart type, set the [Chart type] property in the [General] category on the [Variable Value Changing] tab of the Property panel (note, however, that if Trace data analysis is selected, then the chart type is fixed to [Step line chart]).

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line chart</td>
<td>Creates a graph linking each plot via straight lines (default).</td>
</tr>
<tr>
<td>Step line chart</td>
<td>Creates a graph linking each plot via perpendicular lines (step-plot chart).</td>
</tr>
</tbody>
</table>

(c) Setting the display range
The graph is displayed by dividing the X and Y axes into a 10 x 10 grid.

<1> Use the auto adjustment function (default)
According to the obtained graph data, optimum values are calculated for the time per unit grid (Time/Div) for the X axis and the value per unit grid (Val/Div)/offset value for the Y axis as described below (default) to display a graph.

- X axis (time)
The grids are automatically adjusted so that the specified number of value transition points on the graph fit inside the rendering area (between the left and right ends).

- Y axis (value)
The grids are automatically adjusted so that the upper and lower ends of the rendering area correspond to the maximum and minimum values of the graph data, respectively.

Note In the default condition, 20 points are specified. This value can be changed via the [Number of transition location for auto adjustment] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

Cautions 1. The auto adjustment function is disabled when the trigger function is used or the debug tool is set in the Data collection mode.

Cautions 2. The auto adjustment function becomes invalid when the following operation is performed (the [Auto adjustment] property in the [General] category on the [Variable Value Changing] tab of the Property panel will be changed to [None]).

- The [Time/Div] label or [Val/Div] label on the Analysis Chart panel is double-clicked.
- The display range is changed with the mouse operation (see "Set the display range manually").
Remark  The timing at which the auto adjustment is conducted can be specified with the [Auto adjustment] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

Set the display range manually
First, specify [None] with the [Auto adjustment] property in the [General] category on the [Variable Value Changing] tab of the Property panel. Then, specify the following value.

- X axis (time)
  You can specify the time per unit grid for all channels. To make the setting, set the [Time per grid] property, in the [General] category on the [Variable Value Changing] tab of the Property panel.

- Y axis (value)
  You can specify the value per unit grid or the offset value for each channel individually. To make the setting, set the [Value per grid] property or the [Offset] property, in the [Channel] category on the [Variable Value Changing] tab of the Property panel.

You can also change the values above by any one of the following mouse operations. Note, however, that these operations are disabled during execution of a program.

- The time per unit grid (Time/Div)
  - Double-clicking on the [Time/Div] label in the Analysis Chart panel has the same effect as the automatic adjustment function on the X axis.
  - In the graph area, move the mouse wheel forward or backward while holding down the [Ctrl] key.

- The value per unit grid (Val/Div) or the offset value
  - Double-clicking on the [Val/Div] label in the Analysis Chart panel has the same effect as the automatic adjustment function on the Y axis.
  - Select a graph (the mark of transition points transforms into ), and then move the mouse wheel forward or backward while holding down the [Ctrl] key.

- Offset value
  - Click and vertically drag the mouse while pressing the [Shift] key with the mouse cursor placed over any of the transition points in the graph (the mouse cursor transforms into the icon). Pressing the [Esc] key during dragging the mouse cancels changing the offset value.

(5) Validate the graph data
You can perform the following operations on the displayed graph as needed.

Caution  These operations below are disabled during execution of a program.

(a) Pop-up display at a transition point
Check the information about transition points in the graph.
When the mouse cursor is hovered over a transition point on the graph, information about that location appears in a pop-up.

Note, however, that the content displayed will differ depending on the method for acquiring the graph data (see "(i)Pop-up display").

Figure 2.33  Pop-up Display at Transition Point

Remark  When the [Location] information is shown in a pop-up, you can display the applicable location in the Editor panel by double-clicking the transition point (except for a graph that was restored by loading the analysis chart data file (*.mtac)).
(b) Cursor measurement

You can check the time and value at the position of Cursor-A/Cursor-B on the graph. You can get a cursor measurement for the X axis (time) or Y axis (value). Measurements appear in a list in the cursor information area on this tab (see "(4) Cursor information area"). To perform this measurement, first use the cursor selection button ([X axis (Time)] button/[Y axis (Value)] button) to select the target axis to measure. Then, set Cursor-A and Cursor-B to the desired location on the graph by using the following operations (the cursors are hidden by default).

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Setting (Show)</th>
<th>Clear Setting (Hide)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor-A</td>
<td>[Ctrl] key + click</td>
<td>[Ctrl] key + double-click</td>
</tr>
<tr>
<td>Cursor-B</td>
<td>[Ctrl] key + right-click</td>
<td>[Ctrl] key + right-double-click</td>
</tr>
</tbody>
</table>

Remark: You can change the color of each cursor via the [Cursor-A color]/[Cursor-B color] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

(c) Zoom

You can zoom in on any location on the graph. In the graph control area, select the zoom 1 - 4 check boxes (multiple selections allowed) to open the Variable Value Changing Chart (zoomed in) panel for the checked number(s), and view the specified range in a zoomed display (you can open up to four Variable Value Changing Chart (zoomed in) panels).

Figure 2.34 Zoom

To set the zoom range, select the number of the Variable Value Changing Chart (zoomed in) panel in the [Zoom] combo box, then click and drag with the mouse to select the zoom area. During this time, you can reset the zoom range by using the same operation, as long as Zoom frame appears indicating the drag region displayed on the graph.

To cancel the zoom range setting, press the [ESC] key during dragging.

To clear the set range, double-click somewhere in the graph area (a transition point is not included).

See the Variable Value Changing Chart (zoomed in) panel for details on zoomed views.

Figure 2.35 Zoom (Variable Value Changing Chart (zoom in) Panel)

Remarks 1. You can set separate zoom ranges for each of four Variable Value Changing Chart (zoomed in) panel views.
Remarks 2. You can change the color of each zoom frame via the [Zoom-1 - 4 color] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

(6) Save the graph data to restore the graph
You can restore the graph currently being displayed by loading the analysis chart data file (*.mtac) which saves the data of the graph.

The procedure for restoring the graph is as follows:

(a) Save the graph data

- For the graph on the [Variable Value Changing Chart] tab
When the graph to be saved are being displayed on this tab, select [Save Analysis Chart Data As...] from the [File] menu to open the Save As dialog box.

On this dialog box, select "Analysis Chart Data (*.mtac)" in the [Save as type] area and specify the name of new file in the [File name] area, and then click the [Save] button (note that the file extension must be "mtac").

- For the graph on the Variable Value Changing Chart (zoomed in) panel
When the graph to be saved are being displayed on this panel, select [Save] button to open the Save As dialog box.

On this dialog box, select "Analysis Chart Data (*.mtac)" in the [Save as type] area and specify the name of new file in the [File name] area, and then click the [Save] button (note that the file extension must be "mtac"). However, the graph data saved on the Variable Value Changing Chart (zoomed in) panel is limited to the zoom range.

(b) Load the graph data

On the [Variable Value Changing] tab of the Property panel, select [Load from file] in the [Analysis method] property in the [General] category (see "(2) Specify the method for acquiring the graph data"). Then, specify the analysis chart data file (*.mtac) that was saved previously with the [Analysis chart data file] property in the same category.

Figure 2.36 Load Graph Data ([General] Category)

At this time, data items to be saved/restored are as follows:

<table>
<thead>
<tr>
<th>[Graph data for each channel]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Item</td>
</tr>
<tr>
<td>Value</td>
</tr>
<tr>
<td>Time</td>
</tr>
<tr>
<td>Information about display or non-display</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[Values of properties on the [Variable Value Changing] tab in the Property panel]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Item</td>
</tr>
<tr>
<td>Time per unit grid</td>
</tr>
</tbody>
</table>
Caution Channels without graph data are not saved, regardless of whether the graph is visible. In this case, the default values of the properties for that channel are applied.

Remark See "2.14 Save Analysis Information" for details about saving graph data for purposes other than restoring graphs.

2.13.2 Chart the function execution time ratios

Display a pie chart of the function execution time ratios. The chart is displayed in the Analysis Chart panel's [Execution Time(Percentage) Chart] tab, based on the currently acquired Dynamic analysis information (equivalent to [Execution Time(Percentage) [%]] in the Function List panel). See the [Execution Time(Percentage) Chart] tab for details on each of the area displayed.

Figure 2.37 Chart of Function Execution Time Ratios

Cautions 1. When the debug tool to use does not support the Trace function, or when the debug tool's trace function is not enabled, this chart cannot be displayed.
Even if the trace function is enabled-condition, if there is no trace data in the trace memory, no chart is displayed on this tab, and then the following message will be displayed on the Output panel: "There is no execution time information."

Cautions 2. To display this chart, see cautions of "(a)Trace function".

Cautions 3. [E1/E2/E2 Lite/E20[RX]][EZ Emulator[RX]]
This chart cannot be displayed when the device does not support the trace time tag feature.

Cautions 4. [E1/E2/E2 Lite/E20[RX]][EZ Emulator[RX]]
The results on the [Execution Time(Percentage) Chart] tab may not be exact. This is because the counter
for time-lag measurement of the trace is small and may overflow. Check whether it has overflowed by the timestamp of the Trace panel.

The following operations can be performed on the call graph displayed.

1. Specify the number of functions to display
   You can change the number of functions displayed in the chart. To do this, specify the number in the [The number of functions displaying in the Execution Time(Percentage) Chart] property in the [Analysis Chart] category on the [Settings] tab of the Property panel (set to [10] by default). The targets are graphed in ranking order of highest proportion of execution time taken. Functions exceeding the number specified here are displayed together under "Others".

2. Pop-up display of execution time
   When the mouse cursor is hovered over a function, information about that function's execution time appears in a pop-up.

![Figure 2.38 Pop-up Display of Execution Time](image)

Remark: The display contents are updated each time program execution is stopped. Note, however, that if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Yes] (default), the information will be updated in accordance with the setting on the Property panel.
2.14 Save Analysis Information

You can save the contents of the Function List panel, Variable List panel, Analysis Chart panel, Call Graph panel, and Variable Value Changing Chart (zoomed in) panel to a file.

(1) Save function information
To do this, with the focus on the Function List panel, select [Save Function List Data As...] from the [File] menu. The Save As dialog box opens; perform the operation from this dialog. The following file formats can be specified when saving the information.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text file (*.txt)</td>
<td>Text format</td>
</tr>
<tr>
<td>CSV(Comma-Separated Variables) (*.csv)</td>
<td>CSV format</td>
</tr>
<tr>
<td>Microsoft Office Excel Workbook (*.xls)</td>
<td>Microsoft Office Excel book format</td>
</tr>
<tr>
<td>Function List file (*.mtfl)</td>
<td>File format to import the function information (see &quot;2.12 Import or Export Information File&quot;).</td>
</tr>
</tbody>
</table>

**Caution** Only the items/analysis information currently displayed in the panel can be saved.

(2) Save variable information
To do this, with the focus on the Variable List panel, select [Save Variable List Data As...] from the [File] menu. The Save As dialog box opens; perform the operation from this dialog. The following file formats can be specified when saving the information.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text file (*.txt)</td>
<td>Text format</td>
</tr>
<tr>
<td>CSV(Comma-Separated Variables) (*.csv)</td>
<td>CSV format</td>
</tr>
<tr>
<td>Microsoft Office Excel Workbook (*.xls)</td>
<td>Microsoft Office Excel book format</td>
</tr>
<tr>
<td>Variable List file (*.mtvl)</td>
<td>File format to import the variable information (see &quot;2.12 Import or Export Information File&quot;).</td>
</tr>
</tbody>
</table>

**Caution** Only the items/analysis information currently displayed in the panel can be saved.

(3) Save graph information
To do this, with the focus on the Analysis Chart panel, select [Save Analysis Chart Data As...] from the [File] menu, or with the focus on the Variable Value Changing Chart (zoomed in) panel, click the [Save] button. The Save As dialog box opens; perform the operation from this dialog. The following file formats can be specified when saving the information.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text file (*.txt)</td>
<td>Text format</td>
</tr>
<tr>
<td>CSV(Comma-Separated Variables) (*.csv)</td>
<td>CSV format</td>
</tr>
<tr>
<td>Microsoft Office Excel Workbook (*.xls)</td>
<td>Microsoft Office Excel book format</td>
</tr>
<tr>
<td>Analysis Chart Data (*.mtac)</td>
<td>Analysis chart data file</td>
</tr>
<tr>
<td>Bitmap (*.bmp)</td>
<td>Bitmap format (32-bit) (graphic file format)</td>
</tr>
<tr>
<td>JPEG (*.jpg)</td>
<td>JPEG format (graphic file format)</td>
</tr>
<tr>
<td>PNG (*.png)</td>
<td>PNG format (graphic file format)</td>
</tr>
<tr>
<td>EMF (*.emf)</td>
<td>EMF format (Graphic file format)</td>
</tr>
</tbody>
</table>

Notes 1. This format is only applied to the [Variable Value Changing Chart] tab of the Analysis Chart panel.
Notes 2. Only the area of graph rendering is saved (trigger marks, channel information, etc. cannot be saved).

**Cautions 1.** For the Analysis Chart panel, only the contents of the currently displayed tab will be saved.

**Cautions 2.** When the graphic file format is selected, only the part currently being displayed in the panel will be saved.
(4) Save call graph information
To do this, with the focus on the Call Graph panel, select [Save Call Graph Data As...] from the [File] menu. The
Save As dialog box opens; perform the operation from this dialog.
The following file formats can be specified when saving the information.
Note that when "(Only the visible part)" is selected, only the part currently being displayed in the panel will be
saved.

<table>
<thead>
<tr>
<th>File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmap (*.bmp)</td>
<td>Bitmap format (32-bit) (graphic file format)</td>
</tr>
<tr>
<td>JPEG (*.jpg)</td>
<td>JPEG format (graphic file format)</td>
</tr>
<tr>
<td>PNG (*.png)</td>
<td>PNG format (graphic file format)</td>
</tr>
<tr>
<td>Bitmap (Only the visible part) (*.bmp)</td>
<td>Bitmap format (32-bit) (graphic file format)</td>
</tr>
<tr>
<td>JPEG (Only the visible part) (*.jpg)</td>
<td>JPEG format (graphic file format)</td>
</tr>
<tr>
<td>PNG (Only the visible part) (*.png)</td>
<td>PNG format (graphic file format)</td>
</tr>
<tr>
<td>EMF (*.emf)</td>
<td>EMF format (graphic file format)</td>
</tr>
</tbody>
</table>

Caution: All part of the call graph may not successfully be saved as a graphic file format if the project is too
big.

Remark: If the zoom function has been applied, then the image will be saved at the current zoom ratio
(except for EMF format).
3. CAUTIONS

This chapter describes cautions for using the analysis tool.

3.1 Changing Active Project

If you change the active project, it is possible that nothing will be shown in the Function List panel/Variable List panel/Call Graph panel/Class/Member panel, because no cross reference file has been generated.

If this happens, rebuild after setting the [Enable static analysis information] property in the [General] category on the [Settings] tab of the Property panel to [Yes]. The contents of the panel will be updated.

3.2 Coverage Results

The results of code coverage and data coverage store the program’s execution results. If you repeatedly download, execute, and stop your program, then the results for the repeated actions will be displayed.

To clear the coverage results, select [Clear Coverage Information] from the context menu of the Editor panel/Disassemble panel, and then click the button on the Function List panel/Variable List panel.

If you change the program and execute a build, the allocation addresses of the functions and variables may differ from those of the previous builds. If this happens, coverage ratio will appear for functions that have not been executed, and for variables that have not been read or written.

3.3 Real-time Sampling Analysis

Notes on acquisition of graph data through Real-time sampling analysis are listed below.

- It may not be possible to identify the sampling interval, depending on the number of graphing targets registered.

- It may not be possible to acquire graph data.
  
  If acquiring data has failed, lines between transition points are not displayed but only the time information is displayed (see "(a)Graph").

- When graph data of a 2-, 4-, or 8-byte variable is to be acquired, the process of assigning a value to the variable may be divided into two steps (see "ExampleWhen using the RL78 microcontroller").
  
  If sampling of the variable takes place between the two steps, an incorrect value may be read out because the assignment is not completed.

  **Example**
  
  When using the RL78 microcontroller
  
  In this example, if sampling takes place before "(2)" is executed, the value of variable "value_a" in which only the assignment to the two lower-order bytes has been completed is read out.

  **[C source text]**

  ```c
  long int    value_a = 0;    // Definition of a 4-byte variable
  void func(void)
  {
    value_a = 4000000000;   // Assignment to a 4-byte variable
  }
  
  [Assembly instructions for the assignment processing above]
  ```

  ```assembly
  MOVW    AX, #2800H
  MOVV    !_value_a, AX    ;(1): Assignment to the two lower-order bytes of variable "value_a"
  MOVW    AX, #0EE6BH
  MOVV    !_value_a+2, AX  ;(2): Assignment to the two upper-order bytes of variable "value_a"
  ```
3.4 Trace Data Analysis

Notes on acquisition of graph data through Trace data analysis are listed below.

- It is not possible to display changes in values in the following case:
  - In sections where variables have been assigned to registers via compiler optimization (because reads/writes of variables in such sections cannot be acquired as trace data.)
  - When a 2-byte region is written in units of 1 byte, or a 4-byte region is written in units of 1 or 2 bytes
  - When the debug tool or OCD internal trace cannot acquire trace data of the access type (read/write) (because the graph is rendered by analyzing trace data of the access type.)

- If you mix a Point Trace event and a Trace event specified sections, then the instruction line at the end of the Trace event specified section may be applied to subsequent Point Trace event. For this reason, although [Location] in the pop-up display on the graph should be ".", an invalid file name and line number may appear.

- bit-type, Boolean-type, and _Bool-type variables and structure bit-fields are analyzed in byte units. In cases where bit-type, Boolean-type, and _Bool-type variables and structure bit-fields are allocated to the same address, even a point where access to a single variable or structure bit-field occurs is recorded as a transition point in the graph. Double-clicking on the transition point will jump to the source line of another variable that is allocated to the same address.

- [E20[RX]]
  If [Stop Trace]/[Start Trace] of the context menu on the Trace panel is selected during a program execution, an invalid chart may be displayed.

- [E20[RX]]
  In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of trace data will increase because complement of instructions between branch instructions is performed.
  If you wish to display graphs focusing only on variables, we recommend selecting [Data access] in this property.

3.5 When the Panel Is Opened during Execution of Program

(1) Function List panel/Variable List panel
The updated static analysis information will be displayed. The dynamic analysis information is not updated.

(2) Analysis Chart panel

- If this panel has been never opened since CS+ was launched:

  | [Variable Value Changing Chart] tab | Nothing will be displayed. |
  | [Execution Time(Percentage) Chart] tab | Nothing will be displayed. |

- If this panel has been opened once since CS+ was launched:

  | [Variable Value Changing Chart] tab | - Real-time sampling analysis
  | | The graph will be updated at the specified sampling interval. |
  | | - Trace data analysis
  | | The previous display contents will be displayed. |
  | [Execution Time(Percentage) Chart] tab | The previous display contents will be displayed. |

(3) Call Graph panel

- If this panel has been never opened since CS+ was launched:
  The updated static analysis information will be displayed. The dynamic analysis information is not updated.

- If this panel has been opened once since CS+ was launched:
  The previous display contents will be displayed.
3.6 When CC-RX (C++ Source Files) Is Used

(1) Function List panel
- The following cautions apply to template functions and member functions defined in template classes.
  - "(No Definition)" will appear in the [File Name] column.
  - Only the types will be displayed in the Arguments column. The argument names will not be displayed.
  - ".-" will appear in the [Start Address] and [End Address] columns of member functions defined in template classes. If ".-" appears in the [Start Address] column, you will not be able to jump to the Editor panel, Disassemble panel, or Memory panel.
  - [Find All References] from the context menu does not display the locations of definitions. Information about the referencing functions and variables is also not displayed.
  - This feature does not count the number of function references in template functions and member functions defined in template classes. Similarly, reference information does not appear via [Find All References] from the context menu.
  - It is not possible to set breakpoints at the start of member functions defined in template classes via [Set Break to Function] from the context menu.
  - If a member function defined in a class declaration is only declared and not used, the filename will not be displayed. It will be treated as a function with no defined location.
  - If you specify a function parameter with a class type, ".-" will be displayed in the [Start Address], [End Address] and [Code Size[Bytes]] columns.
  - If you define a function with an argument of type signed char, and an overloaded function with an argument of type char, ".-" will be displayed in the [Start Address], [End Address] and [Code Size[Bytes]] columns.

(2) Variable List panel
- This feature does not display static variables defined in template functions or member functions defined in template classes.
- This feature does not count the number of variable references in template functions and member functions defined in template classes.
- The compiler changes the types of const variables without an extern/volatile declaration to constants. As a result, they will not appear in the Variable List as variables.
- Global variables with the same name defined in anonymous namespaces in different files will be treated as having the same type.
- [Address] and [Size[Bytes]] of anonymous structures and anonymous unions cannot be displayed.

(3) Call Graph panel
- By default, template functions and member functions defined in template classes do not appear in this panel. To display them, on the [Settings] tab of the Property panel, set the [Display the function/variable without definition at Call Graph panel] property of the [General] category to [Yes].
- Functions called from/variables referenced from template functions and member functions defined in template classes do not appear in this panel.
- A constructor/destructor of a class type that was implicitly called in C++ source files does not appear in this panel.

(4) Class/Member panel
- Namespace aliases are not displayed.
- [Jump to Source] or [Jump to Declaration of Source] from the context menu is disabled when template functions or member functions defined in template classes are selected.
A. WINDOW REFERENCE

Appendix A provides detailed explanations of windows/panels/dialog boxes used by the analysis tool.

A.1 Description

The analysis tool has the following windows, panels and dialog boxes.

Table A.1 Window/Panel/Dialog Box List

<table>
<thead>
<tr>
<th>Window/Panel/Dialog Box Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main window</td>
<td>This is the first window to open when CS+ is launched.</td>
</tr>
<tr>
<td>Project Tree panel</td>
<td>Displays the components of the project in a tree structure.</td>
</tr>
<tr>
<td>Property panel</td>
<td>Displays detailed information on the analysis tool and changes the settings of the information.</td>
</tr>
<tr>
<td>Function List panel</td>
<td>Displays the acquired function information.</td>
</tr>
<tr>
<td>Variable List panel</td>
<td>Displays the acquired variable information.</td>
</tr>
<tr>
<td>Analysis Chart panel</td>
<td>Displays charts of the acquired function information and variable information.</td>
</tr>
<tr>
<td>Call Graph panel</td>
<td>Displays calling relationships between functions (call graph).</td>
</tr>
<tr>
<td>Class/Member panel</td>
<td>Displays the acquired class information [CC-RX]Note, function information and variable information in a tree structure.</td>
</tr>
<tr>
<td>Variable Value Changing Chart (zoomed in) panel</td>
<td>Zooms in on the specified range on the chart.</td>
</tr>
<tr>
<td>Output panel</td>
<td>Displays operation logs for various components provided by CS+ and the reference list for functions/variables.</td>
</tr>
<tr>
<td>Select Files not To Analyze dialog box</td>
<td>Specifies files not to analyze.</td>
</tr>
<tr>
<td>Select Files To Analyze dialog box</td>
<td>Specifies files to analyze.</td>
</tr>
<tr>
<td>Column Chooser dialog box</td>
<td>Changes the order of the display items and the setting of display/non-display for the Function List panel/Variable List panel.</td>
</tr>
<tr>
<td>Call Graph Search dialog box</td>
<td>Searches for a function/variable exists in the call graph displayed in the Call Graph panel.</td>
</tr>
<tr>
<td>Filter Settings dialog box</td>
<td>Specifies the filter conditions to display the information on the Function List panel/Variable List panel.</td>
</tr>
</tbody>
</table>

Note  [CC-RX]  The class information is provided only when C++ source files are subject to analysis.
Main window

This is the first window to open when CS+ is launched. In this window, you can open panels for the analysis tool.

Figure A.1 Main Window

The following items are explained here.
- [How to open]
- [Description of each area]

[How to open]
- From the Windows [start] menu, select [All Programs] >> [Renesas Electronics CS+] >> [CS+ for CC].

Remark
In Windows 8.1, select [CS+ for CC (RL78,RX,RH850)] on the start screen.
In Windows 10, select Windows [Start] menu >> [All apps] >> [Renesas Electronics CS+] >> [CS+ for CC (RL78,RX,RH850)].

[Description of each area]

(1) Menubar
(a) [View]
The [View] menu for the analysis tool provides the following items and functions (default).

<table>
<thead>
<tr>
<th>Output</th>
<th>Opens the Output panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Analyzer</td>
<td>The following cascade menus are displayed to open panels for the analysis tool.</td>
</tr>
</tbody>
</table>
## Toolbar
The toolbar for the analysis tool provides the following items and functions (default).

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function List</td>
<td>Opens the <strong>Function List panel</strong>. The function of this item is the same as that of [Function List] in the [View] menu.</td>
</tr>
<tr>
<td>Variable List</td>
<td>Opens the <strong>Variable List panel</strong>. The function of this item is the same as that of [Variable List] in the [View] menu.</td>
</tr>
<tr>
<td>Analysis Chart</td>
<td>Opens the <strong>Analysis Chart panel</strong>. The function of this item is the same as that of [Analysis Chart] in the [View] menu.</td>
</tr>
<tr>
<td>Call Graph</td>
<td>Opens the <strong>Call Graph panel</strong>. The function of this item is the same as that of [Call Graph] in the [View] menu.</td>
</tr>
<tr>
<td>Class/Member</td>
<td>Opens the <strong>Class/Member panel</strong>. The function of this item is the same as that of [Class/Member] in the [View] menu.</td>
</tr>
</tbody>
</table>

## Panel display area
This area consists of multiple panels, each dedicated to a different purpose. See the following sections for details on a panel used by the analysis tool.

- Project Tree panel
- Property panel
- Function List panel
- Variable List panel
- Analysis Chart panel
- Call Graph panel
- Class/Member panel
- Variable Value Changing Chart (zoomed in) panel
- Output panel
This panel is used to display components of the project (microcontroller, design tool, build tool, debug tool, etc.) in a tree structure.

Figure A.2 Project Tree Panel

The following items are explained here.
- [How to open]
- [Description of each area]
- [Context menu]

[How to open]
- From the [View] menu, select [Project Tree].

[Description of each area]

(1) Project tree area
Project components are displayed in tree view with the following given node.

<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Analyzer (Analyze Tool)</td>
<td>This is the analysis tool to use.</td>
</tr>
</tbody>
</table>

Remark
When the node is selected, the detailed information (property) is displayed in the Property panel, and you can change the settings. The Property panel can be opened by double-clicking on the node when the Property panel is not opened.

[Context menu]
The following context menu items are displayed by right clicking the mouse on [Program Analyzer (Analyze Tool)] node.

<table>
<thead>
<tr>
<th>Function List</th>
<th>Opens the Function List panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable List</td>
<td>Opens the Variable List panel.</td>
</tr>
<tr>
<td>Window</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Analysis Chart</td>
<td>Opens the Analysis Chart panel.</td>
</tr>
<tr>
<td>Call Graph</td>
<td>Opens the Call Graph panel.</td>
</tr>
<tr>
<td>Class/Member</td>
<td>Opens the Class/Member panel.</td>
</tr>
<tr>
<td>Property</td>
<td>Opens the Property panel containing the information for the analysis tool.</td>
</tr>
</tbody>
</table>
This panel is used to display the detailed information on the analysis tool and change the settings of the information.

**Figure A.3 Property Panel**

The following items are explained here.

- [How to open]
- [Description of each area]
- [[Edit] menu (Property panel-dedicated items)]
- [Context menu]

**[How to open]**

- On the **Project Tree panel**, select the [Program Analyzer (Analyze Tool)] node, and then select [Property] from the [View] menu.
- On the **Project Tree panel**, select the [Program Analyzer (Analyze Tool)] node, and then select [Property] from the context menu.

**Remark** If the Property panel has been opened, the detailed information on the analysis tool is displayed by selecting the [Program Analyzer (Analyze Tool)] node on the **Project Tree panel**.

**[Description of each area]**

1. **Detailed information display/change area**
   
   In this area, the detailed information on the analysis tool is displayed by category in the list. Also, you can directly change its settings.
   
   The ☐ mark indicates all the items in the category are expanded. The ☑ mark indicates all the items are shrink.
   
   You can expand/shrink the items by clicking these marks or double-clicking the category name.
   
   For details on the information/how to setup in the category and property items contained in it, see the section explaining the corresponding tab.
Tab selection area

Categories for the display of the detailed information are changed when each tab is selected.

In this panel, a following tab is contained (see the section explaining the tab for details on the display/setting).

- [Settings] tab
- [Variable Value Changing] tab

[[Edit] menu (Property panel-dedicated items)]

The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes the latest property value editing being done.</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes the selected character string(s) and copies them to the clipboard while editing the property value.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected range to the clipboard as character string(s).</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the clipboard to the property value while editing the property value.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected character string(s) while editing the property value.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the character strings in the selected property while editing the property value.</td>
</tr>
</tbody>
</table>

[Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

1. While not editing the property value

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset to Default</td>
<td>Restores the selected setting of the property item to default value.</td>
</tr>
<tr>
<td>Reset All to Default</td>
<td>Restores all the selected settings of the property items on the tab to default value.</td>
</tr>
</tbody>
</table>

2. While editing the property value

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes the latest property value editing being done.</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes the selected character string(s) and copies them to the clipboard while editing the property value.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected range to the clipboard as character string(s).</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the clipboard to the property value while editing the property value.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected character string(s) while editing the property value.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the character strings in the selected property while editing the property value.</td>
</tr>
</tbody>
</table>
## [Settings] tab

The [Setting] tab is used to display the detailed information categorized by the following and the configuration can be changed.

1. [General]
2. [Analysis Object]
3. [Import / Export]
4. [Analysis Chart]

### [Description of each category]

1. **General**
   
The general information on the analysis tool is displayed and its configuration can be changed.

<table>
<thead>
<tr>
<th>Enable static analysis information</th>
<th>Select whether the analysis tool should force output of cross reference information when performing a build in order to obtain the cross-reference information necessary to acquire <strong>Static analysis information</strong>, ignoring the property setting(^1) on the build tool specifying whether to output cross reference information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
<tr>
<td>Available values</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable dynamic analysis information</th>
<th>Select whether the analysis tool should forcibly enable the debug tool's functions(^2) and make the standard settings necessary for dynamic analysis, ignoring the property setting specifying whether to enable or disable the debug tool's functions necessary to acquire <strong>Dynamic analysis information</strong>. For the standard settings necessary for dynamic analysis, see &quot;Table A.2Standard Settings Necessary for Dynamic Analysis (Trace Function)&quot; to &quot;Table A.4Standard Settings Necessary for Dynamic Analysis (RRM Function)&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
<tr>
<td>Available values</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>
### Accumulate result of analysis
Select whether to display the cumulative value for each program execution for the execution count and execution time as the analysis information. The target items for this property are as follows:

- **Function List panel**
  - [Execution Count]/[Execution Time][unit]
- **Variable List panel**
  - [Read Count]/[Write Count]/[Read/Write Count]/[Minimum Value]/[Maximum Value]
- **Call Graph panel**
  - [Execution count]/Read count/Write count

<table>
<thead>
<tr>
<th>Default</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

**Available values**
- Yes: Displays the sum of the measurements from the last program execution and from this one.
- No: Displays the measurements for each program execution. If the value is changed from [Yes] to [No], then the current analysis results will be cleared, and the measured values displayed.

### Include the prototype declaration as references
Select whether to target the prototype declaration as the information of the function references when displaying a list of locations referencing a function (see "2.11 Display List of Referencing Location").

<table>
<thead>
<tr>
<th>Default</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

**Available values**
- Yes: Displays the prototype declaration.
- No: Does not display the prototype declaration.

### Refresh at program stop
Select whether to update the contents of the Function List panel/Variable List panel/Analysis Chart panel/Call Graph panel when the program stops executing.

<table>
<thead>
<tr>
<th>Default</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

**Available values**
- Yes: Updates the contents of the panel after the program execution is stopped.
- No: Does not update the contents of the panel even if the program execution is stopped.

**Specify individually**
Enables the button on each panel (updates the contents of the panel by clicking this button).
### Unit of time

<table>
<thead>
<tr>
<th>Default</th>
<th>ns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

#### Available values

<table>
<thead>
<tr>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ns</td>
<td>Displays the time in nanosecond units. The value is rounded to integer number.</td>
</tr>
<tr>
<td>µs</td>
<td>Displays the time in microsecond units. The value is rounded to three decimal places.</td>
</tr>
<tr>
<td>ms</td>
<td>Displays the time in millisecond units. The value is rounded to three decimal places.</td>
</tr>
<tr>
<td>s</td>
<td>Displays the time in second units. The value is rounded to three decimal places.</td>
</tr>
<tr>
<td>h:min:s</td>
<td>Displays the time as &quot;hours, minutes (0 - 59), seconds (0 - 59)&quot;.</td>
</tr>
<tr>
<td>clk</td>
<td>Displays the time in units of clock cycles. The value is rounded to integer number. Note that this item is displayed only when the selected microcontroller supports a time display in units of clock cycles.</td>
</tr>
</tbody>
</table>

### Delimits arguments by new line

<table>
<thead>
<tr>
<th>Default</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

#### Available values

<table>
<thead>
<tr>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Displays in multiple lines, one value per line.</td>
</tr>
<tr>
<td>No</td>
<td>Displays without newlines, comma (&quot;,&quot;), separated.</td>
</tr>
</tbody>
</table>

### Display the SFR / IOR

<table>
<thead>
<tr>
<th>Default</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Changes not allowed</td>
</tr>
</tbody>
</table>

### Display the function/variable without definition at Call Graph panel

<table>
<thead>
<tr>
<th>Default</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

#### Available values

<table>
<thead>
<tr>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Displays the function without definition.</td>
</tr>
<tr>
<td>No</td>
<td>Does not display the function without definition.</td>
</tr>
</tbody>
</table>
### Output function information at program stop [RH850]

Select whether to output the information file for STF to the folder specified with "[Common Options] tab >> [Output File Type and Path] category >> [Intermediate file output folder] property" on the property panel of the build tool to use.

<table>
<thead>
<tr>
<th></th>
<th>Default</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available values</td>
<td>No</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

#### Notes
1. The settings on the following property of your build tool’s Property panel.
   - [CC-RH][CC-RL]
   - [CC-RX]

### Frees memory of host machine when all panels are closed

Select whether to free memory of the host machine when all of the panels provided by the analyze tool (Function List panel, Variable List panel, Analysis Chart panel, Call Graph panel, Class/Member panel, and Variable Value Changing Chart (zoomed in) panel) are closed.

<table>
<thead>
<tr>
<th></th>
<th>Default</th>
<th>Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available values</td>
<td>Yes</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

#### Notes
1. This applies to the following debug tool’s functions (in the order of priority).
- Trace function
- Real-time display update function (RRM function/RAM monitor (pseudo RRM) function)
- Coverage function

The corresponding property settings differ depending on the selected microcontroller and debug tool. For details on how to enable these functions, see "CS+ Integrated Development Environment User's Manual: Debug Tool" of the microcontroller used.

**Notes 3.** The same information as the content on the Function List panel is output to the STF information file (FuncInfo.csv) (including information for items that are currently hidden).

### Table A.2 Standard Settings Necessary for Dynamic Analysis (Trace Function)

<table>
<thead>
<tr>
<th>Microcontroller</th>
<th>Property of Debug Tool&lt;sup&gt;Note&lt;/sup&gt;</th>
<th>Description</th>
<th>Value to be Set When [Yes] is Selected for [Enable dynamic analysis information] Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>[RH850] [RX]</td>
<td>Use trace function</td>
<td>The value of this property automatically changes to [Yes] when the debug tool is connected if [Yes] is selected for the [Enable dynamic analysis information] property.</td>
<td>Yes</td>
</tr>
<tr>
<td>[RL78]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| [RH850]         | Select trace data                    | - When acquiring only function information Select [Branch PC].
                  |                                      | - When acquiring only variable information Select [Data Access].
                  |                                      | - When acquiring function and variable information Select [PC + Data Access]. | - |
| [RX]            | Trace data type                      | - When acquiring only function information Select [Branch].
                  |                                      | - When acquiring only variable information Select [data access].
                  |                                      | - When acquiring function and variable information Select [branch + data access]. | - [RX600][RX700] branch + data access
<pre><code>              |                                      | Note however that the selectable values depend on the device. | - [RX200][RX100] Branch |
</code></pre>
<p>| [RH850] [RX]    | Clear trace memory before running    | Select [Yes]. | Yes |
| [RL78]          | Operation after trace memory is full | Select the operation to be carried out when the trace memory is full with the collected trace data. | Non stop and overwrite to trace memory |
|                 | Accumulate trace time                | Select whether to accumulate trace time tags. | No |
| [RH850] [RX]    | Trace memory size                    | Select the trace memory size. This property however is not displayed for a device that does not support the trace facility. If a large value is selected, a large amount of data can be collected but because of that it takes a longer time to acquire trace data. | - |
| [RL78]          |                                      |             |                                                                                      |
| [RH850]         | Trace priority                       | Select the priority for collecting trace data. | - |</p>
<table>
<thead>
<tr>
<th>Microcontroller</th>
<th>Property of Debug ToolNote</th>
<th>Description</th>
<th>Value to be Set When [Yes] is Selected for [Enable dynamic analysis information] Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>[RX]</td>
<td>Usage of trace function</td>
<td>Select [Trace].</td>
<td>Trace</td>
</tr>
<tr>
<td></td>
<td>Bus Master of data access</td>
<td>Select the bus master that generated a data access.</td>
<td>CPU</td>
</tr>
<tr>
<td></td>
<td>External trace output</td>
<td>Select the method for externally outputting trace data.</td>
<td>-</td>
</tr>
</tbody>
</table>

Note: Set the property in the [Trace] category on the [Debug Tool Settings] tab in the debug tool’s Property panel.

Table A.3 Standard Settings Necessary for Dynamic Analysis (Coverage Function)

<table>
<thead>
<tr>
<th>Microcontroller</th>
<th>Property of Debug ToolNote</th>
<th>Description</th>
<th>Value to be Set When [Yes] is Selected for [Enable dynamic analysis information] Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>[RH850]</td>
<td>Use coverage function</td>
<td>The value of this property automatically changes to [Yes] when the debug tool is connected if [Yes] is selected for the [Enable dynamic analysis information] property.</td>
<td>Yes</td>
</tr>
<tr>
<td>[RX]</td>
<td>Use code coverage function</td>
<td>Select [Yes].</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Coverage area of measurement</td>
<td>Specify the address range (normally the code section range) to be measured by coverage.</td>
<td>-</td>
</tr>
</tbody>
</table>

Note: Set the property in the [Coverage] category on the [Debug Tool Settings] tab in the debug tool’s Property panel.

Table A.4 Standard Settings Necessary for Dynamic Analysis (RRM Function)

<table>
<thead>
<tr>
<th>Microcontroller</th>
<th>Property of Debug ToolNote</th>
<th>Description</th>
<th>Value to be Set When [Yes] is Selected for [Enable dynamic analysis information] Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>[RH850]</td>
<td>Update display during the execution</td>
<td>The value of this property automatically changes to [Yes] when the debug tool is connected if [Yes] is selected for the [Enable dynamic analysis information] property.</td>
<td>Yes</td>
</tr>
<tr>
<td>[RX]</td>
<td>Display update interval[ms]</td>
<td>Specify the update interval of RRM.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Enable the automatic update of realtime display</td>
<td>Select [Yes].</td>
<td>-</td>
</tr>
</tbody>
</table>

Note: Set the property in the [Access Memory While Running] category on the [Debug Tool Settings] tab in the debug tool’s Property panel.

Caution: The above settings are necessary when [Real-time sampling] (default) is selected for the [Analysis method] property on the [Variable Value Changing] tab of the Property panel for the analysis tool.

(2) [Analysis Object]
The detailed information on analysis objects is displayed and its configuration can be changed. For details on the analysis objects, see “1.1.1 What is analyzed”.
### (3) [Import / Export]

The detailed information on import/export functions is displayed and its configuration can be changed. For details on the import/export function, see "2.12 Import or Export Information File".

<table>
<thead>
<tr>
<th>Select specification method of files to analyze</th>
<th>Select the specification method of files to analyze by the analysis tool.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Files not to analyze</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

**Available values**
- Files not to analyze: Specifies files not to analyze.
- Files to analyze: Specifies files to analyze.

<table>
<thead>
<tr>
<th>Files not to analyze</th>
<th>Specify files that are not the subject of analysis. This property appears only when the [Select specification method of files to analyze] property is set to [Files not to analyze].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Files not to analyze[0]</td>
</tr>
<tr>
<td>Modifying</td>
<td>Specify with the Select Files not To Analyze dialog box. The Select files not to analyze dialog box is opened by clicking the [...] button that appears at right edge in the column when this property is selected (no files can be specified on the Property panel).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Files to analyze</th>
<th>Specify files that are the subject of analysis. This property appears only when the [Select specification method of files to analyze] property is set to [Files to analyze].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Files to analyze[0]</td>
</tr>
<tr>
<td>Modifying</td>
<td>Specify with the Select Files To Analyze dialog box. The Select files to analyze dialog box is opened by clicking the [...] button that appears at right edge in the column when this property is selected (no files can be specified on the Property panel).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Import files</th>
<th>Specify the file to import. The following placeholders are supported: %ProjectName% : Replaces itself with the project name. %MicomToolPath% : Replaces itself with the absolute path of the CS+ install folder. The reference point of the relative path is the project folder. Note that if the same file is specified, only the file that is first specified will be imported. The name of the file to import is displayed as the subproperty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Import files [0]</td>
</tr>
<tr>
<td>Modifying</td>
<td>Specify with the Path Edit dialog box. The Path Edit dialog box is opened by clicking the [...] button that appears at right edge in the column when this property is selected (no files can be specified on the Property panel).</td>
</tr>
</tbody>
</table>

**Available values**
- Up to 64 files

<table>
<thead>
<tr>
<th>Export the functions and variables</th>
<th>Select whether to generate the information files (function list file (<em>.mtfl)/variable list file (</em>.mtvl)) with the contents of the Function List panel/Variable List panel when a build or rebuild is performed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

**Available values**
- Yes: Generates the information files.
- No: Does not Generate the information files.
### Export file name for functions

Specify the name of the function list file (*.mtfl) to be generated. The extension (*.mtfl) cannot be changed. If the extension is omitted, "mtfl" is appended. Note that if this property is left blank, no files will be generated.

The following placeholders are supported:
- `%ProjectName%` : Replaces itself with the project name.
- `%ActiveProjectName%` : Replaces itself with the active project name.

The reference point of the relative path is the project folder.

Note that if this property is left blank, no files will be generated.

This property appears only when the [Export the functions and variables] property is set to [Yes].

<table>
<thead>
<tr>
<th>Default</th>
<th>%ProjectName%.mtfl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Directly enter from the keyboard.</td>
</tr>
<tr>
<td>Available values</td>
<td>Up to 259 characters</td>
</tr>
</tbody>
</table>

### Export file name for variables

Specify the name of the variable list file (*.mtvl) generated. The extension (*.mtvl) cannot be changed. If the extension is omitted, "mtvl" is appended. Note that if this property is left blank, no files will be generated.

The following placeholders are supported:
- `%ProjectName%` : Replaces itself with the project name.
- `%ActiveProjectName%` : Replaces itself with the active project name.

The reference point of the relative path is the project folder.

This property appears only when the [Export the functions and variables] property is set to [Yes].

<table>
<thead>
<tr>
<th>Default</th>
<th>%ProjectName%.mtvl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Directly enter from the keyboard.</td>
</tr>
<tr>
<td>Available values</td>
<td>Up to 259 characters</td>
</tr>
</tbody>
</table>

---

(4) **[Analysis Chart]**

The detailed information on analysis graphs is displayed and its configuration can be changed. For details on the analysis graph, see "2.13 Display Analysis Information in Chart".

**Caution** The contents of the Analysis Chart panel is updated automatically if you change the setting of the property in this category.

### The number of functions displaying in the Execution Time(Percentage) Chart

Specify the number of the functions displayed on the [Execution Time(Percentage) Chart] tab of the Analysis Chart panel. The function with a large ratio of the execution time is displayed in the graph by priority, and the remainder is collectively displayed as "Others".

<table>
<thead>
<tr>
<th>Default</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Directly enter from the keyboard.</td>
</tr>
<tr>
<td>Available values</td>
<td>Integer number between 1 and 100</td>
</tr>
</tbody>
</table>
### [Variable Value Changing] tab

The [Variable Value Changing] tab is used to display the detailed information on graphs displayed in the [Variable Value Changing Chart] tab of the Analysis Chart panel categorized by the following and the configuration can be changed.

1. **[General]**
2. **[Trigger]**
3. **[Smart Analog] [E1/E2/E2 Lite/E20/COM Port[RL78]]**
4. **[Channel 1 - 32]**

#### [Description of each category]

1. **[General]**
   - The general information on graphs is displayed and its configuration can be changed.

<table>
<thead>
<tr>
<th>Analysis method</th>
<th>Select the method for acquiring the graph data (see &quot;(2) Specify the method for acquiring the graph data&quot;).</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULT</td>
<td>Real-time sampling</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list. Note that changes cannot be made during execution of a program.</td>
</tr>
<tr>
<td>Available values</td>
<td>Real-time sampling</td>
</tr>
</tbody>
</table>
| Analysis of trace data| Displays graphs based on the trace data acquired via the Trace function of the debug tool. This does not appear when any one of the following: 
   - The debug tool does not support the trace function. 
   - The debug tool does not support the trace time tag feature. 
   - The debug tool is set in the Data collection mode \(^\text{Note 1}\). |
| Load from file        | Displays graphs by loading the analysis chart data file (*.mtac) that has been saved.                    |

#### Analysis chart data file

Specify the analysis chart data file (*.mtac) to restore graphs. The following placeholders are supported:

\%
- `ProjectName`: Replaces itself with the project name.
- `MicomToolPath`: Replaces itself with the absolute path of the CS+ install folder.

The reference point of the relative path is the project folder.

This property appears only when the [Analysis method] property is set to [Load from file].

| DEFAULT               | Blank                                                                                                   |
| Modifying             | Specify with the Open File dialog box. The Open File dialog box is opened by clicking the [...] button that appears at right edge in the column when this property is selected (no files can be specified on the Property panel). |
| Available values      | One file (*.mtac)                                                                                       |
### Start/stop real-time sampling

Select whether the start/stop of the real-time sampling synchronizes to the start/stop of a program execution. This property appears only when the [Analysis method] property is set to [Real-time sampling].

<table>
<thead>
<tr>
<th>Default</th>
<th>Sync</th>
</tr>
</thead>
</table>

**Modifying**

Select from the drop-down list.

**Available values**

<table>
<thead>
<tr>
<th>Sync</th>
<th>Synchronizes to the start/stop of a program execution.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>Does not synchronize to the start/stop of a program execution. It can be controlled via the [Sampling] button on the [Variable Value Changing Chart] tab.</td>
</tr>
</tbody>
</table>

### Auto adjustment

Select whether to calculate the optimum values from the obtained graph data and specify them in the [Time per grid][Time/Div] property and [Value per grid][Val/Div] 1 - 32][Offset 1 - 32] properties for the X and Y axes of the graph (see "(c)Setting the display range").

**[E1/E2/E2 Lite/E20/COM Port[RL78]]**

This property does not appear when the debug tool is set in the Data collection mode.

<table>
<thead>
<tr>
<th>Default</th>
<th>Only during program stop</th>
</tr>
</thead>
</table>

**Note 1.**

Note that [None] is fixed to this property if the [Analysis method] property is set to [Load from file] or the [Use trigger function] property is set to [Yes].

**Modifying**

Select from the drop-down list.

**Available values**

<table>
<thead>
<tr>
<th>Always</th>
<th>Always adjusts the graph display automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only during program stop</td>
<td>Automatically adjusts the graph display only when program execution stops.</td>
</tr>
<tr>
<td>None</td>
<td>Does not adjust the graph display automatically.</td>
</tr>
</tbody>
</table>

### Number of transition location for auto adjustment

Specify the number of value transition points to be displayed in the rendering area when the graph display is automatically adjusted. This property does not appear when the [Auto adjustment] property is set to [None].

<table>
<thead>
<tr>
<th>Default</th>
<th>20</th>
</tr>
</thead>
</table>

**Modifying**

Directly enter from the keyboard.

**Available values**

<table>
<thead>
<tr>
<th>The value in decimal number within the following range.</th>
</tr>
</thead>
<tbody>
<tr>
<td>- 1 to 1000</td>
</tr>
</tbody>
</table>

### Time per grid[Time/Div]

Specify the time for each of the 10 units (grid segments) that the grid area is divided into. This property is enabled only when the [Auto adjustment] property is set to [None].

<table>
<thead>
<tr>
<th>Default</th>
<th>1ms</th>
</tr>
</thead>
</table>

**Note 2.**

Note that the value loaded from the file is set to this property if [Load from file] is specified with the [Analysis method] property.

**Modifying**

Directly enter from the keyboard.

**Available values**

<table>
<thead>
<tr>
<th>Any one of the following (1ns to 10s: in decimal number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- 1 to 10s</td>
</tr>
<tr>
<td>- 1 to 10000ms</td>
</tr>
<tr>
<td>- 1 to 10000000us</td>
</tr>
<tr>
<td>- 1 to 10000000000ns</td>
</tr>
<tr>
<td>Chart type</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Default</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Modifying</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Available values</th>
<th>Line chart</th>
<th>Displays the graph in a normal line chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Step line chart</td>
<td>Displays the graph in a step-plot line chart.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specify foreground color and background color</th>
<th>Select whether to select the foreground color and background color of the graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Available values</th>
<th>Yes</th>
<th>Selects the foreground color and background color of the graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Does not select the foreground color and background color of the graph (i.e. uses the setting of background color for the [Default] item in the Option dialog box).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Background color</th>
<th>Specify the background color(^{Note 3}) of the graph. This property appears only when the [Specify foreground color and background color] property is set to [Yes].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The setting of background color for the [Default] item in the Option dialog box.</td>
</tr>
<tr>
<td>Modifying</td>
<td>Specify with the color selection combo box or directly enter from the keyboard.</td>
</tr>
</tbody>
</table>

| Available values | When directly enter from the keyboard: The value in decimal number/hexadecimal number (prefix "0x" is needed) or the color name (see "About the specification of the color"). |

<table>
<thead>
<tr>
<th>Background color(Lost section)</th>
<th>Specify the background color(^{Note 3}) of the graph in a lost section (see &quot;(a)Graph&quot;). This property appears only when the [Specify foreground color and background color] property is set to [Yes].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The setting of background color for the [Lost] item in the Option dialog box.</td>
</tr>
<tr>
<td>Modifying</td>
<td>Specify with the color selection combo box or directly enter from the keyboard.</td>
</tr>
</tbody>
</table>

| Available values | When directly enter from the keyboard: The value in decimal number/hexadecimal number (prefix "0x" is needed) or the color name (see "About the specification of the color"). |
Notes 1. [E1/E2 Lite/E20/COM Port[RL78]] This feature is supported only when the selected microcontroller incorporates Smart Analog IC.

Notes 2. If the unit (case insensitive) is omitted, when [Real-time sampling] is selected in the [Analysis method] property, it will be handled as "ms". In other cases, it will be handled as "ns". When this property is changed, if the value of the [Trigger position] property is greater than "the value of this property x 10", then "the value of this property x 10" is automatically specified to the [Trigger position] property.

Notes 3. The color specified in this property will also be reflected to the foreground color/background color of the Variable Value Changing Chart (zoomed in) panel.

(2) [Trigger] The information on the trigger function is displayed and its configuration can be changed (see "(3)Use the trigger function").
Use trigger function | Select whether to display the graphs by using the trigger function.
---|---
Default | No
Modifying | Depends on the specification of the [Analysis method] property.
- When [Real-time sampling] is specified
  Select from the drop-down list.
- When [Analysis of trace data] or [Load from file] is specified
  Changes not allowed
  Note that changes cannot be made during execution of a program.
Available values | Yes | Uses the trigger function.
| No | Does not use the trigger function.

Trigger mode | Select the trigger mode (the timing at which graphs are updated).
This property appears only when the [Use trigger function] property is set to [Yes].
---|---
Default | Auto
Modifying | Select from the drop-down list.
  Note that changes cannot be made during execution of a program.
Available values | Auto | Re-renders the graph cyclically. Also clears and re-renders the graph upon receipt of a trigger signal.
| Single | Only renders the graph upon the first trigger signal from the start of sampling.
| Normal | Only re-renders the graph upon receipt of a trigger signal.

Trigger source | Select the variable (channel) that is the source of a trigger signal.
This property appears only when the [Use trigger function] property is set to [Yes].
---|---
Default | ch1
Modifying | Select from the drop-down list.
  Note that changes cannot be made during execution of a program.
Available values | Any one of the channels (ch1 to ch32)

Trigger level | Select the trigger level (i.e., the threshold value for determining as a trigger signal).
This property appears only when the [Use trigger function] property is set to [Yes].
---|---
Default | 0
Modifying | Select from the drop-down list.
  Note that changes cannot be made during execution of a program.
Available values | The value in decimal number/hexadecimal number within the following range.
  "The minimum value of the trigger variable (Trigger source)" to "The maximum value of the trigger variable (Trigger source)"
  Values in floating point notation can also be specified.
### Direction of trigger edge

Select the direction of the trigger edge. This property appears only when the [Use trigger function] property is set to [Yes].

<table>
<thead>
<tr>
<th>Default</th>
<th>Rising</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Select from the drop-down list. Note that changes cannot be made during execution of a program.</td>
</tr>
</tbody>
</table>
| Available values | Rising: Generates a trigger signal when the value of Trigger source changes from less than Trigger level to greater than or equal to Trigger level. Falling: Generates a trigger signal when the value of Trigger source changes from greater than Trigger level to less than or equal to Trigger level. Both: Generates a trigger signal when both “Rising” and “Falling”.

### Trigger position

Specify the trigger position (i.e. the horizontal position that indicates the location at which a trigger signal has been generated). This property appears only when the [Use trigger function] property is set to [Yes].

<table>
<thead>
<tr>
<th>Default</th>
<th>0s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Directly enter from the keyboard. Note that changes cannot be made during execution of a program.</td>
</tr>
</tbody>
</table>
| Available values | The value in decimal number within the following range:\nNote: - 0 to \( \text{(the value of the [Time per grid[Time/Div]] property)} \times 10 \)

### Trigger mark color

Specify the color of the trigger marks that indicate trigger level and the trigger position. This property appears only when the [Use trigger function] property is set to [Yes].

<table>
<thead>
<tr>
<th>Default</th>
<th>Color Orange</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Specify with the color selection combo box or directly enter from the keyboard. Note that changes cannot be made during execution of a program.</td>
</tr>
</tbody>
</table>
| Available values | When directly enter from the keyboard: The value in decimal number/hexadecimal number (prefix “0x” is needed) or the color name (see "About the specification of the color").

**Note**
If the unit (s, ms, us/µs, ns: case insensitive) is omitted, it will be handled as "ms".
If the specified value is greater than "the value of [Time per grid[Time/Div]] \times 10\), then "the value of [Time per grid[Time/Div]] \times 10\) is automatically specified to this property.

(3) [Smart Analog] [E1/E2 Lite/E20/COM Port[RL78]]
The information on the Smart Analog function is displayed and its configuration can be changed.

**Caution**
This category appears only when the selected microcontroller incorporates Smart Analog IC and the debug tool is set to the **Data collection mode**.

### Sampling interval[ms]

Specify the sampling interval in ms unit to collect the data by using Smart Analog function. Before the debug tool starts acquiring data in the **Data collection mode**, the value of the symbol \(r_dbg_graph.c#static_e1_waveout_rate\) is replaced with the value specified for this property.

<table>
<thead>
<tr>
<th>Default</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying</td>
<td>Directly enter from the keyboard. Note that changes cannot be made during execution of a program.</td>
</tr>
<tr>
<td>Available values</td>
<td>0 to 1000 in decimal number</td>
</tr>
</tbody>
</table>
The information on the graphing target that is registered in each channel is displayed and its configuration can be changed (see "(1)Register graphing targets").

For how to integrate the settings for channels into a pattern and switch the pattern from among multiple patterns, refer to Remarks 2. of this section.

**Caution**
If [Load from file] has been specified with the [Analysis method] property, then the values loaded from the file are reflected to the properties in this category and these values cannot be changed.

### Variable/Address 1 - 32
Specify the name of a variable or an address expression that is registered as a graphing target (see "(1)Register graphing targets").

Note that the values of all properties in this category will be changed to the default value if the value of this property is changed.

#### [E1/E2/E2 Lite/E20/COM Port[RL78]]
When the debug tool is in the Data collection mode, character strings specified in this property are only displayed as a label for the Variable name check box (they are not handled as a graphing target).

**Default** Blank

**Modifying**
Directly enter from the keyboard.
Note that changes cannot be made during execution of a program.

**Available values**
Up to 2046 characters

### Type/Size 1 - 32
Select the type and size of the variable/address to register.

#### [E1/E2/E2 Lite/E20/COM Port[RL78]]
This property does not appear when the debug tool is in the Data collection mode.

**Default** Auto

**Modifying**
Select from the drop-down list.
Note that changes cannot be made during execution of a program.

**Available values**
Any one of the following:
- Auto
- signed 1byte(8bits)
- signed 2bytes(16bits)
- signed 4bytes(32bits)
- unsigned 1byte(8bits)
- unsigned 2bytes(16bits)
- unsigned 4bytes(32bits)
### Notes 1.

The input format is as follows (same as the input format of the Watch panel).

- If the variable name of a structure, union, or array is registered, it cannot be graphed. For structures, unions, and arrays, the member name or element must be specified.

- Immediate addresses are registered with a size of 1 byte.

<table>
<thead>
<tr>
<th>Input Format</th>
<th>Value to be Acquired</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable name of C language</td>
<td>Value of C language variable</td>
</tr>
<tr>
<td>Variable-expression[Variable-expression]</td>
<td>Element of array</td>
</tr>
<tr>
<td>Variable-expression.Member name</td>
<td>Member of structures/unions</td>
</tr>
<tr>
<td>Variable-expression-&gt;Member name</td>
<td>Member of structures/unions that pointer designates</td>
</tr>
<tr>
<td>*Variable-expression</td>
<td>Value of pointer variable</td>
</tr>
</tbody>
</table>
Notes 2. A judgment is automatically made in order of address expression, register name, IOR/SFR name, variable name by the debug tool. If a address expression is determined, it will be handled as "signed 1byte(8bits)".

Notes 3. The relationship between channel numbers and colors is as follows:

<table>
<thead>
<tr>
<th>Number</th>
<th>Color</th>
<th>αRGB value in 32 bits</th>
<th>Number</th>
<th>Color</th>
<th>αRGB value in 32 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>0xC0FF0A4F</td>
<td>17</td>
<td>Light red</td>
<td>0xC0FF6666</td>
</tr>
<tr>
<td>2</td>
<td>Green</td>
<td>0xC05BE416</td>
<td>18</td>
<td>Light yellow</td>
<td>0xC0FFCC66</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>0xC0056DFF</td>
<td>19</td>
<td>Light green</td>
<td>0xC066CC66</td>
</tr>
<tr>
<td>4</td>
<td>Orange</td>
<td>0xC0FF541C</td>
<td>20</td>
<td>Light navy blue</td>
<td>0xC06666FF</td>
</tr>
<tr>
<td>5</td>
<td>Lightblue</td>
<td>0xC04FC1FF</td>
<td>21</td>
<td>Light violet</td>
<td>0xC0CC66FF</td>
</tr>
<tr>
<td>6</td>
<td>Purple</td>
<td>0xC0A932FF</td>
<td>22</td>
<td>Pure orange</td>
<td>0xC0FF9900</td>
</tr>
<tr>
<td>7</td>
<td>Yellow</td>
<td>0xC0FFD91C</td>
<td>23</td>
<td>Pure green</td>
<td>0xC000AA00</td>
</tr>
<tr>
<td>8</td>
<td>Redviolet</td>
<td>0xC0FF30A5</td>
<td>24</td>
<td>Pure blue</td>
<td>0xC00000FF</td>
</tr>
<tr>
<td>9</td>
<td>Yellow-green</td>
<td>0xC0BEE02F</td>
<td>25</td>
<td>Pure magenta</td>
<td>0xC0CC00FF</td>
</tr>
<tr>
<td>10</td>
<td>Blueviolet</td>
<td>0xC05510FF</td>
<td>26</td>
<td>Deep red</td>
<td>0xC0FF0000</td>
</tr>
<tr>
<td>11</td>
<td>Pink</td>
<td>0xC0FF97E4</td>
<td>27</td>
<td>Deep green</td>
<td>0xC0006600</td>
</tr>
<tr>
<td>12</td>
<td>Brown</td>
<td>0xC0913A37</td>
<td>28</td>
<td>Deep blue</td>
<td>0xC022222CC</td>
</tr>
<tr>
<td>13</td>
<td>Ocher</td>
<td>0xC0C68E15</td>
<td>29</td>
<td>Deep purple</td>
<td>0xC099000CC</td>
</tr>
<tr>
<td>14</td>
<td>Darkgreen</td>
<td>0xC0317F0C</td>
<td>30</td>
<td>Dark red</td>
<td>0xC0990000</td>
</tr>
<tr>
<td>15</td>
<td>Darkbrown</td>
<td>0xC060493E</td>
<td>31</td>
<td>Very dark green</td>
<td>0xC0004400</td>
</tr>
<tr>
<td>16</td>
<td>Grey</td>
<td>0xC072808E</td>
<td>32</td>
<td>Dark purple</td>
<td>0xC0663399</td>
</tr>
</tbody>
</table>

Remarks 1. About the specification of the color
You can specify one of the following.
Note, however, that if you specify the alpha value indicating transparency, then it is assumed that "255(0xff)" (opaque) was specified.
- 32-bit value (assigning each 8-bit segment, from high to low, to the αRGB values)
  Example: 0xC0FF0A4F
- 24-bit value (assigning each 8-bit segment, from high to low, to the RGB values)
  Example: 0xFF0A4F
- Four eight-bit values, delimited by commas (assigning values from left to right to αRGB)
  Example: 192, 255, 10, 79
Remarks 2. How to integrate the settings for channels into a pattern and switch the pattern from among multiple patterns
You can integrate, save, and restore the settings for all channels. You can also select a pattern from among multiple patterns.
1. Make the settings for each channel. Shift the focus to the Analysis Chart panel, select [Save Analysis Chart Data As...] from the [File] menu, and save the settings in the [Analysis Chart Data (*.mtac)] file format. In this case, the file name will include a pattern name such as analysis_graph_xx_pattern.mtac. Not including graph data in the file will reduce its size.
2. Set another pattern for a different channel and save the file with another name. Repeat this step as many times as the number of patterns.
Creating files enables the management of deleting and copying patterns from the Explorer.
3. To use a saved pattern, select [Load from file] for the [Analysis method] property on the [Variable Value Changing] tabbed page of the Property panel and specify the *.mtac file containing the pattern for the [Analysis chart data file] property. Restore the [Analysis method] property to its original setting.

- Three eight-bit values, delimited by commas (assigning values from left to right to RGB)
  Example: 255, 10, 79
- Using general English color words (case insensitive)
  Example: Blue
This panel is used to display the acquired function information. The following types of function are displayed in this panel.

- Global function
- Static function
- Member function (only when C++ source files are subject to analysis)

Note, however, that the function information in the files not to be analyzed is not displayed in this panel (see "1.1.1What is analyzed"). See "2.1Overview" for details on how to display the function information.

Cautions 1. [E20[RX]]
In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of the Dynamic analysis information by trace data will increase because complement of instructions between branch instructions is performed (the processing time is proportional to the set value of the [Trace memory size][MByte]] property in the same category above).

Cautions 2. [CC-RX]
When C++ source files are subject to analysis, also see "3.6When CC-RX (C++ Source Files) Is Used".

Cautions 3. [CC-RX]
Unused static functions deleted via compiler optimization cannot be displayed in the panel.

Remarks 1. You can set filters for displaying function information on this panel (see "2.6.5Filter the analysis information").

Remarks 2. This panel can be zoomed in and out by in the tool bar, or by moving the mouse wheel forward or backward while holding down the [Ctrl] key.

Remarks 3. [RH850]
See "(a)Trace function" and "(c)Coverage function [IECUBE][E20[RX]][Simulator]" for details on the relationship between the Dynamic analysis information in this panel and PEN currently being selected in the Debug Manager panel.

Figure A.4 Function List Panel

The following items are explained here.

- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (Function List panel-dedicated items)]
- [Edit] menu (Function List panel-dedicated items)]
- [Context menu]

[How to open]
- On the toolbar in the Main window, click the button.
- From the [View] menu, select [Program Analyzer] >> [Function List].

[Description of each area]

(1) Header area

(a) Column name
The name of the item of the acquired function information is displayed.
Marks (icons) that are displayed at the name of the item indicate as follows:

<table>
<thead>
<tr>
<th>Mark (Icon)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>△ / ▽</td>
<td>Indicates whether there is a sort order setting (see &quot;2.6.4Sort the analysis information&quot;).</td>
</tr>
<tr>
<td>▼ / ▲</td>
<td>Indicates whether there is a filter display setting (see &quot;2.6.5Filter the analysis information&quot;).</td>
</tr>
<tr>
<td>◀ / ◀</td>
<td>Indicates whether display is locked (see &quot;2.6.3Lock the specific column to display&quot;).</td>
</tr>
</tbody>
</table>

Remark
Columns to display can be customized via mouse operations in this area.
- Set the columns to display
- Change the order of the columns to display
- Lock the specific column to display

(b) Button
Opens the Column Chooser dialog box in order to sort and show/hide the items (columns) displayed in the panel, and return customized settings to the defaults (see "2.6Customize Display Method").

(2) Information area
This area displays the acquired function information.
The analysis tool acquires two types of function information: Static analysis information and Dynamic analysis information. The timing when each type of information can be displays differs (see "1.1.2Types of analysis information").
When the active project is changed while displaying the function information, the function information of the target project is displayed. Note, however, that if the cross reference information has not been generated in the project or the analysis tool is not supported by the project, nothing is displayed on this panel.
The value of the information that has been changed because of the execution of a program is shown highlighted (the color depends on the configuration in the [General - Font and Color] category of the Option dialog box). To reset the highlighting, click the button on the toolbar.
The items and details acquired as function information are as follows:
### Item Type Contents

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Function Name | Static analysis | Displays the name of the global function, the file-internal static function or the member function (function that is defined with class type) that is defined/referenced in the C/C++ source file. Up to 1024 characters can be displayed. The meanings of an icon displayed is as follows:  
- : Function  
- : Member function [CC-RX]  
- : Template function [CC-RX]  
If the function is a const member function/volatile member function, then "const"/"volatile" is displayed immediately after the function name. |
| Class Name    | Static analysis | Displays the name of the class to which the function belongs. If it is a template class, then the number of template arguments are also displayed in the format of "class name<T: the number of template arguments>". Note, however, that if the function is not a member function, or if analysis was not completed, then this will be blank. |
| Namespace     | Static analysis | Displays the name of the namespace to which the function belongs. If the namespace is nested, then it is displayed in the format of "namespace name::namespace name". If it is an anonymous namespace, then "<unnamed>" is displayed. Note, however, that if analysis was not completed, then this will be blank. |
| File Name     | Static analysis | Displays the file name (without path) of the C/C++ source file where the function is defined. Note, however, that if it is not defined in a C/C++ source file in project, or if analysis was not completed, then this will display "(No Definition)". If it is defined in a header file, then the name of the header file is displayed. |
| File Pass     | Static analysis | Displays the absolute path of the C/C++ source file where the function is defined. Note, however, that if it is not defined in a C/C++ source file in project, or if analysis was not completed, then this will be blank. If it is defined in a header file, then the absolute path of the header file is displayed. |
| PM Information | Static analysis | Displays the following information about PE in which the function is executed.  
- In PE: $P Mn$  
- In common PE: $Common$  
- Unknown: -  
Note that this item appears only when the selected microcontroller version supports multi-core. |
<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Import\(^1\)             | Static analysis | Displays the following information about the source of the function information.  
- If it was acquired from inside an active project, "Original" is displayed.  
- If it was acquired from an import file, the names of all import files are displayed.  
- If it was acquired from inside an active project and an import file, "Original" and the names of all import files are displayed.  
See "2.12 Import or Export Information File" for details on the import function. |
| Access Specifier [CC-RX] | Static analysis | Displays the access specifier being declared to the member function. Note, however, that this will display ".-" if analysis is not complete.  
The following access specifiers can be displayed.  
public, private, protected |
| Attribute                | Static analysis | Displays the function's symbol attributes/symbol-modifier attributes. If there are multiple attributes, then they are displayed separated by commas ("."),  
Note, however, that this will display ".-" if analysis is not complete.  
The following attributes can be displayed.  
- [CC-RH] static, interrupt, inline  
- [CC-RX] static, interrupt, inline, template, virtual, abstract  
- [CC-RL] static, interrupt, inline, near, far, callt, rtos task |
| Return Type              | Static analysis | Displays the return type of the function\(^2\). Note, however, that this will display ".-" if analysis is not complete.  
There is no limit to display the number of pointers. |
| Arguments Count \(^1\)   | Static analysis | Displays the number of arguments of the function in decimal number notation. If the function has a variable argument parameter, then the number of arguments defined at the location where the function is defined is displayed.  
Note, however, that this will display ".-" if analysis is not complete. |
| Arguments                | Static analysis | Displays the argument type and formal argument name of the function\(^2\). If there are multiple arguments, then they are displayed separated by commas ("."),  
If the function has a variable argument parameter, then the argument type and argument name defined at the location where the function is defined are displayed.  
If there are no arguments, then "void" is displayed.  
Note, however, that this will display ".-" if analysis is not complete.  
There is no limit to display the number of pointers (the first dimension of an array is handled as a pointer). |
| Code Size[Bytes]         | Static analysis | Displays the function's code size in decimal number notation. Note, however, that this will display ".-" if analysis is not complete. |
| Start Address            | Static analysis | Displays the function's start address in hexadecimal number notation. The number of digits to display is equivalent to the maximum address value of the selected microcontroller.  
Note, however, that this will display ".-" if analysis is not complete. |
<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Address(^{Note\ 1})</td>
<td>Static analysis</td>
<td>Displays the end address of the function aligned in ROM in hexadecimal notation. The number of digits to display is equivalent to the maximum address value of the selected microcontroller. Note, however, that this will display &quot;.-&quot; if analysis is not complete.</td>
</tr>
<tr>
<td>Reference Count</td>
<td>Static analysis</td>
<td>Displays the number of times the function is referenced in the program, in decimal number notation. Prototype declarations are also counted as references. Code in C/C++ source files that is referenced but is eliminated by the preprocessor during compilation (e.g. via &quot;#if&quot; or &quot;#ifdef&quot; statements) is not included in the number of references (it is also not output by the search results from [Find All References] in the context menu). References to functions via assignment to function pointers are not included in the reference count. Note, however, that this will display &quot;.-&quot; if analysis is not complete.</td>
</tr>
<tr>
<td>Execution Count</td>
<td>Dynamic analysis</td>
<td>Displays the number of times the function was executed (called) as a result of program execution, in decimal number notation(^{Note\ 3}). This function counts the number of times that the instruction located at the address allocated to the function label is executed. For this reason, an invalid value may be displayed if the measurement starts midway through the execution of a function. Note, however, that this will display &quot;.-&quot; if the debug tool's Trace function is disabled, or analysis is not complete.</td>
</tr>
<tr>
<td>Execution Time([unit])</td>
<td>Dynamic analysis</td>
<td>Displays the execution time of the function (the time executing the code in the function body, not including subroutines)(^{Note\ 3, 4}). The unit of time can be changed by selecting [Unit of Time] from the [Toolbar], or from the Property panel's [Settings] tab, in the [General] category, changing the [Unit of time] property (see the [Unit of time] property in the Property panel for details on the time-display format). Note, however, that this will display &quot;.-&quot; if the debug tool's Trace function is disabled, or analysis is not complete.</td>
</tr>
<tr>
<td>Execution Time(Percentage)([%])</td>
<td>Dynamic analysis</td>
<td>Displays the proportion of total execution time (range that could be obtained as trace data) taken by the execution time of the target function, rounded to the nearest two decimal places, in the range 0.00 to 100.00(^{Note\ 3, 4}). The level of shading of the cell's background color indicates the proportion. Note, however, that this will display &quot;.-&quot; if the debug tool's Trace function is disabled, or analysis is not complete.</td>
</tr>
</tbody>
</table>
Execution Time(Average)[unit] [Full-spec emulator] [IECUBE|RL78]| [E1/E20/E2|RH850]| [Simulator]

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Time(Average) [unit]</td>
<td>Dynamic analysis</td>
<td>Displays the average execution time of the function (&quot;execution time&quot; / &quot;number of executions&quot;) Note 3, 4 The results of calculation are displayed rounded to the nearest nanosecond. The unit of time can be changed by selecting [Unit of Time] from the [Toolbar], or from the Property panel's [Settings] tab, in the [General] category, changing the [Unit of time] property. The unit of time can be changed by selecting [Unit of Time] from the [Toolbar], or from the Property panel's [Settings] tab, in the [General] category, changing the [Unit of time] property (see the [Unit of time] property in the Property panel for details on the time-display format). Note, however, that this will display &quot;.&quot; if the debug tool's Trace function is disabled, or analysis is not complete.</td>
</tr>
<tr>
<td>Code Coverage[%]</td>
<td>Dynamic analysis</td>
<td>Displays the code coverage rates of the function (C0: &quot;number of bytes of code executed in the address range&quot; / &quot;function's code size&quot; x 100) (see &quot;3.2 Coverage Results&quot;). The level of shading of the cell's background color indicates the code coverage. Note, however, that this will display &quot;.&quot; if the debug tool's Coverage function [IECUBE</td>
</tr>
</tbody>
</table>

Notes 1. This item does not appear by default. See "2.6.1 Set the columns to display" for details on how to display this item.

Notes 2. If including an alternative name by using "#define" or "typedef", then not the alternative name but the original type is displayed.

Notes 3. Set the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel to [Yes] to display the cumulative value for each program execution.

Notes 4. The execution time does not include the execution time of the runtime libraries provided by the compiler. If the current setting of the debug tool does not allow clearing of the trace memory before tracing starts, the execution time value will be incorrect.

Notes 5. [E20|RX] This item appears only when the selected microcontroller supports the coverage function and also CS+ is connected to the debug tool.

In the bottom of the [Function Name] item, the following information for each file is shown as ["Total"]. Note that "(No Definition)" displayed in the [File Name] item is treated as one file.

Figure A.5 ["Total"] Display (Function List Panel)
**Cautions 1.** Items of the **Dynamic analysis information** do not appear while disconnecting from the debug tool (default).

**Cautions 2.** [IECUBE[RL78]]

"0" is output as the first trace-data time tag during program execution. For this reason, if the user repeatedly starts and stops execution, or performs step execution, the [Execution Time[unit]] / [Execution Time(Percentage)[%]] / [Execution Time(Average)[unit]] items will be invalid.

**Cautions 3.** Values of the following items for the system library functions cannot be acquired.

- [Return Type]/[Arguments Count]/[Arguments]/[Code Size[Bytes]]/[End Address]/[Execution Time[unit]]/[Execution Time(Percentage)[%]]/[Execution Time(Average)[unit]]/[Code Coverage[%]]

**Remarks 1.** If you define a static function in a header file, and include it from more than one source file, information for the header file and all source files is displayed on one line.

**Remarks 2.** [CC-RX]
The display contents of the line for the definition of a template function and the line for the function using a template function are as follows:

```c
// // Function using the template function
//
int template_use(void)
{
    short result = 0;
    short s = 100;
    char c = 200;

    result += template_func(s, c);
    return result;
}

// // Definition of the template function
//
template <typename T1, typename T2> T1 template_func(T1 t1, T2 t2)
{
    T1 result = 10;
    result += t1 + t2;
    return result;
}
```

**Examples 1.** Display contents for the line for the definition of the template function
- [Return Type]: -
- [Arguments]: -
- [Function Name]: Template_func<T:2>

**Examples 2.** Display contents for the line for the function using the template function
- [Return Type]: short
- [Arguments]: short t1, char t2
- [Function Name]: Template_func<T:2>
Remarks 3. The display of each type of information can be customized as follows:
- Sort the analysis information
- Filter the analysis information

Remarks 4. The current row mark ( ) on the left edge of this area indicates that the column in question is the current row.
The following operations can be performed on the current row:
- Jump to Defined Location
- Set Break Events
- Display List of Referencing Location

[Toolbar]
The toolbar provides the following items and functions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Acquires the latest data from the debug tool, and updates the contents of this panel.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays the latest information automatically by acquiring the information each time program execution stops. Note that this item is disabled when the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Specify Individually] (this button is locked in accordance with the setting on the Property panel).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Resets highlighting of values that have been changed by executing a program. Note that this item is disabled during execution of a program.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays only the information for functions in a file(s)/category(s) currently selected in the Project Tree panel (see &quot;(a)Linking with the Project Tree panel&quot;).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays only the information for functions starting with the word at the caret position in the Editor panel (see &quot;(b)Linking with the Editor panel&quot;).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays only the information for functions in the common region and PE currently selected in the Debug Manager panel (see &quot;(c)Linking with the Debug Manager panel [RH850]&quot;). Note that this item is disabled when the selected microcontroller version does not support multi-core. or while disconnecting from the debug tool.</td>
</tr>
</tbody>
</table>

Unit of Time
- H:M:S Displays the time as "hours, minutes (0 - 59), seconds (0 - 59)".
- Second Displays the time in second units. The value is rounded to three decimal places.
- Millisecond Displays the time in millisecond units. The value is rounded to three decimal places.
- Microsecond Displays the time in microsecond units. The value is rounded to three decimal places.
- Nanosecond Displays the time in nanosecond units. The value is rounded to integer number.
- Clock Displays the time in clock units. The value is rounded to integer number. Note that this item is displayed only when the selected microcontroller supports a time display in units of clock cycles.

[[File] menu (Function List panel-dedicated items)]
The [File] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Function List Data</td>
<td>Overwrites the contents of this panel to the previously saved file (see &quot;2.14Save Analysis Information&quot;). Note that when the file has never been saved or the file is write disabled, the same operation is applied as the selection in [Save Function List Data As...].</td>
</tr>
</tbody>
</table>
Save Function List Data As... Opens the Save As dialog box to newly save the contents of this panel to the specified text file (see "2.14 Save Analysis Information").

Print... Opens the Windows dialog box to print the contents currently being displayed in this panel.

### [Edit] menu (Function List panel-dedicated items)

The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected column (multiple selections possible) to the clipboard as character strings separated by tabs. Note that the contents of the clipboard cannot be pasted to this panel.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the columns being displayed in this panel.</td>
</tr>
</tbody>
</table>

### [Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find All References</td>
<td>Displays a list of the locations referencing the function(s) of the selected row(s), in the Output panel's [Find References] tab (see &quot;2.11 Display List of Referencing Location&quot;).</td>
</tr>
<tr>
<td>Set Break to Function</td>
<td>Sets a breakpoint at the first line of the function at the current row (the first executable line in the target function) (see &quot;2.9.1 Set a breakpoint to a function&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Source</td>
<td>Opens the Editor panel and displays the source file in which the function of the current row is defined (see &quot;2.7 Jump to Defined Location&quot;).</td>
</tr>
<tr>
<td>Jump to Disassemble</td>
<td>Opens the Disassemble panel (Disassemble1) and displays the disassemble data corresponding to the start address of the function of the current row (see &quot;2.7 Jump to Defined Location&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Memory</td>
<td>Opens the Memory panel (Memory1) and displays the memory list corresponding to the start address of the function of the current row (see &quot;2.7 Jump to Defined Location&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected row(s) to the clipboard as character strings separated by tabs. Note that the contents of the clipboard cannot be pasted to this panel.</td>
</tr>
</tbody>
</table>
This panel is used to display the acquired variable information. The following types of variable are displayed in this panel:

- Global variable
- Static variable inside a file
- Static variable inside a function
- Class variable (only when C++ source files are subject to analysis)

Note, however, that the variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed"). See "2.1 Overview" for details on how to display the variable information.

**Cautions 1. [E20]RX]**
In the debug tool's Property panel, when the [Trace data type] property in the [Trace] category on the [Debug Tool Settings] tab is set to [Branch], the acquisition time of the Dynamic analysis information by trace data will increase because complement of instructions between branch instructions is performed. If you focus only on variables, we recommend selecting [Data access] in this property.

**Cautions 2. [CC-RX]**
When C++ source files are subject to analysis, also see "3.6 When CC-RX (C++ Source Files) Is Used".

**Cautions 3. [CC-RX]**
Unused variables deleted via compiler optimization are not displayed.

**Remarks 1.** You can set filters for displaying variable information on this panel (see "2.6.5 Filter the analysis information").

**Remarks 2.** This panel can be zoomed in and out by [ ] in the tool bar, or by moving the mouse wheel forward or backward while holding down the [Ctrl] key.

**Remarks 3. [RH850]**
See "(a) Trace function" for details on the relationship between the Dynamic analysis information in this panel and PEn currently being selected in the Debug Manager panel.

Figure A.6 Variable List Panel

The following items are explained here:

- [How to open]
- [Description of each area]
- [Toolbar]
- [File] menu (Variable List panel-dedicated items)
- [Edit] menu (Variable List panel-dedicated items)
- [Context menu]
[How to open]
- On the toolbar in the Main window, click the button.
- From the [View] menu, select [Program Analyzer] >> [Variable List].

[Description of each area]

(1) Header area
(a) Column name
The name of the item of the acquired variable information is displayed.
Marks (icons) that are displayed at the name of the item indicate as follows:

<table>
<thead>
<tr>
<th>Mark (Icon)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ /</td>
<td>Indicates whether there is a sort order setting (see &quot;2.6.4Sort the analysis information&quot;).</td>
</tr>
<tr>
<td>/ /</td>
<td>Indicates whether there is a filter display setting (see &quot;2.6.5Filter the analysis information&quot;).</td>
</tr>
<tr>
<td>/ /</td>
<td>Indicates whether display is locked (see &quot;2.6.3Lock the specific column to display&quot;).</td>
</tr>
<tr>
<td>/</td>
<td>Indicates that a message relating to information about this item has been output to the Output panel. Hover the mouse over it to display a pop-up with the last message to be output.</td>
</tr>
</tbody>
</table>

Remark: Columns to display can be customized via mouse operations in this area.
- Set the columns to display
- Change the order of the columns to display
- Lock the specific column to display

(b) Button
Opens the Column Chooser dialog box in order to sort and show/hide the items (columns) displayed in the panel, and return customized settings to the defaults (see "2.6Customize Display Method").

(2) Information area
This area displays the acquired variable information.
The analysis tool acquires two types of function information: Static analysis information and Dynamic analysis information. The timing when each type of information can be displayed differs (see "1.1.2Types of analysis information").
When the active project is changed while displaying the variable information, the variable information of the target project is displayed. Note, however, that if the cross reference information has not been generated in the project or the analysis tool is not supported by the project, nothing is displayed on this panel.
The value of the information that has been changed because of the execution of a program is shown highlighted (the color depends on the configuration in the [General - Font and Color] category of the Option dialog box). To reset the highlighting, click the button on the toolbar.
The items and details acquired as variable information are as follows:
<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Variable Name | Static analysis | Displays the name of the global variable, the static variable inside a file, the static variable inside a function or the class variable (static member variable of a class type) that is defined/referenced in the C/C++ source file. Up to 1024 characters can be displayed. The meanings of icons displayed are as follows:  
- : Variable  
- : Member variable [CC-RX]  
[CC-RX]  
If an anonymous union is used, then this will display "<unnamed_N>" as the variable name (N: A number from 1 automatically provided in appearance order). |
| Class Name [CC-RX] | Static analysis | Displays the name of the class to which the variable belongs. If it is a template class, then the number of template arguments are also displayed in the format of "class name<T: the number of template arguments>". Note, however, that if the variable is not a member variable, or if analysis was not completed, then this will be blank. |
| Namespace [CC-RX] | Static analysis | Displays the name of the namespace to which the variable belongs. If the namespace is nested, then it is displayed in the format of "namespace name::namespace name". If it is an anonymous namespace, then "<unnamed>" is displayed. Note, however, that if analysis was not completed, then this will be blank. |
| File Name | Static analysis | Displays the file name (without path) of the C/C++ source file where the variable is definedNote 1. Note, however, that if it is not defined in a C/C++ source file in project, or if analysis was not completed, then this will display "(No Definition)". If it is defined in a header file, then the name of the header file is displayed. |
| Function NameNote 1 | Static analysis | Displays the name of the function where the variable is defined. Note, however, this will be blank for other than a static variable inside a function.  
[CC-RX]  
In addition to the above, the argument types of the function are also displayed in parentheses "()". If the function is a const member function/volatile member function, then "const"/"volatile" is displayed immediately after the function name. |
| File PathNote 1 | Static analysis | Displays the absolute path of the C/C++ source file where the variable is defined. Note, however, that if it is not defined in a C/C++ source file in project, or if analysis was not completed, then this will be blank. If it is defined in a header file, then the absolute path of the header file is displayed. |
| PM Information [RH850] | Static analysis | Displays the following information about PE from which the variable can be accessed.  
- From PEn: PMn  
- From common PE: Common  
- Unknown: -  
Note that this item appears only when the selected microcontroller version supports multi-core. |
### Static analysis

**Import**

Displays the following information about the source of the variable information.
- If it was acquired from inside an active project
  "Original" is displayed.
- If it was acquired from an import file
  The names of all import files are displayed.
- If it was acquired from inside an active project and an import file
  "Original" and the names of all import files are displayed.

See "2.12 Import or Export Information File" for details on the import function.

**Access Specifier**

- [CC-RX]

Displays the access specifier being declared to the member variable. Note, however, that this will display "-" if analysis is not complete.

The following access specifiers can be displayed:
- public, private, protected

**Attribute**

Displays the variable’s symbol attributes/symbol-modifier attributes. If there are multiple attributes, then they are displayed separated by commas (",").

Note, however, that this will display "-" if analysis is not complete.

The following attributes can be displayed:
- [CC-RH]
  - static, ior, const, volatile
- [CC-RX]
  - static, const, volatile, restrict
- [CC-RL]
  - static, const, volatile, near, far, saddr

**Type**

Displays the type of the variable.

If including an alternative name by using "#define statement" or "typedef statement", then not the alternative name but the type is displayed.

Note, however, that this will display "-" if analysis is not complete.

There is no limit to display the number of pointers (up to 4 dimensions for an array can be displayed).

**Members**

Displays the members of the structure/union. If there are multiple members, then they are displayed separated by commas (",").

Note, however, that this will display "-" if other than structures/unions or analysis is not complete.

**Address**

Displays the variable's allocated address in hexadecimal number notation.

The number of digits to display is equivalent to the maximum address value of the selected microcontroller.

Note, however, that this will display "-" if analysis is not complete.

**Size [Bytes]**

Displays the variable’s size in decimal number notation.

Note, however, that this will display "-" for bit variables or the like that cannot be displayed in bytes, or if analysis is not complete.

Variables that are defined only and not referenced will be eliminated by compiler optimization. For this reason, this will display "0" for such variables.
### Reference Count

**Static analysis**
- Displays the number of times the variable is referenced in the program, in decimal number notation.
- The location where the variable is defined is also counted. The totals for structures, unions, and arrays are displayed at the variable level (references to individual members and array elements are not shown).
- In the definition of variables, a line with an assignment statement (e.g. "int variable = 10") is counted.
- "variable++;" is interpreted as "variable = variable + 1". Therefore, this variable is counted twice.
- Code in C/C++ source files that is referenced but is eliminated by the preprocessor during compilation (e.g. via "#if" or "#ifdef" statements) is not included in the number of references (it is also not output by the search results from [Find All References] in the context menu).
- Note, however, that this will display "-" if analysis is not complete.

### Read Count

**[Full-spec emulator]**
- **IECUBE**
- **E1/E2/E20/RH850**
- **E1/E2/E2 Lite/E20/RX**
- **Simulator**

**Dynamic analysis**
- Displays the number of times the variable was read, in decimal number notation
- For structures and unions, reads are counted at the structure/union variable level (the number of reads at the individual member and element levels are not shown).
- Note, however, that this will display "-" if the debug tool's Trace function is disabled, or if analysis is not complete.

### Write Count

**[Full-spec emulator]**
- **IECUBE**
- **E1/E2/E20/RH850**
- **E1/E2/E2 Lite/E20/RX**
- **Simulator**

**Dynamic analysis**
- Displays the number of times the variable was written, in decimal number notation
- For structures and unions, writes are counted at the structure/union variable level (the number of writes at the individual member and element levels are not shown).
- Note, however, that this will display "-" if the debug tool's Trace function is disabled, or if analysis is not complete.

### Read/Write Count

**[Full-spec emulator]**
- **IECUBE**
- **E1/E2/E20/RH850**
- **E1/E2/E2 Lite/E20/RX**
- **Simulator**

**Dynamic analysis**
- Displays the number of times the variable was read/written, in decimal number notation
- For structures and unions, reads/writes are counted at the structure/union variable level (the number of reads/writes at the individual member and element levels are not shown).
- It may not be possible to analyze reads/writes of variables in segments where variables have been assigned to registers via compiler optimization. For this reason, reads/writes in such sections will not be counted.
- Note, however, that this will display "-" if the debug tool's Trace function is disabled, or if analysis is not complete.

### Minimum Value

**[Full-spec emulator]**
- **IECUBE**
- **E1/E2/E20/RH850**
- **E1/E2/E2 Lite/E20/RX**
- **Simulator**

**Dynamic analysis**
- Displays the minimum measurement time from the results of program execution, in decimal number notation
- Only a variable less than or equal to 4 bytes can be displayed.
- Note, however, that this will display "-" if for bit type variables/boolean type variables/Bool type variables/structures/unions/arrays/pointer, if the debug tool's Trace function is disabled, or if analysis is not complete.

### Maximum Value

**[Full-spec emulator]**
- **IECUBE**
- **E1/E2/E20/RH850**
- **E1/E2/E2 Lite/E20/RX**
- **Simulator**

**Dynamic analysis**
- Displays the maximum measurement time from the results of program execution, in decimal number notation
- Only a variable less than or equal to 4 bytes can be displayed.
- Note, however, that this will display "-" if for bit type variables/boolean type variables/Bool type variables/structures/unions/arrays/pointer, if the debug tool's Trace function is disabled, or if analysis is not complete.
Notes 1. This item does not appear by default. See "2.6.1 Set the columns to display" for details on how to display this item.

Notes 2. If including an alternative name by using "#define" or "typedef", then not the alternative name but the original type is displayed.

Notes 3. Set the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel to [Yes] to display the cumulative value for each program execution.

Notes 4. The calculation is based on the acquired trace data. So for example, if one write to a 4-byte area was output in the trace data as the upper 2 bytes and the lower 2 bytes, then two times will be displayed.

In the bottom of the [Variable Name] item, the following information for each file is shown as ["Total"]. Note that "(No Definition)" displayed in the [File Name] item is treated as one file.

Figure A.7  ["Total"] Display (Variable List Panel)

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Coverage[%]</td>
<td>Dynamic analysis</td>
<td>Displays the data coverage rates of the variable (&quot;number of bytes accessed in the address range&quot; / &quot;variable size&quot; x 100) (see &quot;3.2 Coverage Results&quot;). The level of shading of the cell's background color indicates the data coverage. Note, however, that this will display &quot;+&quot; if the debug tool's Coverage function [IECUBE][E20[RX]][Simulator] is disabled, or if analysis is not complete.</td>
</tr>
</tbody>
</table>

Notes 1. This item does not appear by default. See "2.6.1 Set the columns to display" for details on how to display this item.

Notes 2. If including an alternative name by using "#define" or "typedef", then not the alternative name but the original type is displayed.

Notes 3. Set the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel to [Yes] to display the cumulative value for each program execution.

Notes 4. The calculation is based on the acquired trace data. So for example, if one write to a 4-byte area was output in the trace data as the upper 2 bytes and the lower 2 bytes, then two times will be displayed.

In the bottom of the [Variable Name] item, the following information for each file is shown as ["Total"]. Note that "(No Definition)" displayed in the [File Name] item is treated as one file.

Figure A.7  ["Total"] Display (Variable List Panel)

<table>
<thead>
<tr>
<th>Item</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>The target file name</td>
</tr>
<tr>
<td>File Pass&lt;sup&gt;Note&lt;/sup&gt;</td>
<td>File pass of the target file</td>
</tr>
<tr>
<td>Size[Bytes]</td>
<td>Total of the variable's size in the target file</td>
</tr>
<tr>
<td>Reference Count</td>
<td>Total number of times variables are referenced in the target file</td>
</tr>
<tr>
<td>Read Count</td>
<td>Total number of times variables were read in the target file</td>
</tr>
<tr>
<td>Write Count</td>
<td>Total number of times variables were written in the target file</td>
</tr>
<tr>
<td>Read/Write Count</td>
<td>Total number of times variables were read/written in the target file</td>
</tr>
<tr>
<td>Data Coverage[%]</td>
<td>The data coverage rates of variables in the target file</td>
</tr>
</tbody>
</table>

Note 1. This item does not appear by default. See "2.6.1 Set the columns to display" for details on how to display this item.

Cautions 1. Items of the Dynamic analysis information do not appear while disconnecting from the debug tool (default).

Cautions 2. The [Read Count]/[Write Count]/[Read/Write Count]/[Data Coverage[%]] item for a bit type variable/boolean type variable/ _Bool type variable/bit field structure is measured by counting the number of accesses to the address that the variable is being allocated. Consequently, if bit type variables/boolean type variables/_Bool type variables/bit field structures are allocated to the same address, these items above will display the same value.

Remarks 1. If static variables inside a function with the same name are declared in a function, they are handled as follows:
- [Members]/[Address]/[Size(Bytes)]/[Read Count]/[Write Count]/[Read/Write Count]/[Minimum Value]/[Maximum Value]/[Data Coverage[%]]
  The information of the variable that is first declared in a function is displayed.
- Items other than listed above
  The information of the variable that is first declared in a function is displayed.

Remarks 2. If you define a static variable in a header file, and include it from more than one source file, information for the header file and all source files is displayed on one line.

Remarks 3. The display of each type of information can be customized as follows:
- Sort the analysis information
- Filter the analysis information

Remarks 4. The current row mark ( ) on the left edge of this area indicates that the column in question is the current row.
The following operations can be performed on the current row:
- Jump to Defined Location
- Register Watch-Expressions
- Display List of Referencing Location
- Graph transitions in values

[Toolbar]
The toolbar provides the following items and functions.

| ![ ] | Acquires the latest data from the debug tool, and updates the contents of this panel. |
| ![ ] | Displays the latest information automatically by acquiring the information each time program execution stops. Note that this item is disabled when the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Specify Individually] (this button is locked in accordance with the setting on the Property panel). |
| ![ ] | Resets highlighting of values that have been changed by executing a program. Note that this item is disabled during execution of a program. |
| ![ ] | Displays only the information for variables in a file(s)/category(s) currently selected in the Project Tree panel (see "(a) Linking with the Project Tree panel"). |
| ![ ] | Displays only the information for variables starting with the word at the caret position in the Editor panel (see "(b) Linking with the Editor panel"). |
| [RH850] | Displays only the information for variables in the common region and PE currently selected in the Debug Manager panel (see "(c) Linking with the Debug Manager panel [RH850]"). Note that this item is disabled when the selected microcontroller version does not support multi-core or while disconnecting from the debug tool. |

[[File] menu (Variable List panel-dedicated items)]
The [File] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Variable List Data</td>
<td>Overwrites the contents of this panel to the previously saved file (see &quot;2.14 Save Analysis Information&quot;). Note that when the file has never been saved or the file is write disabled, the same operation is applied as the selection in [Save Variable List Data As...].</td>
</tr>
<tr>
<td>Save Variable List Data As...</td>
<td>Opens the Save As dialog box to newly save the contents of this panel to the specified text file (see &quot;2.14 Save Analysis Information&quot;).</td>
</tr>
<tr>
<td>Print...</td>
<td>Opens the Windows dialog box to print the contents currently being displayed in this panel.</td>
</tr>
</tbody>
</table>
[[Edit] menu (Variable List panel-dedicated items)]

The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected column (multiple selections possible) to the clipboard as character strings separated by tabs. Note that the contents of the clipboard cannot be pasted to this panel.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the columns being displayed in this panel.</td>
</tr>
</tbody>
</table>

[Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find All References</td>
<td>Displays a list of the locations referencing the variable(s) of the selected row(s), in the Output panel's [Find References] tab (see &quot;2.11 Display List of Referencing Location&quot;).</td>
</tr>
<tr>
<td>Register to Analysis Chart</td>
<td>Registers the variable(s) of the selected row(s) to the Analysis Chart panel (see &quot;2.13.1 Graph transitions in values&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Access Break</td>
<td>The following cascade menus are displayed to set a break event with access condition (see &quot;2.9.2 Set a break event to a variable&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Set Variable Read Break to</td>
<td>Sets a break event with read access condition to the variable of the current row.</td>
</tr>
<tr>
<td>Set Variable Write Break to</td>
<td>Sets a break event with write access condition to the variable of the current row.</td>
</tr>
<tr>
<td>Set Variable R/W Break to</td>
<td>Sets a break event with read/write access condition to the variable of the current row.</td>
</tr>
<tr>
<td>Register to Watch1</td>
<td>Registers the variable(s) of the selected row(s) to the Watch panel (Watch1) as watch-expression(s) (see &quot;2.10 Register Watch-Expressions&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Source</td>
<td>Opens the Editor panel and displays the source file in which the variable of the current row is defined (see &quot;2.7 Jump to Defined Location&quot;).</td>
</tr>
<tr>
<td>Jump to Memory</td>
<td>Opens the Memory panel (Memory1) and displays the memory list from the start address of the variable of the current row (see &quot;2.7 Jump to Defined Location&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected row(s) to the clipboard as character strings separated by tabs. Note that the contents of the clipboard cannot be pasted to this panel.</td>
</tr>
</tbody>
</table>

Note

[RX]
For combination break events, this item is valid only when the combination condition is "OR".
Analysis Chart panel

This panel is used to display charts of the acquired function information and variable information (including the data information for Smart AnalogNote).

See "2.13 Display Analysis Information in Chart" for details on how to display the chart in this panel.

Note

This feature is supported only when the selected microcontroller incorporates Smart Analog IC.

Figure A.8 Analysis Chart Panel

The following items are explained here.

- [How to open]
- [Description of each area]
- [Toolbar]
- ([File] menu (Analysis Chart panel-dedicated items)]

[How to open]

- On the toolbar in the Main window, click the button.
- From the [View] menu, select [Program Analyzer] >> [Analysis Chart].

[Description of each area]

(1) Chart area
This area displays a chart relating to the acquired function information/variable information.

(2) Tab selection area
The type of chart is switched when a tab is selected.
In this panel, a following tab is contained (see the section explaining the tab for details on the display/setting).

- [Variable Value Changing Chart] tab
- [Execution Time(Percentage) Chart] tab

Remark A mark is displayed on the tab if a message relating to the chart information has been output to the Output panel.
[Toolbar]
The toolbar provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Acquires the latest data from the debug tool, and updates the contents of this panel. Note that this item is disabled if no registered variables exist.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays the latest information automatically by acquiring the information each time program execution stops. Note that this item is disabled if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Specify Individually] (this button is locked in accordance with the setting on the Property panel).</td>
</tr>
</tbody>
</table>

[[File] menu (Analysis Chart panel-dedicated items)]
The [File] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Overwrites the contents that are displayed on the currently selected tab to the previously saved file (see <em>2.14Save Analysis Information</em>). Note that when the file has never been saved or the file is write disabled, the same operation is applied as the selection in [Save Analysis Chart Data As...].</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Opens the Save As dialog box to newly save the contents that are displayed on the currently selected tab to the specified file (see <em>2.14Save Analysis Information</em>).</td>
</tr>
</tbody>
</table>
[Variable Value Changing Chart] tab

Use this tab to display the relationship between registered variable/register/address/other values and time by a graph (line chart).
Furthermore, when the selected microcontroller incorporates Smart Analog IC, by enabling Data collection mode on the debug tool, it is possible to display the collected data for Smart Analog by a graph [E1/E2/E2 Lite/E20/COM Port[RL78]]. You can zoom in on the range specified in this panel, using the Variable Value Changing Chart (zoomed in) panel. See "2.13.1 Graph transitions in values" for details on how to display graphs on this tab.

Cautions 1. A graph is displayed based on trace data or real-time RAM monitoring results acquired by the debug tool. To display a graph, also see cautions of "(a)Trace function" or "(b)RRM function/RAM monitor (pseudo RRM) function".

Cautions 2. When Real-time sampling analysis is specified as the method for acquiring the graph data, also see "3.3 Real-time Sampling Analysis".

Cautions 3. When Trace data analysis is specified as the method for acquiring the graph data, also see "3.4 Trace Data Analysis".

Cautions 4. [E1/E2/E2 Lite/E20/COM Port[RL78]]
To graph the collected data for Smart Analog, a monitor program for collecting data must be linked to the execution program.

Remarks 1. See "(4) Display graphs" for details on when graphs on this tab are updated.

Remarks 2. You can restore graphs currently being displayed on this tab by loading the analysis chart data file (*.mtac) which saves the data of the graphs (see "(6) Save the graph data to restore the graph").

Remarks 3. If the acquired graph data exceeds the buffer capacity (10000 plots), then the oldest graph data is overwritten by the new graph data (ring buffer system). In this case, part of the graph rendering will be blank.

Remarks 4. The Channel information area and Cursor information area can be shown/hidden by clicking the mark on the center of their splitter.

Figure A.9 Analysis Chart Panel: [Variable Value Changing Chart] Tab

The following items are explained here.
- [How to open]
- [Description of each area]
[How to open]
- On the toolbar in the Main window, click the button, and then select the [Variable Value Changing Chart] tab.
- From the [View] menu, select [Program Analyzer] >> [Analysis Chart], and then select the [Variable Value Changing Chart] tab.

[Description of each area]

(1) Graph control area

(a) [Analysis method]
Displays the analysis method currently being specified with the [Analysis method] property in the [General] category on the [Variable Value Changing] tab of the Property panel (see "(2)Specify the method for acquiring the graph data").

<table>
<thead>
<tr>
<th>Display Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling</td>
<td>Indicating that [Real-time sampling] is selected.</td>
</tr>
<tr>
<td>Trace</td>
<td>Indicating that [Analysis of trace data] is selected.</td>
</tr>
<tr>
<td>File</td>
<td>Indicating that [Load from file] is selected.</td>
</tr>
</tbody>
</table>

(b) [Sampling] button
Manually controls (toggles) the start/stop of the real-time sampling.
Note, however, that this button is available only when the following conditions are being satisfied:
- The debug tool is connected to CS+.
- Real-time sampling analysis is selected as the analysis method.
Caution If sampling is restarted, the stored graph data will be deleted (the graph being displayed will be erased).

(c) [Reflect] button
Automatically registers watch-expressions currently being registered in the Watch panel (Watch1) as graphing target.
Up to 32 watch-expressions in the Watch panel (Watch1), from top to bottom are registered (see "<3>Reflecting the Watch panel (auto registration)").
Note, however, that this button is available only when the following conditions are being satisfied:
- The debug tool is connected to CS+.
- The program is halted.
- Real-time sampling analysis or Trace data analysis is selected as the analysis method.
- [E1/E2/E2 Lite/E20/COM Port[RL78]]
Data collection mode is invalid on the debug tool.
Caution If this button is clicked, the information on the registered graphing targets will be deleted (the graph being displayed will be erased).

(d) [Zoom] combo box
When selecting the zoom range, select the number of the Variable Value Changing Chart (zoomed in) panel (Zoom 1 - 4) (see "(c)Zoom").
Note, however, that this combo box is disabled during execution of a program.
(e) **Zoom 1 - 4 check box**

Specifies the **Variable Value Changing Chart (zoomed in)** panel to be displayed. Select the check box of the corresponding number to open the **Variable Value Changing Chart (zoomed in)** panel (Variable Value Changing Chart (zoomed in) 1 - 4) (multiple selections possible). In the default condition, no check boxes are selected.

(2) **Chart area**

Figure A.11  Chart Area

![Chart Area Diagram]

- **(f) Trigger information**
- **(h) Trigger position**
- **(g) Trigger level**
- **(k) Zoom frame**
- **(e) Y axis (value)**
- **(j) Cursor-A**
- **(i) Cursor-B**
- **(b) X axis (time)**
- **(c) [Time/Div]**
- **(d) Latest time**

This area displays the relationship between values (Y axis (value) and X axis (time)) in the registered graphing target, in a line chart. The function of each item displayed in this area is as follows:

(a) **Graph**

The graph shows how the value of a target registered for each channel changes as the program execution proceeds. If acquisition of graph data through **Real-time sampling analysis** fails, however, only time information is provided with no connection lines. Such period is called a lost section and appears in the graph after the program has stopped as shown below (the background color of graphs depends on the [Background color(Lost section)] property in the [General] category on the [Variable Value Changing] tab of the Property panel).

If the debug tool has failed to acquire any single unit of data regardless of the current display range of graphs, the following message appears in the **Output panel**.

"RRM lost or buffer overflow has occurred, during data sampling."
Remarks 1. Acquisition of graph data may fail for the following reasons.

- The target variable without a scope definition is outside the current scope at the time of sampling because it is a static variable inside a file or function.

- [E1/E2/E2 Lite/E20/COM Port[RL78]] Some data has been lost while the debug tool is in the Data collection mode.

- Other than the above (see "3.4 Trace Data Analysis")

Remarks 2. The rendering color of the graph for each channel can be changed individually via the [Color 1-32] property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel.

Remarks 3. If Real-time sampling analysis is selected, the format of the line chart can be changed via the [Chart type] property in the [General] category on the [Variable Value Changing] tab of the Property panel (see "(b) Selection of the chart type").

(b) X axis (time)
Displays the passage of time. Grid lines divided in ten are displayed. The time per unit grid (Time/Div) for all channels can be specified with the [Time per grid[Time/Div]] property in the [General] category on the [Variable Value Changing] tab of the Property panel (see "(c) Setting the display range"). The time display range depends on the method for acquiring the graph data (see "Table 2.11 Differences Depending on Method for Acquiring Graph Data").

(c) [Time/Div]
Note that only while program execution is stopped, double-clicking on this label automatically adjusts the [Time per grid[Time/Div]] property to an optimum value so that the specified number of value transition points of the graph fit inside the rendering area (between the left and right ends) (see "(c) Setting the display range").

(d) Latest time
Displays the latest time corresponding to the graph data.

(e) Y axis (value)
Displays the values of the registered graphing target.
Grid lines divided in ten are displayed. The value per unit grid (Val/Div) for each channel can be specified with the [Value per grid[Val/Div] 1-32] property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel.
While the program is stopped, the axis line representing the origin (Value = 0) will be displayed as a dotted line in the rendering color of each channel.

Caution The display range of Y axis (value) depends on the [Value per grid[Val/Div] 1-32] property and [Offset 1-32] property setting, but if the obtained value is greater than the maximum or less than the minimum, nothing is displayed on the graph for that segment.
Regardless of a range of current graph display, if a channel whose obtained values are always outside of the display range exists, then the message will be displayed on the Output panel.

**Remark**

The offset value for each channel can be specified in unit grids of Y axis with the [Offset 1-32] property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel.

(f) **Trigger information**

Displays the contents currently being set in the [Trigger] category on the [Variable Value Changing] tab of the Property panel if the trigger function is used (see "(3)Use the trigger function").

"-" will be displayed in this area if the trigger function is not used.

(g) **Trigger level**

Indicates the trigger level when the trigger function is used (see "(3)Use the trigger function").

The value of the trigger level can be changed by dragging this trigger mark with the mouse.

Note, however, that this operation is disabled during execution of a program.

(h) **Trigger position**

Indicates the trigger position when the trigger function is used (see "(3)Use the trigger function").

The value of the trigger position can be changed by dragging this trigger mark with the mouse.

Note, however, that this operation is disabled during execution of a program.

(i) **Pop-up display**

When the mouse cursor is hovered over a transition location on the graph, the information about that location appears in a pop-up.

The display format is as follows:

<table>
<thead>
<tr>
<th>ch1 - 32: Value name</th>
<th>Value: Data value</th>
<th>Time: Data value</th>
</tr>
</thead>
</table>

**Caution**

This function is disabled during execution of a program.

**Remarks 1.**

The [Location] information is only displayed both when the graph data is acquired via Trace data analysis and when the transition location information exists in the graph data (if the information does not exist, "-" will be displayed). In this case, furthermore, you can display the applicable location in the Editor panel by double-clicking the transition point (except for a graph that was restored by loading the analysis chart data file (*.mtac)).

Note, however, that the [Location] information may be invalid value when the graph data is acquired by simultaneously using a Trace event and a Point Trace event in the debug tool.

**Remarks 2.**

The [Time] information is displayed in the following format:

- Real-time sampling analysis: XXXsXXXms
- Trace data analysis: XXXsXXXmsXXXµsXXXns
These two cursors (Cursor-A and Cursor-B) are used to check the time and value on the X axis (time) or Y axis (value). Under Cursor selection buttons, select the [X axis (Time)] button to perform a cursor measurement for the X axis (time), and the [Y axis (Value)] button to perform it for the Y axis (value). The measurement results are listed in the Cursor information area. Use the following operations to show or hide the cursors (the cursors are hidden by default).

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Setting (Show)</th>
<th>Clear Setting (Hide)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor-A</td>
<td>[Ctrl] key + mouse click</td>
<td>[Ctrl] key + mouse double-click</td>
</tr>
<tr>
<td>Cursor-B</td>
<td>[Ctrl] key + mouse right-click</td>
<td>[Ctrl] key + mouse right-double-click</td>
</tr>
</tbody>
</table>

**Cautions 1.** Cursor-A and Cursor-B are not displayed during execution of a program.

**Cautions 2.** When the [X axis (Time)] button is selected for the target axis, you cannot set the cursors in the area on the left of "0s", regardless of whether the graph data exists.

**Remark** The color of each cursor can be changed via the [Cursor-A color]/[Cursor-B color] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

**Zoom frame**
Indicates the zoom range displayed in the Variable Value Changing Chart (zoomed in) panel (see "(c)Zoom"). You can specify different zoom ranges for four different Variable Value Changing Chart (zoomed in) panels by selecting the panel numbers in the [Zoom] combo box.

**Remark** The color of each zoom frame can be changed via the [Zoom-1 - 4 color] property in the [General] category on the [Variable Value Changing] tab of the Property panel.

**Channel information area**
The display range of this area can be changed by moving the splitter with the mouse. In addition, this area can be shown/hidden by clicking the mark on the center of the splitter. For how to integrate the settings for channels into a pattern and switch the pattern from among multiple patterns, refer to Remarks 2. of [Channel 1 - 32] in the [Variable Value Changing] tab of the Property panel.

**Remark**
- [E1/E2/E2 Lite/E20/COM Port[RL78]]
  If the debug tool is in Data collection mode, the icon displayed here changes to  from .

**Variable name check box**
Displays the name of a variable (including register name/address expression) currently being registered in the channel as a graphing target, in a check box format ("none" will be displayed if no graphing target is registered). The character color of the variable name is the same as the rendering color of the graph. Select the check box to display the graph corresponding to the variable (multiple selections possible). In the default condition, all check boxes where the graphing target is being registered are selected.

**Caution**
- [E1/E2/E2 Lite/E20/COM Port[RL78]]
  When the debug tool is in Data collection mode, the variable name displayed here is not target for graphing.

**Remarks 1.** See "(1)Register graphing targets" for details on how to register the graphing target.

**Remarks 2.** The color of the graph for each channel can be changed individually via the [Color 1-32] property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel.

**[Val/Div]**
Displays "the value per unit grid" currently being specified with the [Value per grid][Val/Div] 1-32 property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel. When the program is not running, double-clicking this label automatically adjusts the values of the [Value per grid][Val/Div] 1-32 and [Offset 1-32] properties so that the graph for the selected channel will be shown in the entire rendering area (see "(c)Setting the display range").
(4) Cursor information area
The display range of this area can be changed by moving the splitter with the mouse. In addition, this area can be shown/hidden by clicking the mark on the center of the splitter.

Figure A.14 Cursor Information Area

(a) Cursor selection buttons
Select the target axis to perform a Cursor measurement.
Note, however, that this button is disabled during execution of a program.

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X axis (Time)</td>
<td>Set the cursor measurement target to the X axis (time) (default).</td>
</tr>
<tr>
<td>Y axis (Value)</td>
<td>Set the cursor measurement target to the Y axis (value).</td>
</tr>
</tbody>
</table>

(b) Measurement result
This area displays the following measurement result from the cursor-A and cursor-B positions.
Note, however, that the information below disappears during execution of a program.

<table>
<thead>
<tr>
<th>Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>- When the target is the X axis (time)</td>
<td>Shows the time indicated by cursor-A, the time indicated by cursor-B, and the difference between the two (the cycle [Hz] calculated from the difference).</td>
</tr>
<tr>
<td>- When the target is the Y axis (value)</td>
<td>Shows &quot;-&quot;</td>
</tr>
<tr>
<td>ch1 - 32</td>
<td>- When the target is the X axis (time) Shows the value at the time when cursor-A indicates, the value at the time when cursor-B indicates, and the difference between the two.</td>
</tr>
<tr>
<td></td>
<td>- When the target is the Y axis (value) Shows the value indicated by cursor-A, the value indicated by cursor-B, and the difference between the two. If no value can be obtained, &quot;-&quot; will be displayed.</td>
</tr>
</tbody>
</table>
[Execution Time(Percentage) Chart] tab

Use this tab to display the acquired function information in a pie chart of the function execution times. See "2.13.2 Chart the function execution time ratios" for details on how to display graphs on this tab.

**Cautions 1.** If the debug tool used does not support the Trace function, or if the debug tool's trace function is not enabled, then this chart cannot be displayed. Even if the trace function is enabled-condition, if there is no trace data in the trace memory, no chart is displayed on this tab, and then the following message will be displayed on the Output panel: "There is no execution time information."

**Cautions 2.** To display this chart, also see cautions of "(a) Trace function".

**Cautions 3.** [E1/E2/E2 Lite/E20[RX]][EZ Emulator[RX]]

This chart cannot be displayed when the device does not support the trace time tag feature.

**Cautions 4.** [E1/E2/E2 Lite/E20[RX]][EZ Emulator[RX]]

The results on this tab may not be exact. This is because the counter for time-lag measurement of the trace is small and may overflow. Check whether it has overflowed by the timestamp of the Trace panel.

Figure A.15 Analysis Chart Panel: [Execution Time(Percentage) Chart] Tab

The following items are explained here.

- [How to open]
  - [How to open]
  - [Description of each area]

**[How to open]**

- On the toolbar in the Main window, click the button, and then select the [Execution Time(Percentage) Chart] tab.
- From the [View] menu, select [Program Analyzer] >> [Analysis Chart], and then select the [Execution Time(Percentage) Chart] tab.

**[Description of each area]**

(1) Chart area

This area displays a pie chart indicating function execution time ratios. You can change the number of functions to display by setting from the [Execution Time(Percentage) Chart] tab property in the [General] category on the [Settings] tab of the [Property panel] (set to [10] by default). The targets are charted in ranking order of highest proportion of execution time taken. Functions exceeding the number specified here are displayed together under "Others".

---

R20UT5298EJ0100 Rev.1.00  Page 113 of 161  Jun 01, 2023
Remarks 1. The colors of labels and background of a chart depend on the settings of "font color" and "background color" for the [Default] item in the [General - Font and Color] category of the Option dialog box.

Remarks 2. You can expand or shrink the graph display from 10 to 100 % by rotating the mouse wheel forward or backward while pressing the [Ctrl] key (note that this does not apply to the font size of each label).

(a) Label display
Each function label is displayed in the format "Function-name[proportion of execution time (%)]".
For static files, the file name is also included inside the parentheses ( ).

Remark The proportion of execution time is the same as the [Execution Time(Percentage)][%] in the Function List panel.

(b) Pop-up display
When the mouse cursor is hovered over the chart, information about that function appears in a pop-up. The display format is as follows:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Execution time [unit]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function name</td>
<td>Indicates the name of the target function.</td>
</tr>
<tr>
<td>[CC-RX]</td>
<td>If the target function is a member function, then this will be displayed in the format of &quot;Class name::Function name&quot;.</td>
</tr>
<tr>
<td>Execution time [unit]</td>
<td>Indicates the execution time of the target function (this is the same value as the [Execution Time][unit] in the Function List panel).</td>
</tr>
<tr>
<td></td>
<td>The [Unit] can be changed by the [Unit of time] property in the [General] category on the [Settings] tab of the Property panel.</td>
</tr>
</tbody>
</table>
This panel is used to display the tree-structured chart (call graph) that indicates calling relationships between functions. The following types of function/variable are displayed in this panel.

- Global function
- Static function
- Member function (only when C++ source files are subject to analysis) [CC-RX]
- Global variable
- Static variable inside a file
- Static variable inside a function
- Class variable (only when C++ source files are subject to analysis) [CC-RX]

Note, however, that the function information and variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1 What is analyzed").

See "2.4 Display Calling Relationships between Functions (Call Graph)" for details on how to display the call graph.

Cautions 1. If the debug tool to use does not support the trace function, or if the debug tool's trace function is not enabled, then the Dynamic analysis information (e.g. the execution count/read count/write count) in the call graph cannot be displayed.

For the dynamic analysis information, also see the caution of "(a) Trace function".

Cautions 2. When C++ source files are subject to analysis, also see "3.6 When CC-RX (C++ Source Files) Is Used".

Remarks 1. A function/variable whose source file does not exist in the project can be displayed in the call graph if the Display the function/variable without definition at Call Graph panel property in the [General] category on the [Settings] tab of the Property panel is set to [Yes].

Remarks 2. This panel can be zoomed in and out (10 to 109 %) by in the Panel control area, or by moving the mouse wheel forward or backward while holding down the [Ctrl] key.

Figure A.16 Call Graph Panel (Whole View)
The following items are explained here.

- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (Call Graph panel-dedicated items)]
- [[Edit] menu (Call Graph panel-dedicated items)]
- [Context menu]

[How to open]
- On the toolbar in the Main window, click the button.
- From the [View] menu, select [Program Analyzer] >> [Call Graph].

[Description of each area]

(1) Panel control area

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Toggles whether scrolling of content is enabled by dragging the panel directly. By default, scrolling is disabled. Note that if scrolling is enabled, then the shape of the mouse cursor will change, and a function/variable will be neither highlighted (shown in selected state) nor reflected in the [Target Function Name] combo box even if clicking on a Function box/Variable box with mouse. There will also not be a Pop-up display with information about the function.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the call graph's zoom ratio. A number between 10 and 109 can be selected (by default, 100 is specified). You can also change the zoom by rotating the mouse wheel forward or backward while pressing the [Ctrl] key.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the call graph's zoom ratio. Each click of one of the buttons decrements/increments the value of the zoom slider by 1.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Automatically changes the call graph's zoom ratio. The call graph is enlarged or shrunk in accordance with the size of the panel, so that the entire call graph can be displayed.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Resets the zoom ratio of the call graph to the default value of 100.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Selects the parent function to target for display in the call graph (it will be at the top of the call graph) from the drop-down list. By default, the first function to appear named &quot;main&quot;,&quot;reset&quot;,&quot;start&quot; or containing such word is specified as the parent function (if there is no corresponding function, it will be empty).</td>
</tr>
</tbody>
</table>
If the selected microcontroller version supports multi-core, you can select "PMn". In this case, the call graph will only be displayed for the functions executed in the selected PMn/PEn.

Notes 2. The function name differs with the selected microcontroller as follows:
- [RH850][RL78]: main
- [RX]: reset

(2) Call graph area
This area displays a call graph indicating calling relationships between functions that have been acquired from the cross reference information. A call graph has the following two view modes that can be toggled by clicking the button.

- Whole view (default)
  By default, the first function to appear named "main"/"reset"/"start"Note 1 or containing such word is considered to be the parent function, and that function is placed on the left edge of the call graph (the corresponding parent function name will be displayed in the [Parent Function Name] combo box). If there is no corresponding function name, then the functions in the program that are not called by any other functions (reference count = 0) will be considered to be parent functions, and they will be placed on the leftmost edge (the [Parent Function Name] combo box will be empty).
  Next, the child functions, grandchild functions, and so on will be placed on the call graph, from left to right (they will be arranged from top to bottom, with the functions to appear first shown topmost). If an arbitrary parent function is specified in the [Parent Function Name] combo boxNote 2, then only the functions called by that function will appear in the call graph. If the combo box is empty, then all functions in the program will appear in the call graph.

Notes 1. The function name differs with the selected microcontroller as follows:
- [RH850][RL78]: main
- [RX]: reset

Notes 2. [RH850]
If the selected microcontroller version supports multi-core and "PMn" is selected in the [Parent Function Name] combo box, the call graph will only be displayed for the functions executed in the selected PMn/PEn.

- Details view
  The parent functions and child functions of the function currently being specified with the [Target Function Name] combo box are displayed.
The parent functions, the target function and the child functions are placed on the call graph, from left to right (they will be arranged from top to bottom, with the functions to appear first shown topmost). Furthermore, if global variables, static variables inside a file or static variables inside a function accessed from the target function exist, the variables also is placed immediately below the target function, as variable boxes (when the multiple variables exist, they will be arranged from top to bottom, with the variables to appear first shown topmost).

Remark

Any one of the following events will cause that the call graph is switched to whole view mode.

- The value of the [Parent Function Name] combo box has been changed (including the result of a build/rebuild in the build tool).
- A clean has been executed in the build tool.

Figure A.17 Call Graph Panel (Details View)

The composition of the call graph is as follows:

Figure A.18 Composition of Call Graph

(a) Function box
(b) Variable box
(c) Connection line

The function is displayed in a box format.
The following information is displayed in a function box.
Figure A.19  Information of Function Box

<table>
<thead>
<tr>
<th>Function name</th>
<th>Definition</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Indicates the location at which the target function is defined with &quot;File name(Line number)&quot;. Note, however, that if the definition information does not exist, then this will display &quot;(No Definition)&quot;.</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates the attribute of the target function.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Static function:  &lt;static&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Template function: &lt;template&gt; [CC-RX]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Virtual function: &lt;virtual&gt; [CC-RX]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Pure virtual function: &lt;abstract&gt; [CC-RX]</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>The current state of the target function is shown in the following background colors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Light blue: Not executed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Purple: Executed</td>
<td></td>
</tr>
<tr>
<td>PM Information</td>
<td>If the selected microcontroller version supports multi-core, PE in which the target function is assigned is shown in the following shadow colors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Gray: Common</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Orange: PM0/PE0, PM4/PE4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Red: PM1/PE1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Green: PM2/PE2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Blue: PM3/PE3</td>
<td></td>
</tr>
</tbody>
</table>

Note  
If the target function is a overloaded function or a template function, then the argument types of the function are also displayed in parentheses "()".  
If the target function is a const member function or volatile member function, then "const" or "volatile" is displayed immediately after the function name.

Remark  
By double-clicking a function box, you can jump to the location of the source text where the function is defined (see "2.7 Jump to Defined Location").  
Note, however, that this function cannot be used while scrolling via the mouse dragging is being enabled by the button. In this case, select the target function with the Target Function Name combo box, then select [Jump to Source] from the context menu.

(b) Variable box  
In the details view mode, a global variable, a static variable inside a file or a static variable inside a function accessed from the target function is displayed in a box format.  
The following information is displayed in a variable box.
Figure A.20 Information of Variable Box

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Definition</th>
<th>Attribute</th>
<th>Condition</th>
<th>PM Information [RH850]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Indicates the name of the target variable. If the target variable is a static variable inside a function, then this will be displayed in the format of &quot;Variable name#Function name&quot;.</td>
<td>Indicates the location at which the target variable is defined with &quot;File name(Line number)&quot;. Note, however, that if the definition information does not exist, then this will display &quot;(No Definition)&quot;.</td>
<td>Indicates the attribute of the target variable. - Static variable: &lt;static&gt; - Static variable inside a function: &lt;static local&gt; If the attribute other than the above, nothing is displayed in this area.</td>
<td>The current state of the target function is shown in the following background colors. - Green: Not referenced - Red purple: Referenced If the selected microcontroller version supports multi-core, PE in which the target variable is assigned is shown in the following shadow colors. - Gray: Common - Orange: PM0/PE0, PM4/PE4 - Red: PM1/PE1 - Green: PM2/PE2 - Blue: PM3/PE3</td>
</tr>
<tr>
<td>Reference count</td>
<td>Indicates the number of times of static references.</td>
<td>Read count, Write count</td>
<td>Indicates the number of times dynamic references (R: read accesses, W: write accesses) have been made. Note that this information appears only when the trace data exist. This information is the cumulative value for each program execution when the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel is set to [Yes].</td>
<td></td>
</tr>
</tbody>
</table>

Remark
By double-clicking a variable box, you can jump to the location of the source text where the variable is defined (see "2.7 Jump to Defined Location"). Note, however, that this function cannot be used while scrolling via the mouse dragging is being enabled by the button. In this case, disable the scroll function temporarily, then double click the target variable.

(c) Connection line
If a given function is called statically by another function, then the function boxes of the two functions will be shown linked by a connection line. Connection lines are only displayed for static function calls. Connection lines are not displayed for dynamic function calls. The following information is displayed by each connection line.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Definition</th>
<th>Attribute</th>
<th>Condition</th>
<th>PM Information [RH850]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Figure A.21  Information of Connection Line

<table>
<thead>
<tr>
<th>Reference count</th>
<th>Indicates the number of times of static calls.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution count</td>
<td>Indicates the number of times dynamic calls have been made, in parentheses &quot;( )&quot;. Note that this information appears only when the trace data exist. This information is the cumulative value for each program execution when the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel is set to [Yes].</td>
</tr>
<tr>
<td>Recursive call</td>
<td>A connection line and reference count is displayed as follows when a function calls itself.</td>
</tr>
<tr>
<td>Circular call</td>
<td>As an example, say that there are functions A, B, and C. If A calls B, which calls C, which then calls A (A -&gt; B -&gt; C -&gt; A), then although connection lines will be displayed for the calls of A to B and B to C, no connection line will be shown for the call of C to A. Instead, the following line segment will only be shown, to indicate a circular call. You can check information about functions in a circular call via the Pop-up display.</td>
</tr>
</tbody>
</table>

Remark  If there are no static function calls but there are dynamic function calls (e.g. if function calls are only made using function pointers), then this information can be confirmed in the Pop-up display.

(d) Pop-up display
When the mouse cursor is hovered over a function box/variable box, information about that function/variable appears in a pop-up. The display format is as follows:

Caution  This function cannot be used while scrolling via the mouse dragging is being enabled by the button.
- Function box

Note [CC-RX]

- When the target function is a global function or static function:
  If the target function belongs to a namespace (except for a global namespace/anonymous namespace), then this will be displayed in the format of "Namespace name::Function name". Moreover, if the target function is a overloaded function or a template function, then this will be followed by the argument types of the function in parentheses "( )".

- When the target function is a member function:
  If the target function belongs to a namespace (except for a global namespace/anonymous namespace), then this will be displayed in the format of "Namespace name::Class name::Function name". Otherwise this will be displayed in the format of "Class name::Function name". Moreover, if the target function is a overloaded function or a template function, then Function name will be followed by the argument types of the function in parentheses "( )".

<table>
<thead>
<tr>
<th>Function name</th>
<th>Indicates the name of the target function Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Indicates the location at which the target function is defined. Note, however, if the definition information does not exist, then this will display &quot;(No Definition)&quot;.</td>
</tr>
</tbody>
</table>
| Recursive call count | This item is displayed only if the target function is a recursive call.  
  Reference count: Number of recursive calls made  
  Execution count: Number of executions (only if there is trace data) |
| Circular call count | This item is displayed only if there are circular function calls from the target function. If there are multiple target functions, that at most 4 will be listed.  
  Function name: Name of function in circular call  
  Reference count: Number of circular calls made  
  Execution count: Number of executions (only if there is trace data) |
| Dynamic call count | This item is displayed only if there are only dynamic function calls, and no static function calls. If there are multiple target functions, that at most 4 will be listed.  
  Function name: Name of dynamic call function  
  Count: Number of executions |
If the target function is a const member function or volatile member function, then "const" or "volatile" is displayed immediately after the function name.

**Remark**
The cumulative value for each program execution is displayed as the execution count when the [Accumulate result of analysis] property in the [General] category on the [Settings] tab of the Property panel is set to [Yes].

- **Variable box**

![Variable box](image)

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Indicates the name of the target variable Note. If the target variable is a static variable inside a function, then this will be displayed in the format of &quot;Function name#Variable name&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Indicates the location at which the target variable is defined. Note, however, that if the definition information does not exist, then this will display &quot;(No Definition)&quot;.</td>
</tr>
</tbody>
</table>

**Note**

- **[CC-RX]**
  - When the target variable is a global variable or static variable inside a file:
    If the target variable belongs to a namespace (except for a global namespace/anonymous namespace), then this will be displayed in the format of "Namespace name::Variable name".
  
  - When the target variable is a class variable:
    If the target variable belongs to a namespace (except for a global namespace/anonymous namespace), then this will be displayed in the format of "Namespace name::Class name::Variable name". Otherwise this will be displayed in the format of "Class name::Variable name".

  - When the target variable is a static variable inside a function:
    If the target variable belongs to a namespace (except for a global namespace/anonymous namespace), then this will be displayed in the format of "Namespace name::Function name#Variable name". Otherwise this will be displayed in the format of "Function name#Variable name".

  - If the target variable is a class variable, then this will be displayed in the format of "Class name::Function name#Variable name".

**[Toolbar]**
The toolbar provides the following items and functions.

| ![Icon](image) | Acquires the latest data from the debug tool, and updates the contents of this panel. 
Note that this item is disabled during execution of a program. |
|----------------|--------------------------------------------------------------------------------------------------|
| ![Icon](image) | Displays the latest information automatically by acquiring the information each time program execution stops. 
Note that this item is disabled if the [Refresh at program stop] property in the [General] category on the [Settings] tab of the Property panel is set to other than [Specify Individually] (this button is locked in accordance with the setting on the Property panel). |
| ![Icon](image) | Opens the Call Graph Search dialog box to search for a function/variable existing on this panel. |
[[File] menu (Call Graph panel-dedicated items)]

The [File] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Call Graph Data</td>
<td>Overwrites the contents of this panel to the previously saved file (see <em>Save Analysis Information</em>). Note that when the file has never been saved or the file is write disabled, the same operation is applied as the selection in [Save Call Graph Data As...].</td>
</tr>
<tr>
<td>Save Call Graph Data As...</td>
<td>Opens the Save As dialog box to newly save the contents of this panel to the specified text file (see <em>Save Analysis Information</em>).</td>
</tr>
</tbody>
</table>

[[Edit] menu (Call Graph panel-dedicated items)]

The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find...</td>
<td>Opens the Call Graph Search dialog box to search for a function/variable currently existing on this panel.</td>
</tr>
</tbody>
</table>

[Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump to Source</td>
<td>Opens the Editor panel and displays the source file in which the function/variable currently being selected is defined (see <em>Jump to Defined Location</em>).</td>
</tr>
<tr>
<td>Jump to Disassemble</td>
<td>Opens the Disassemble panel (Disassemble1) and displays the disassemble data corresponding to the start address of the function/variable currently being selected (see <em>Jump to Defined Location</em>). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Memory</td>
<td>Opens the Memory panel (Memory1) and displays the memory list corresponding to the start address of the function/variable currently being selected (see <em>Jump to Defined Location</em>). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Function/Variable List</td>
<td>Opens the Function List panel/Variable List panel and selects the function/variable currently being selected.</td>
</tr>
<tr>
<td>Detail View</td>
<td>Switches to the details view that displays the parent functions and child functions of the function currently being selected (specified with the [Target Function Name] combo box). Note that this item is disabled during execution of a program.</td>
</tr>
</tbody>
</table>
This panel is used to display the class information, function information and variable information in a tree structure.

The following types of function/variable are displayed in this panel.

- Global function
- Static function
- Member function (only when C++ source files are subject to analysis)
- Global variable
- Static variable inside a file
- Class variable (only when C++ source files are subject to analysis)
- Instance variable (only when C++ source files are subject to analysis)

Note, however, that the class information, function information and variable information in the files not to be analyzed is not displayed in this panel (see "1.1.1What is analyzed").

See "2.5Display Class/Function/Variable Information" for details on how to display the class information, function information and variable information.

**Caution**

The class information is provided only when C++ source files are subject to analysis.

When C++ source files are subject to analysis, also see "3.6When CC-RX (C++ Source Files) Is Used".

---

**Figure A.22 Class/Member Panel**

---

The following items are explained here.

- [How to open]
- [Description of each area]
- [Toolbar]
- [[Edit] menu (Class/Member panel-dedicated items)]
- [Context menu]
[How to open]
- On the toolbar in the Main window, click the button.
- From the [View] menu, select [Program Analyzer] >> [Class/Member].

[Description of each area]
(1) Panel control area

| [View Setting] combo box (Left combo box) | Selects a classification method for the tree from the drop-down list.  
|   | - Category group (default)  
|   | - Access group  
|   | - Namespace group  
|   | - File group  
|   | - Alphabet group  |

| | Selects the last node that was selected.  
| | Note that this item is disabled if there are no node selections in the history, or during execution of a program.  |

| | Selects the node that was selected before the button was clicked.  
| | Note that this item is disabled if there are no node selections in the history that were selected via button, or during execution of a program.  |

| [Target Name] combo box (Left combo box) | Specifies the character strings to search via the button (case-insensitive).  
| | You can either type character strings directly from the keyboard (up to 512 characters), or select one from the input history via the drop-down list (up to 10 items).  
| | Note that this item is disabled during execution of a program.  |

| | Searches up in the last tree to have focus for nodes containing the string specified in the [Target Name] combo box, and selects the node that is found.  
| | Note that this button is disabled if the [Target Name] combo box is left blank, or during execution of a program.  |

| | Searches down in the last tree to have focus for nodes containing the string specified in [Target Name] combo box, and selects the node that is found.  
| | Note that this button is disabled if the [Target Name] combo box is left blank, or during execution of a program.  |

Remark After typing character strings to search, to press the [Enter] key is the same function as clicking the button, and to press the [Shift] + [Enter] key is the same function as clicking the button.

(2) Classes/Categories tree area
This area used to display the class and other information defined by the program in tree format. Information about the node being selected in this tree appears in the Functions/Variables list area. You can use the [View Setting] combo box to classify the display into the following five groups.

- Category group (default)  
- Access group  
- Namespace group  
- File group  
- Alphabet group

The node name and their order in the tree are described below. Note however, that if information could not be obtained, or there are no child nodes to display, then that node will not appear in the tree. You can expand/shrink the node with a child node by double-clicking it.
(a) Category group (default)
This classifies and displays classes, interfaces and other types.

<table>
<thead>
<tr>
<th>Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typedefs</td>
</tr>
<tr>
<td>Global Functions and Variables</td>
</tr>
<tr>
<td>Define Macros and Constants</td>
</tr>
<tr>
<td>Namespaces [CC-RX]</td>
</tr>
<tr>
<td>{ } Namespace name</td>
</tr>
<tr>
<td>Class [CC-RX]</td>
</tr>
<tr>
<td>![Class name](Note 1) Base Types</td>
</tr>
<tr>
<td>![Base type (Class/Interface/Struct type) name](Note 1) Derived Types</td>
</tr>
<tr>
<td>![Derived type (Class/Interface/Struct type) name](Note 1) Inner Types</td>
</tr>
<tr>
<td>![Inner type (Class/Interface/Struct type/Union type/Enum type) name](Note 1)</td>
</tr>
<tr>
<td>Interfaces [CC-RX]</td>
</tr>
<tr>
<td>![Interface name](Note 1) Base Types</td>
</tr>
<tr>
<td>![Base type (Class/Interface/Struct type) name](Note 1) Derived Types</td>
</tr>
<tr>
<td>![Derived type (Class/Interface/Struct type) name](Note 1) Inner Types</td>
</tr>
<tr>
<td>![Inner type (Class/Interface/Struct type/Union type/Enum type) name](Note 1)</td>
</tr>
<tr>
<td>Struct Types</td>
</tr>
<tr>
<td>![Struct type name](Note 1, 2)</td>
</tr>
<tr>
<td>Union Types</td>
</tr>
<tr>
<td>![Union type name](Note 3)</td>
</tr>
<tr>
<td>Enum Types</td>
</tr>
<tr>
<td>![Enum type name](Note 3)</td>
</tr>
</tbody>
</table>

Notes 1. **[CC-RX]**
These are displayed in the following access specifier order, together with icons denoting the access specifier (nodes with the same access specifier are displayed in alphabetical order).

<table>
<thead>
<tr>
<th>Access Specifier</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
<td>None</td>
</tr>
<tr>
<td>protected</td>
<td>![Protected](Note 1)</td>
</tr>
<tr>
<td>private</td>
<td>![Private](Note 1)</td>
</tr>
</tbody>
</table>

Notes 2. **[CC-RX]**
Base Types node, Derived Types node and Inner Types node are displayed as necessary.

Notes 3. **[CC-RX]**
Inner Types node is displayed as necessary.
(b) ACCESS GROUP

This classifies and displays nodes by their access specifiers specified in their classes, etc.
Nodes of the same type are displayed in alphabetical order.

<table>
<thead>
<tr>
<th>Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typedefs</td>
</tr>
<tr>
<td>Global Functions and Variables</td>
</tr>
<tr>
<td>Define Macros and Constants</td>
</tr>
<tr>
<td>public [CC-RX]</td>
</tr>
<tr>
<td>Class name [Note 1]</td>
</tr>
<tr>
<td>Interface name [Note 1]</td>
</tr>
<tr>
<td>Struct type name [Note 1]</td>
</tr>
<tr>
<td>Union type name [Note 2]</td>
</tr>
<tr>
<td>Enum type name</td>
</tr>
<tr>
<td>protected [CC-RX]</td>
</tr>
<tr>
<td>Class name [Note 1]</td>
</tr>
<tr>
<td>Interface name [Note 1]</td>
</tr>
<tr>
<td>Struct type name [Note 1]</td>
</tr>
<tr>
<td>Union type name [Note 2]</td>
</tr>
<tr>
<td>Enum type name</td>
</tr>
<tr>
<td>private [CC-RX]</td>
</tr>
<tr>
<td>Class name [Note 1]</td>
</tr>
<tr>
<td>Interface name [Note 1]</td>
</tr>
<tr>
<td>Struct type name [Note 1]</td>
</tr>
<tr>
<td>Union type name [Note 2]</td>
</tr>
<tr>
<td>Enum type name</td>
</tr>
</tbody>
</table>

Notes 1. [CC-RX]
Base Types node, Derived Types node and Inner Types node are displayed as necessary.

Notes 2. [CC-RX]
Inner Types node is displayed as necessary.

(c) NAMESPACE GROUP

This classifies and displays nodes by the namespaces in which the class or other elements are defined.
Nodes of the same type are displayed in the access specifier order (see "(a) Category group (default)"), and
nodes with the same access specifier are displayed in alphabetical order.

<table>
<thead>
<tr>
<th>Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace name [Note 1]</td>
</tr>
<tr>
<td>Typedefs</td>
</tr>
<tr>
<td>Global Functions and Variables</td>
</tr>
<tr>
<td>Define Macros and Constants</td>
</tr>
<tr>
<td>Class name [CC-RX] [Note 2]</td>
</tr>
</tbody>
</table>
Notes 1. Function, classes, and other elements that do not belong to any namespace (including when they are in C source file) are displayed in the same manner, in the "(Global)" instead of "Namespace name". If an element is defined in an anonymous namespace, its "Namespace name" will be "(Anonymous:<File name>)", and it will be displayed in the same way.

Notes 2. [CC-RX] Base Types node, Derived Types node and Inner Types node are displayed as necessary.

Notes 3. [CC-RX] Inner Types node is displayed as necessary.

(d) File group
This classifies and displays the files in which the class or other elements are defined. Nodes of the same type are displayed in the access specifier order (see "(a)Category group (default)"), and nodes with the same access specifier are displayed in alphabetical order.

Notes 1. The icon displayed differs depending on the type of the file.

Notes 2. [CC-RX] Base Types node, Derived Types node and Inner Types node are displayed as necessary.

Notes 3. [CC-RX] Inner Types node is displayed as necessary.

(e) Alphabet group
This displays nodes in alphabetical order, regardless of their classes or access specifiers.
### Notes 1. [CC-RX]
Base Types node, Derived Types node and Inner Types node are displayed as necessary.

### Notes 2. [CC-RX]
Inner Types node is displayed as necessary.

### Cautions 1. [CC-RX]
Typedefs node/Global Functions and Variables node/Define Macros and Constants node is not displayed if no information displayed in the Functions/Variables list area exist.

### Cautions 2. [CC-RX]
When C++ source files are subject to analysis, the alternative name of a namespace is not displayed.

### Remarks 1. When the mouse cursor is hovered over a `xxx name` node (except for a `file name` node), the namespace name to which it belongs appears in a pop-up. However, if it belongs to a global namespace or an anonymous namespace, then "~" or "<unnamed>" will appear.
If the mouse cursor is hovered over a `namespace name` node, the namespace name to which it belongs (upper namespace name) will appear.

### Remarks 2. About `Namespace name` node:
If an element contains an internal namespace, it is displayed in the form "enveloping Namespace name::internal Namespace name".

#### Examples 1.
- namespace Name: Name

#### Examples 2.
- For an internal namespace: Name::SubName

### Remarks 3. About `Class name` node:
If it is a template class, then the type information is added.
If an element is an internal class, it is displayed in the form "enveloping Class name::internal Class name".

#### Examples 1.
- class Sub: Sub

#### Examples 2.
- template<class T> class List: List<T>

#### Examples 3.
- For an internal class: Main::SubInMain

### Remarks 4. About `Class/Interface/Struct type`:
Base Types, Derived Types, and Inner Types are only shown for classes/interfaces that are direct descendants (if there are multiple such types, they are all shown).

### Remarks 5. [CC-RX]
If `Class name/Interface name/Struct type name/Union type name/Enum type name` is an anonymous (i.e. it has no tag name), then it will be displayed in the format of "<unnamed_N>" (N: A number from 1 automatically provided in appearance order).

### Remarks 6. You can jump to the corresponding node (Class name node, Interface name node, etc. in the same tree) by double-clicking a node displayed under the Base Types node/Derived Types node/Inner Types node.

### Remarks 7. You can jump to the location where the node currently being selected is defined or declared (see "2.7 Jump to Defined Location"/"2.8 Jump to Declared Location").

### (3) Functions/Variables list area
This area displays the information of the node currently being selected in the Classes/Categories tree area (e.g. function names/variable names that are defined in the node).
The relationship between the selection in the Classes/Categories tree area and the display contents of this area is as follows:
### Node Selection vs. Display Contents of This area

<table>
<thead>
<tr>
<th>Node Selection</th>
<th>Display Contents of This area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typedefs</td>
<td>Alternative name</td>
</tr>
<tr>
<td>Global Functions and Variables</td>
<td>Global function name</td>
</tr>
<tr>
<td></td>
<td>Static function name</td>
</tr>
<tr>
<td></td>
<td>Global variable name</td>
</tr>
<tr>
<td></td>
<td>Static variable inside a file name</td>
</tr>
<tr>
<td>Define Macros and Constants</td>
<td>Macro name</td>
</tr>
<tr>
<td></td>
<td>Constant</td>
</tr>
<tr>
<td>Class name</td>
<td>Alternative name</td>
</tr>
<tr>
<td>Interface name</td>
<td>Member function name</td>
</tr>
<tr>
<td>Struct type name (C++ source file)</td>
<td>Class variable name</td>
</tr>
<tr>
<td></td>
<td>Instance variable name</td>
</tr>
<tr>
<td></td>
<td>Constant</td>
</tr>
<tr>
<td>Union type name (C++ source file)</td>
<td>Alternative name</td>
</tr>
<tr>
<td></td>
<td>Member function name</td>
</tr>
<tr>
<td></td>
<td>Instance variable name</td>
</tr>
<tr>
<td></td>
<td>Constant</td>
</tr>
<tr>
<td>Struct type name (C source file)</td>
<td>Member variable name</td>
</tr>
<tr>
<td>Union type name (C source file)</td>
<td>Member variable name</td>
</tr>
<tr>
<td>Enum type name</td>
<td>Enum member name</td>
</tr>
<tr>
<td>Namespace name</td>
<td>None</td>
</tr>
<tr>
<td>File name</td>
<td>None</td>
</tr>
<tr>
<td>Other than above</td>
<td>None</td>
</tr>
</tbody>
</table>

**Caution**

Nothing is displayed in this area if functions/variables to be displayed do not exist or nothing is being selected in the Classes/Categories tree area.

**Remarks 1.** When the mouse cursor is hovered over a **xxx name** node (except for a **file name** node), the namespace name to which it belongs appears in a pop-up. However, if it belongs to a global namespace or an anonymous namespace, then "-" or "<unnamed>" will appear. If the mouse cursor is hovered over a **namespace name** node, the namespace name to which it belongs (upper namespace name) will appear.

**Remarks 2.** Argument types are added to function names.

Examples 1. int main(void): main(void)
Examples 2. void main_sub01(int local_a, int local_b, int local_c): main_sub01(int, int, int)
Examples 3. int function01(int arg01) const: function01(int) const

For template functions **[CC-RX]**, the line for the definition of a template function and the line for the function using a template function are displayed individually.

Examples 1. template<class T> T max(T a, T b) (on a line where a template is defined): max<T,T:1>()
Examples 2. int max(int a, int b) (on a line where a template is used): max<T:1>(int, int)

**Remarks 3.** **[CC-RX]** These are displayed in the following access specifier order, together with icons denoting the access.
specifier type (nodes with the same access specifier are displayed in alphabetical order). However, if the tree is classified by File group, then they are all displayed in alphabetical order.

<table>
<thead>
<tr>
<th>Access Specifier</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
<td>None</td>
</tr>
<tr>
<td>protected</td>
<td>🌟</td>
</tr>
<tr>
<td>private</td>
<td>🌠</td>
</tr>
</tbody>
</table>

Remarks 4. You can jump to the location where the node currently being selected is defined or declared (see "2.7 Jump to Defined Location"/"2.8 Jump to Declared Location").

[Toolbar]

The toolbar provides the following items and functions

- ![Acquire Latest Data](image)
  Acquires the latest data from the debug tool, and updates the contents of this panel.

[Edit] menu (Class/Member panel-dedicated items)]

The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected node to the clipboard as character strings.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the nodes being displayed in the Functions/Variables list area.</td>
</tr>
</tbody>
</table>

[Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump to Source</td>
<td>Opens the Editor panel and displays the source file in which the node currently being selected is defined (see &quot;2.7 Jump to Defined Location&quot;).</td>
</tr>
<tr>
<td>Jump to Declaration of Source</td>
<td>Opens the Editor panel and displays the source file in which the node currently being declared is declared (see &quot;2.8 Jump to Declared Location&quot;).</td>
</tr>
<tr>
<td>Jump to Disassemble</td>
<td>Opens the Disassemble panel (Disassemble1) and displays the disassemble data corresponding to the start address of the node currently being selected in the Functions/Variables list area (see &quot;2.7 Jump to Defined Location&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Memory</td>
<td>Opens the Memory panel (Memory1) and displays the memory list corresponding to the start address of the node currently being selected in the Functions/Variables list area (see &quot;2.7 Jump to Defined Location&quot;). Note that this item is disabled while disconnecting from the debug tool.</td>
</tr>
<tr>
<td>Jump to Function/Variable List</td>
<td>Opens the Function List panel/Variable List panel and selects the function/variable of the node currently being selected.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected node to the clipboard as character strings.</td>
</tr>
</tbody>
</table>

Note  
[CC-RX]  
This item is disabled if a node that indicates an instance variable is selected.
This panel is used to zoom in on the specified range on the chart displayed in the [Variable Value Changing Chart] tab of the Analysis Chart panel. Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Variable Value Changing Chart (zoomed in)1 - 4" on the title bar. From these panels, you can zoom in on the specified range individually. See "(c)Zoom" for details on how to display the chart on this panel.

**Cautions 1.** The graph on this panel cannot be updated during execution of a program.

**Cautions 2.** The graphing target cannot be registered/deleted on this panel.

**Remarks 1.** The display contents of this panel are updated when:
- Each time the graph displayed in the [Variable Value Changing Chart] tab of the Analysis Chart panel is updated (except for the real-time display update)
- The zoom range is set or cleared
- The analysis chart data file (*.mtac) is loaded

**Remarks 2.** You can restore graphs currently being displayed on this panel by loading the analysis chart data file (*.mtac) which saves the data of the graphs (see "(6)Save the graph data to restore the graph").

Figure A.23 Variable Value Changing Chart (zoomed in) Panel (Default)

You can display/hide the Channel information area and the Cursor information area by clicking the mark on the center of the splitter on this panel.
Figure A.24  Variable Value Changing Chart (zoomed in) Panel (Whole Area View)

The following items are explained here.
- [How to open]
- [Description of each area]

[How to open]
- On the [Variable Value Changing Chart] tab of the Analysis Chart panel, select the zoom 1 - 4 check box.

[Description of each area]
(1) Graph control area

(a) [Data source]
Displays the data source of the graph currently being displayed.

<table>
<thead>
<tr>
<th>Display Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From chart data (online)</td>
<td>Indicates that the data source is the graph currently being displayed in the [Variable Value Changing Chart] tab.</td>
</tr>
<tr>
<td>From file (offline)</td>
<td>Indicates that the data source is the information form the loaded analysis chart data file (*.mtac).</td>
</tr>
</tbody>
</table>

(b) [Zoom]
Indicates the color of the zoom frame currently being specified with the [Zoom-1 - 4 color] property in the [General] category on the [Variable Value Changing] tab of the Property panel.
(c) [Save] button
Opens the Save As dialog box to save the contents currently being displayed on this panel to the specified file (see "2.14 Save Analysis Information").

(2) Chart area

Figure A.26 Chart Area

This area displays a zoomed view of the range selected on the graph in the [Variable Value Changing Chart] tab of the Analysis Chart panel.
The function of each item displayed in this area is as follows:
(a) X axis (time)
Displays the passage of time.
(b) [Time/Div]
Displays the time per grid unit (10% of the total time for the zoom range set in the [Variable Value Changing Chart] tab of the Analysis Chart panel). This value cannot be changed.
(c) Latest time
Displays the latest time corresponding to the zoom range set in the [Variable Value Changing Chart] tab of the Analysis Chart panel.
(d) Y axis (value)
Displays the values of the registered graphing target.
The value per grid unit (Val/Div) is 10% of the value (difference between maximum and minimum) for the zoom range set in the [Variable Value Changing Chart] tab of the Analysis Chart panel for each channel (cannot be changed).
If the origin (value = 0) exists in the zoom range, the axis line represented it will be displayed as a dotted line in the rendering color of each channel.
Caution If the graph data obtained from the data source exceeds the minimum/maximum of the display range above, then nothing will be displayed on the graph for that segment.
(e) Pop-up display
When the mouse cursor is hovered over a transition location on the graph, the information about that location appears in a pop-up.
See "(i) Pop-up display" for details on its display format.
Caution This function is disabled during execution of a program.
(f) Cursor
These two cursors (Cursor-A and Cursor-B) are used to check the time and value on the X axis (time) or Y axis (value).
Under Cursor selection button, select the [X axis (Time)] button to perform a cursor measurement for the X axis (time), and the [Y axis (Value)] button to perform it for the Y axis (value).
The measurement results are listed in the Cursor information area.
Use the following operations to show or hide the cursors (the cursors are hidden by default).

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Setting (Show)</th>
<th>Clear Setting (Hide)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor-A</td>
<td>[Ctrl] key + mouse click</td>
<td>[Ctrl] key + mouse double-click</td>
</tr>
<tr>
<td>Cursor-B</td>
<td>[Ctrl] key + mouse right-click</td>
<td>[Ctrl] key + mouse right-double-click</td>
</tr>
</tbody>
</table>

Caution: Cursor-A and Cursor-B are not displayed during execution of a program.

(3) Channel information area
The display range of this area can be changed by moving the splitter with the mouse.
In addition, this area can be shown/hidden by clicking the mark on the center of the splitter (by default, this area is hidden).

Figure A.27 Channel Information Area

(a) Variable name check box
Displays the name of a variable (including register name/address expression) currently being registered in a channel as a graphing target, in a check box format ("none" will be displayed if no graphing target is registered). The character color of the variable name is the same as the rendering color of the graph. Select the check box to display the graph corresponding to the variable (multiple selections possible).
In the default condition, the settings of the data source are reflected to these check boxes. Note, however, that this operation is disabled during execution of a program.

(b) [Val/Div]
Displays "the value per unit grid" currently being specified with the [Value per grid][Val/Div] 1 - 32] property in the [Channel 1-32] category on the [Variable Value Changing] tab of the Property panel.

(4) Cursor information area
The display range of this area can be changed by moving the splitter with the mouse.
In addition, this area can be shown/hidden by clicking the mark on the center of the splitter (by default, this area is hidden).

Figure A.28 Cursor Information Area

(a) Cursor selection button
Select the target axis to perform a Cursor measurement. Note, however, that this button is disabled during execution of a program.

<table>
<thead>
<tr>
<th>X axis (Time)</th>
<th>Set the cursor measurement target to the X axis (time) (default).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y axis (Value)</td>
<td>Set the cursor measurement target to the Y axis (value).</td>
</tr>
</tbody>
</table>

(b) Measurement result
This area displays the following measurement result from the cursor-A and cursor-B positions. Note, however, that the information below disappears during execution of a program.
| Time                  | - When the target is the X axis (time)  
|                      | Shows the time indicated by cursor-A, the time indicated by cursor-B, and the difference between the two (the cycle [Hz] calculated from the difference).  
|                      | - When the target is the Y axis (value)  
|                      | Shows "-"  
| ch1 - 32             | Shows the value at the time when cursor-A indicates, the value at the time when cursor-B indicates, and the difference between the two.  
|                      | If no value can be obtained, "-" will be displayed. |
**Output panel**

This panel is used to display operation logs for various components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+ and a list of locations that refer to the specified function/variable. See "2.11 Display List of Referencing Location" for details on how to output lists of locations referencing a function or variable.

**Remark** This panel can be zoomed in and out by in the tool bar, or by moving the mouse wheel forward or backward while holding down the [Ctrl] key.

**Figure A.29 Output Panel**

The following items are explained here.
- **[How to open]**
  - From the [View] menu, select [Output].
- **[Description of each area]**
  1. **Message area**
     This area displays operation logs for various components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+ and a list of places that refer to the specified function/variable. For details on the contents displayed in this area, see the section explaining the corresponding tab.
  2. **Tab selection area**
     The origin of messages is changed when each tab is selected. The following tabs are available for the analysis tool.
     - [All Messages] tab
     - [Program Analyzer] tab
     - [Build Tool] tab
     - [Debug Tool] tab
     - [Find References] tab
     **Remark** When the new message is output, "***" mark is displayed to the left of the tab name.
- **[File] menu (Output panel-dedicated items)**

  The [File] menu for this panel provides the following items and functions.
The [Edit] menu for this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected range to the clipboard as character string(s).</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the messages displayed on the currently selected tab.</td>
</tr>
<tr>
<td>Find...</td>
<td>Opens the Find and Replace dialog box.</td>
</tr>
<tr>
<td>Replace...</td>
<td>Opens the Find and Replace dialog box.</td>
</tr>
</tbody>
</table>

**Save Output-Tab Name**

Overwrites the contents that are displayed on the currently selected tab to the previously saved text file (*.txt).

Note that when the file has never been saved or the file is write disabled, the same operation is applied as the selection in [Save Output-Tab Name As...].

**Save Output-Tab Name As...**

Opens the Save As dialog box to newly save the contents that are displayed on the currently selected tab to the specified text file (*.txt).

[Context menu]

The context menu displayed by right-clicking on this panel provides the following items and functions.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the contents of the selected range to the clipboard as character string(s).</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the messages displayed on the currently selected tab.</td>
</tr>
<tr>
<td>Clear</td>
<td>Deletes all the messages displayed on the currently selected tab.</td>
</tr>
<tr>
<td>Tag Jump</td>
<td>Opens the Editor panel and jumps to the number of the corresponding line in the corresponding file of the message at the caret position.</td>
</tr>
<tr>
<td>Stop Searching</td>
<td>Cancels the current search operation. However, this item is not displayed when a search is not being executed.</td>
</tr>
<tr>
<td>Help for Message</td>
<td>Displays help for the message on the current caret position. This item only applies to warning messages and error messages.</td>
</tr>
</tbody>
</table>
[All Messages] tab

This tab is used to display operation logs for all components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+.

Figure A.30 Output Panel: [All Messages] Tab

The following items are explained here.

- [How to open]
- [Description of each area]

[How to open]

- From the [View] menu, select [Output].

[Description of each area]

(1) Message area

This area displays operation logs for all components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+. Note that messages that the analysis tool output during analysis are not displayed on this tab (these messages are displayed only on the [Program Analyzer] tab).

The colors of message display differ with the type of message as shown below (character colors and background colors depend on the configuration in the [General - Font and Color] category of the Option dialog box).

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Display Example (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal message</td>
<td>AaBbCc</td>
<td>Character color Black</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Background color White</td>
</tr>
<tr>
<td>Warning message</td>
<td>AaBbCc</td>
<td>Character color Blue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Background color Standard color</td>
</tr>
<tr>
<td>Error message</td>
<td>AaBbCc</td>
<td>Character color Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Background color Light gray</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks 1. When the output message is double-clicked, or the [Enter] key is pressed with the caret over the message, the Editor panel appears and the destination line number of the file is displayed.

Remarks 2. Help with regard to the message in the line is shown by selecting [Help for Message] in the context menu or pressing the [F1] key while the caret is in the line where the warning message or the error message is displayed.

Remarks 3. You can save the contents displayed on this tab to a text file (*.txt) by selecting [Save Output-All Messages As...] from the [File] menu.
[Program Analyzer] tab

This tab is used to display only operation logs for the analysis tool out of those for various components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+.

Figure A.31 Output Panel: [Program Analyzer] Tab

The following items are explained here.
- [How to open]
- [Description of each area]

[How to open]
- From the [View] menu, select [Output].

[Description of each area]

(1) Message area

This area displays only operation logs for the analysis tool out of those for various components (analysis tool, design tool, build tool, debug tool, etc.) provided by CS+.

The colors of message display differ with the type of message as shown below (character colors and background colors depend on the configuration in the [General - Font and Color] category of the Option dialog box).

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Display Example (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal message</td>
<td>AsBbCc</td>
<td>Character color Black Background color White</td>
</tr>
<tr>
<td>Warning message</td>
<td>AsBbCc</td>
<td>Character color Blue Background color Standard color</td>
</tr>
<tr>
<td>Error message</td>
<td>AsBbCc</td>
<td>Character color Red Background color Light gray</td>
</tr>
</tbody>
</table>

Remarks 1. When the output message is double-clicked, or the [Enter] key is pressed with the caret over the message, the Editor panel appears and the destination line number of the file is displayed.

Remarks 2. Help with regard to the message in the line is shown by selecting [Help for Message] in the context menu or pressing the [F1] key while the caret is in the line where the warning message or the error message is displayed.

Remarks 3. You can save the contents displayed on this tab to a text file (*.txt) by selecting [Save Output-Program Analyzer As...] from the [File] menu.
[Find References] tab

Use this tab to display a list of locations referencing the specified function/variable. See "2.11 Display List of Referencing Location" for details on how to output lists of locations referencing a function or variable.

Cautions 1. This tab does not appear if the Display List of Referencing Location operation is never performed.

Cautions 2. Code in C/C++ source files that is referenced but is eliminated by the preprocessor during compilation (e.g. via "#if" or "#ifdef" statements) is not output as referenced locations.

Cautions 3. Reference of a function that is assignment to function pointers is not output as referenced locations.

Cautions 4. Each time a search is made for referencing locations, the output list of referencing locations is cleared.

Figure A.32 Output Panel: [Find References] Tab

The following items are explained here.

- [How to open]
- [Description of each area]

[How to open]

- From the [View] menu, select [Output].

[Description of each area]

(1) Message area

This area displays the following list of locations referencing a function/variable on the Function List panel/Variable List panel (see "2.11 Display List of Referencing Location").

Remarks 1. When the function name/variable name on this tab is double-clicked, the Editor panel appears and the caret moves to the line where the function/variable is defined.

Remarks 2. The color of the highlighted target function name and target variable name depends on the [Highlight] item in the [General - Font and Color] category of the Option dialog box.

Remarks 3. You can save the contents displayed on this tab to a text file (*.txt) by selecting [Save Output-Find References As...] from the [File] menu.

(a) Output format of list of locations referencing a function

The contents of the search results consist of the following parts:
Figure A.33 Output Format of List of Locations Referencing Function

<table>
<thead>
<tr>
<th>A</th>
<th>The location at which the target function is defined and a list of locations referencing the target function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Indicates the name of the target function.</td>
</tr>
<tr>
<td>Definition</td>
<td>Indicates the location at which the target function is defined. Note that if the information cannot be acquired from the cross reference file, then &quot;None&quot; is displayed.</td>
</tr>
<tr>
<td>File name (Number of lines)</td>
<td>Indicates the file name Note 1 at which the location in question exists. The number in parentheses indicates the number of lines (line number) in the file.</td>
</tr>
<tr>
<td>Line 1 of the location</td>
<td>Displays a 1-line excerpt from the file at the location. At this time, the target function name is highlighted.</td>
</tr>
<tr>
<td>Reference</td>
<td>Lists the locations referencing the target function. If there is the Dynamic analysis information, then the number of times the target function is executed is included in parentheses ( ). Note that if the information cannot be acquired from the cross reference file, then &quot;None&quot; is displayed.</td>
</tr>
<tr>
<td>File name (Number of lines)</td>
<td>Indicates the file name Note 1 at which the location in question exists. The number in parentheses indicates the number of lines (line number) in the file.</td>
</tr>
<tr>
<td>Line 1 of the location</td>
<td>Displays a 1-line excerpt from the file at the location. At this time, the target function name is highlighted.</td>
</tr>
<tr>
<td>B</td>
<td>A list of functions called within the target function</td>
</tr>
<tr>
<td>Calling function name</td>
<td>Lists the names of functions called within the target function. If no functions are called, then &quot;None&quot; is displayed.</td>
</tr>
<tr>
<td>C</td>
<td>A list of variables referenced (read/written) inside the target function</td>
</tr>
<tr>
<td>Reference variable name</td>
<td>Lists the names of variables referenced (read/written) inside the target function Note 2. If no variables are referenced, then &quot;None&quot; is displayed.</td>
</tr>
</tbody>
</table>

Note: When the [File path] item is being displayed on the Function List panel (this item is not displayed by default), the absolute path of the file appears.
(b) Output format of list of locations referencing a variable
The output search results consist of the location where the target variable is defined, and a list of locations referencing the target variable.

**Figure A.36 Output Format of List of Locations Referencing Variable**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target</strong></td>
<td>Indicates the name of the target variable.</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Indicates the location at which the target variable is defined. Note that if the information cannot be acquired from the cross reference file, then &quot;None&quot; is displayed.</td>
</tr>
<tr>
<td><strong>File name (Number of lines)</strong></td>
<td>Indicates the file nameNote at which the location in question exists. The number in parentheses indicates the number of lines (line number) in the file.</td>
</tr>
<tr>
<td><strong>Line 1 of the location</strong></td>
<td>Displays a 1-line excerpt from the file at the location. At this time, the target variable name is highlighted.</td>
</tr>
<tr>
<td><strong>Reference</strong></td>
<td>Lists the locations referencing the target variable. If there is the Dynamic analysis information, then the number of times the target variable has been read/written is included in parentheses ( ). Note that if the information cannot be acquired from the cross reference file, then &quot;None&quot; is displayed.</td>
</tr>
<tr>
<td><strong>File name (Number of lines)</strong></td>
<td>Indicates the file nameNote at which the location in question exists. The number in parentheses indicates the number of lines (line number) in the file.</td>
</tr>
<tr>
<td><strong>Line 1 of the location</strong></td>
<td>Displays a 1-line excerpt from the file at the location. At this time, the target variable name is highlighted.</td>
</tr>
</tbody>
</table>
Note  When the [File path] item is being displayed on the Variable List panel (this item is not displayed by default), the absolute path of the file appears.

Remark  A line with a variable described in "extern declaration" is handled as "Reference".

Figure A.37  Example of List of Locations Referencing Variable (without Dynamic Analysis Information)

Figure A.38  Example of List of Locations Referencing Variable (with Dynamic Analysis Information)
This dialog box is used to specify the files not to be analyzed by the analysis tool (see "1.1.1 What is analyzed"). The function information and variable information in the files specified not to be analyzed on this dialog box are not displayed in the following panels:

- Function List panel
- Variable List panel
- Call Graph panel
- Class/Member panel

The following items are explained here.

- [How to open]
- [Description of each area]
- [Function buttons]

**[How to open]**

- On the [Settings] tab in the Property panel, select the [Files not to analyze] property in the [Analysis Object] category, and then click the [...] button.
[Description of each area]

(1) Header area
This area displays the column name (File Name, Category, and Defined Symbol Count) of the file information. You can change the display order of the columns displayed by dragging and dropping the column name to an arbitrary column. Furthermore, you can sort the contents in the File information display area by clicking each column name (clicking repeatedly cycles the sort order between ascending, descending and the default display (i.e. in the order on the project tree)). In this case, if the items to sort are numbers (decimal or hexadecimal), then the file information is sorted by numerical value, for other types of data (e.g. strings), the file information is sorted by character code.  

Caution The display order of the columns and the order of the contents in the file information area cannot be restored. This dialog box is always opened in the default condition.

(2) File information display area
This area displays a list of C/C++ source file names currently being registered in the project and their information.

(a) [File Name]
Displays the C/C++ source file name or the category name (surrounded by "()"). Specify the check boxes of each file name not to analyze that file.

| ✔ | Does not analyze this file. |
|   |                             |
| ☐ | Analyzes this file.        |

Remarks 1. If a check box of a category name is cleared, then all of the check boxes of the file names that belong to the category will be cleared.

Remarks 2. When the mouse cursor is hovered over a file name, the full path of the file and the path including the tree node name that is displayed in the project tree appear in a pop-up.

(b) [Category]
Displays the category name to which the corresponding C/C++ source file is registered in the project tree. When a category name is displayed in the [File Name], "File" is displayed (if it is a root category, "-" is displayed).

(c) [Defined Symbol Count]
Displays the total number (decimal number) of the functions and variables that are defined in the corresponding C/C++ source file or category. However, if the number of the defined symbols cannot be obtained, then ".-" will be displayed.

(3) [All Select / All Deselect] check box
Select this check box to select all of the check boxes in [File] column. Conversely, remove the check of this check box to remove all of the checks in [File] column.

| ✔ | Indicates that all of the check boxes in [File] column is being selected. |
|   |                                                                             |
| ☐ | Indicates that all of the check boxes in [File] column is not being selected or all of the check boxes in [File] column is not being cleared. |
| ☐ | Indicates that no check box in [File] column is being selected (default). |

[Function buttons]

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Sets the specified file(s) to the file(s) not to be analyzed then closes the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ignores the setting and closes this dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the help of this dialog box.</td>
</tr>
</tbody>
</table>
This dialog box is used to specify the files to be analyzed by the analysis tool (see "1.1.1 What is analyzed"). Only the function information and variable information in the files specified to be analyzed on this dialog box are displayed in the following panels:

- Function List panel
- Variable List panel
- Call Graph panel
- Class/Member panel

The following items are explained here.

- [How to open]
- [Description of each area]
- [Function buttons]

**[How to open]**

- On the [Settings] tab in the Property panel, select the [Files to analyze] property in the [Analysis Object] category, and then click the [...] button.
[Description of each area]

(1) Header area
This area displays the column name (File Name, Category, and Defined Symbol Count) of the file information. You can change the display order of the columns displayed by dragging and dropping the column name to an arbitrary column. Furthermore, you can sort the contents in the File information display area by clicking each column name (clicking repeatedly cycles the sort order between ascending, descending and the default display (i.e. in the order on the project tree)). In this case, if the items to sort are numbers (decimal or hexadecimal), then the file information is sorted by numerical value, for other types of data (e.g. strings), the file information is sorted by character code.

Caution The display order of the columns and the order of the contents in the file information area cannot be restored. This dialog box is always opened in the default condition.

(2) File information display area
This area displays a list of C/C++ source file names currently being registered in the project and their information.

(a) [File Name]
Displays the C/C++ source file name or the category name (surrounded by "()").
Specify the check boxes of each file name to analyze that file.

<table>
<thead>
<tr>
<th>Select</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Analyzes this file.</td>
</tr>
<tr>
<td>□</td>
<td>Does not analyze this file.</td>
</tr>
</tbody>
</table>

Remarks 1. If a check box of a category name is cleared, then all of the check boxes of the file names that belong to the category will be cleared.
Remarks 2. When the mouse cursor is hovered over a file name, the full path of the file and the path including the tree node name that is displayed in the project tree appear in a pop-up.

(b) [Category]
Displays the category name to which the corresponding C/C++ source file is registered in the project tree. When a category name is displayed in the [File Name], "File" is displayed (if it is a root category, "-" is displayed).

(c) [Defined Symbol Count]
Displays the total number (decimal number) of the functions and variables that are defined in the corresponding C/C++ source file or category. However, if the number of the defined symbols cannot be obtained, then ".-" will be displayed.

(3) [All Select / All Deselect] check box
Select this check box to select all of the check boxes in [File] column. Conversely, remove the check of this check box to remove all of the checks in [File] column.

<table>
<thead>
<tr>
<th>Select</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Indicates that all of the check boxes in [File] column is being selected.</td>
</tr>
<tr>
<td>□</td>
<td>Indicates that all of the check boxes in [File] column is not being selected or all of the check boxes in [File] column is not being cleared.</td>
</tr>
<tr>
<td>□</td>
<td>Indicates that no check box in [File] column is being selected (default).</td>
</tr>
</tbody>
</table>

[Function buttons]

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Sets the specified file(s) to the file(s) to be analyzed then closes the dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ignores the setting and closes this dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the help of this dialog box.</td>
</tr>
</tbody>
</table>
Column Chooser dialog box

This dialog box is used to sort, show/hide the items (columns) displayed on the Function List panel/Variable List panel. If the Customize Display Method operation has been performed on one of the panels, then this dialog can also be used to reset these customizations to the default settings.

Figure A.41 Column Chooser Dialog Box (For Function List Panel)

Figure A.42 Column Chooser Dialog Box (For Variable List Panel)
The following items are explained here.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]
- On the Function List panel, click the button.
- On the Variable List panel, click the button.

[Description of each area]

(1) Item list area
This area displays a list of all items (columns) that can be displayed in the Function List panel/Variable List panel (the items (columns) that can be displayed differ according to the microcontroller and the debug tool used). The display order of the items in this list, and the state of checkboxes, are the same as the current sort order and visible/hidden status in the corresponding panel. Specify the check boxes of each item to show or hide that item on the panel.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Displays this item on the panel.</td>
</tr>
<tr>
<td></td>
<td>Does not display this item on the panel.</td>
</tr>
<tr>
<td>📝</td>
<td>Indicates that a message relating to information about this item has been output to the Output panel. Hover the mouse over it to display a pop-up with the last message to be output.</td>
</tr>
</tbody>
</table>

[Function buttons]

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Resets the display order and visible/hidden settings for each item in the Function List panel/Variable List panel to their default values. Note that all display locking, display filtering, and other customization will be cleared.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes this dialog box.</td>
</tr>
</tbody>
</table>

Note
The order of [Item] in the table corresponds to the display order of items (columns) on each panel. Note that items displayed differ depending on the microcontroller and debug tool used (see *(2)Information area* of the Function List panel/*(2)Information area* of the Variable List panel).

Table A.5 Default Display Status (Function List Panel)

<table>
<thead>
<tr>
<th>Item</th>
<th>While Disconnecting from Debug Tool</th>
<th>While Connecting to Debug Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Class Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Namespace</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>File Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>File Path</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>PM Information [RH850]</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Item</td>
<td>Status</td>
<td>Status</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td>While Disconnecting</td>
<td>While Connecting to</td>
</tr>
<tr>
<td></td>
<td>from Debug Tool</td>
<td>Debug Tool</td>
</tr>
<tr>
<td>Import</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>Access Specifier</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Attribute</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Return Type</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Arguments Count</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>Arguments</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Code Size[Bytes]</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Start Address</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>End Address</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>Reference Count</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Execution Count</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Execution Time[unit]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Execution Time(Percentage)[%]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Execution Time(Average)[unit]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Code Coverage[%]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
</tbody>
</table>

Table A.6  Default Display Status (Variable List Panel)

<table>
<thead>
<tr>
<th>Item</th>
<th>Status</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>While Disconnecting</td>
<td>While Connecting to</td>
</tr>
<tr>
<td></td>
<td>from Debug Tool</td>
<td>Debug Tool</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Class Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Namespace</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>File Name</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Function Name</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>File Path</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>PM Information [RH850]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Import</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>Access Specifier</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Attribute</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Type</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Members</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Address</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Size[Bytes]</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Reference Count</td>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Item</td>
<td>Status</td>
<td>While Disconnecting from Debug Tool</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Read Count</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Write Count</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Read/Write Count</td>
<td>Non-display</td>
<td>Non-display</td>
</tr>
<tr>
<td>Minimum Value</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Maximum Value</td>
<td>Non-display</td>
<td>Display</td>
</tr>
<tr>
<td>Data Coverage[%]</td>
<td>Non-display</td>
<td>Display</td>
</tr>
</tbody>
</table>
Call Graph Search dialog box

This dialog box is used to search for a function/variable existing in the call graph displayed in the Call Graph panel.

Caution

Searches can be performed only for functions/variables (function boxes/variable boxes) that appear in a call graph.

Figure A.43 Call Graph Search Dialog Box

The following items are explained here.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]
- On the toolbar of the Call Graph panel, click the button.
- Focus the Call Graph panel, and then select [Find...] from the [Edit] menu.

[Description of each area]

(1) [Search condition] area
Configure the search conditions.
If multiple search conditions are specified, then only a function/variable meeting all conditions will be searched.

(a) [Function/Variable Name]
Specify a function name/variable name to search.
You can either type character strings directly into the text box (up to 2046 characters), or select one from the input history via the drop-down list (up to 10 items).
The previous specified function name/variable name is displayed by default (if it does not exist, then this is left blank).

<1> [Condition]
From the following drop-down list, select the condition for the character strings specified with [Function/Variable Name].

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>equals</td>
<td>Searches for the function names/variable names that exactly matches the specified string.</td>
</tr>
<tr>
<td>begins with</td>
<td>Searches for function names/variable names starting with the specified string.</td>
</tr>
</tbody>
</table>
**Remark**

- Drag and drop an arbitrary row of the Function List panel/Variable List panel to this area.
- Drag and drop an arbitrary character strings to this area.

(b) **[Class Name]** [CC-RX]

If required as a search parameter for a function/variable, you can specify the class name to which a member function/member variable to search belongs. You can either type character strings directly into the text box (up to 2046 characters), or select one from the input history via the drop-down list (up to 10 items). The previous specified class name is displayed by default (if it does not exist, then this is left blank).

- **[Condition]**
  From the following drop-down list, select the condition for the character strings specified with [Class Name].

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>equals</td>
<td>Searches for the function names/variable names that belong to the class exactly matching the specified string.</td>
</tr>
<tr>
<td>begins with</td>
<td>Searches for function names/variable names that belong to the class starting with the specified string.</td>
</tr>
<tr>
<td>ends with</td>
<td>Searches for function names/variable names that belong to the class ending with the specified string.</td>
</tr>
<tr>
<td>contains</td>
<td>Searches for function names/variable names that belong to the class containing the specified string (default).</td>
</tr>
</tbody>
</table>

**Remark**

- Drag and drop an arbitrary character strings to this area.

(c) **[Case-sensitive]**

Specify whether to search for characters specified in [Function/Variable Name]/[Class Name] [CC-RX] in case-sensitive.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Searches with the specified characters in case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>Searches with the specified characters in not case-sensitive (default).</td>
</tr>
</tbody>
</table>

(d) **[Parent Count]**

If required as a search parameter for a function, you can specify the number of parent functions to search. You can either type a value directly into the text box (settable range: 0 to 65535), or select one from the input history via the drop-down list (up to 10 items). The previous specified value is displayed by default (if it does not exist, then this is left blank).

- **[Condition]**
  From the following drop-down list, select the condition for the numeric value specified with [Parent Count].

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is greater than</td>
<td>Searches for the names of functions with more (greater than) the specified number of parent functions.</td>
</tr>
<tr>
<td>is greater than or equals to</td>
<td>Searches for the names of functions with at least as many (greater than or equal to) the specified number of parent functions.</td>
</tr>
<tr>
<td>equals to</td>
<td>Searches for the names of functions with the same number of (equal to) the specified number of parent functions (default).</td>
</tr>
<tr>
<td>is less than or equals to</td>
<td>Searches for the names of functions with at least as less (greater than or equal to) the specified number of parent functions.</td>
</tr>
<tr>
<td>is less than</td>
<td>Searches for the names of functions with less (greater than) the specified number of parent functions.</td>
</tr>
</tbody>
</table>
(e) [Child Count]
If required as a search parameter for a function, you can specify the number of child functions to search. You can either type a value directly into the text box (settable range: 0 to 65535), or select one from the input history via the drop-down list (up to 10 items). The previous specified value is displayed by default (if it does not exist, then this is left blank).

- [Condition]
  From the following drop-down list, select the condition for the numeric value specified with [Child Count].

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is greater than</td>
<td>Searches for the names of functions with more (greater than) the specified number of child functions.</td>
</tr>
<tr>
<td>is greater than or equal to</td>
<td>Searches for the names of functions with at least as many (greater than or equal to) the specified number of child functions.</td>
</tr>
<tr>
<td>equals to</td>
<td>Searches for the names of functions with the same number of (equal to) the specified number of child functions (default).</td>
</tr>
<tr>
<td>is less than or equal to</td>
<td>Searches for the names of functions with at least as less (greater than or equal to) the specified number of child functions.</td>
</tr>
<tr>
<td>is less than</td>
<td>Searches for the names of functions with less (greater than) the specified number of child functions.</td>
</tr>
</tbody>
</table>

(2) [Preview] area
This area displays all part of the call graph.
If the area currently displayed in the Call Graph panel is a portion of the entire call graph, then that area is shown in a red frame.

[Function buttons]

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Backward</td>
<td>The search uses the specified conditions, starting from the function name/variable name at the bottom of the call graph, and proceeding upward. The corresponding function box/variable box is highlighted. If a function box/variable box has been selected on the Call Graph panel, then the search starts from the corresponding function/variable, moving upward. Note that if an illegal value is specified, or the program is executing, then a message will appear, and the function/variable search will not be performed. If focus moves to this dialog box from a panel other than the Call Graph panel or the Call Graph panel is hidden, then this button will be disabled.</td>
</tr>
<tr>
<td>Search Forward</td>
<td>The search uses the specified conditions, starting from the function name/variable name at the top of the call graph, and proceeding downward. The corresponding function box/variable box is highlighted. If a function box/variable box has been selected on the Call Graph panel, then the search starts from the corresponding function/variable, moving downward. Note that if an illegal value is specified, or the program is executing, then a message will appear, and the function/variable search will not be performed. If focus moves to this dialog box from a panel other than the Call Graph panel or the Call Graph panel is hidden, then this button will be disabled.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the function search and closes this dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the help for this dialog box.</td>
</tr>
</tbody>
</table>
Filter Settings dialog box

This dialog box is used to set the filter conditions when filtering the display of analysis information on the Function List panel/Variable List panel.

**Caution**
The filtering configured via this dialog box and the Filtering results linked to panel are mutually exclusive functions.
For this reason, the two filtering functions here cannot be enabled simultaneously (when one of the filters is active, setting the other filter will disable all filters set to date).
See "2.6.5Filter the analysis information" for details on the display-filter.

Figure A.44 Filter Settings Dialog Box

The following items are explained here.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]
- On the Function List panel/Variable List panel, click the filter icon (  / ), and then select the [(Custom)].

[Description of each area]
Configure the filter conditions.
In the First condition setting area (top)/Second condition setting area (bottom), you can specify up to two conditions.
Use the Logical operator buttons ([AND]/[OR]) to set the two conditions as a single filter condition.

1. First condition setting area (top)/Second condition setting area (bottom)
   (a) Comparison value (left combo box)
   You can either type the comparison value of for the filter (number or string) directly via the keyboard (up to 2048 characters), or select one from the input history via the drop-down list (maximum 10 items).
   By default, the comparison value set in the current target item is displayed.
   (b) Condition (right combo box)
   Select the condition for the comparison value specified in (a) above, from the drop-down list.
   By default, the condition set in the current target item is selected.
### Comparison Value

<table>
<thead>
<tr>
<th>Item</th>
<th>Numerical Value</th>
<th>Character String</th>
</tr>
</thead>
<tbody>
<tr>
<td>no condition&lt;sup&gt;Note&lt;/sup&gt;</td>
<td>Compared as numerical value</td>
<td>Compared as character string</td>
</tr>
<tr>
<td>equals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not equal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is greater than</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is greater than or equal to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is less than</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is less than or equal to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>begins with</td>
<td>Compared as character string</td>
<td></td>
</tr>
<tr>
<td>does not begin with</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ends with</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not end with</td>
<td></td>
<td></td>
</tr>
<tr>
<td>contains</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not contain</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: If [no condition] is selected, then the comparison value will be ignored (not set as a condition).

Caution: Use the top condition-specification area if you only wish to specify one filtering condition.

(2) Logical operator buttons

Select the logical relationship holding between the conditions specified in the First condition setting area (top)/Second condition setting area (bottom) via the following option button.

<table>
<thead>
<tr>
<th>AND</th>
<th>Only information meeting both condition 1 and condition 2 is displayed. This is mutually exclusive to the [OR] button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Only information meeting either condition 1 or condition 2 is displayed. This is mutually exclusive to the [AND] button.</td>
</tr>
</tbody>
</table>

**[Function buttons]**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Displays the analysis information in the Function List panel/Variable List panel under the specified filtering conditions. If the Filtering results linked to panel was performed, then all display-filters linked to the panel conducted prior to this are deleted.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ignores the setting and closes this dialog box.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the help of this dialog box.</td>
</tr>
</tbody>
</table>
## Revision Record

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Jun 01, 2023</td>
<td>First Edition issued</td>
</tr>
</tbody>
</table>